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Value-Added Reseller (VAR) Language

Oracle Retail VAR Applications
The following restrictions and provisions only apply to the programs referred to in this section and
licensed to you. You acknowledge that the programs may contain third party software (VAR
applications) licensed to Oracle. Depending upon your product and its version number, the VAR
applications may include:

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation
(MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail
Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications.

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of
Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory
Management.

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington,
and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags.

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of
San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization
application.

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR
Applications. Oracle will not deliver source code to the VAR Applications to you.
Notwithstanding any other term or condition of the agreement and this ordering document, you
shall not cause or permit alteration of any VAR Applications. For purposes of this section,
“alteration” refers to all alterations, translations, upgrades, enhancements, customizations or
modifications of all or any portion of the VAR Applications including all reconfigurations,
reassembly or reverse assembly, re-engineering or reverse engineering and recompilations or
reverse compilations of the VAR Applications or any derivatives of the VAR Applications. You
acknowledge that it shall be a breach of the agreement to utilize the relationship, and/or
confidential information of the VAR Applications for purposes of competitive discovery.

The VAR Applications contain trade secrets of Oracle and Oracle’s licensors and Customer shall
not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or
other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to
replace, with functional equivalent software, any of the VAR Applications in future releases of the
applicable program.





v

Contents
Send Us Your Comments................................................................................................ xi

Preface ............................................................................................................................ xiii
Audience .............................................................................................................................. xiii
Related Documents............................................................................................................. xiii

Customer Support............................................................................................................... xiii

Review Patch Documentation ........................................................................................... xiii

Oracle Retail Documentation on the Oracle Technology Network.............................. xiii

Conventions......................................................................................................................... xiv

1 Overview ....................................................................................................................... 1
The Admin Module Window ................................................................................................1

The File Pull Down Menu......................................................................................................1
The General Pull Down Menu ..............................................................................................2

The Planning Pull Down Menu ............................................................................................3

The Merchandising Pull Down Menu..................................................................................3

The Logs Pull Down menu ....................................................................................................4

The Security Pull Down Menu..............................................................................................5

The Tools Pull Down Menu...................................................................................................5
The Window pull down menu..............................................................................................5

The Help pull down menu ....................................................................................................6

2 General Options........................................................................................................... 7
Calendars .................................................................................................................................7

Overview of Calendars ...................................................................................................7

Financial Reporting .........................................................................................................7

Importing EPOS Data Within Specific Date Ranges ...................................................8

Using Calendars in KPIs .................................................................................................9
Roll-ups ...........................................................................................................................10

The Calendars Dialogue Box ........................................................................................11

Calendars Menu Bar and Toolbar................................................................................12

Adding a Calendar ........................................................................................................13

Editing and Deleting Calendars...................................................................................15

Custom Query .......................................................................................................................16
Custom Queries..............................................................................................................16

Manufacturers .......................................................................................................................17

Overview of Manufacturers Option............................................................................17

Adding a Manufacturer ................................................................................................19

Editing a Manufacturer .................................................................................................20

Deleting a Manufacturer...............................................................................................21
Refreshing and Exiting..................................................................................................22

Using Manufacturers in Data Import..........................................................................23



vi

Status & Status Levels ..........................................................................................................24

Overview.........................................................................................................................24

Configuring Statuses in Admin ...................................................................................38

System Variables ...................................................................................................................51
Index to System Variable Options ...............................................................................51

System Variables ............................................................................................................52

System Variable Descriptions ......................................................................................59

Tax Codes.............................................................................................................................122

About Tax Codes..........................................................................................................122

Menus and Toolbars ....................................................................................................122
Adding, Editing and deleting Tax Codes .................................................................124

Refreshing and Exiting................................................................................................126

Assigning Tax Codes...................................................................................................127

Importing Tax Codes...................................................................................................128

Units......................................................................................................................................128

Overview of Units Option ..........................................................................................128
About SI Units ..............................................................................................................129

About Scientific Notation ...........................................................................................130

The File Pull Down Menu...........................................................................................130

The Units Pull Down Menu........................................................................................131

The Dimensions Pull Down Menu ............................................................................131

The Help Pull Down Menu ........................................................................................132
The Toolbar...................................................................................................................133

Unit Details ...................................................................................................................133

User Defined Attributes .....................................................................................................136

Overview of User Defined Attributes .......................................................................136

Dialogue Boxes where UDA's are Set .......................................................................138

Overview of Configuring User Defined Attributes ................................................143
Configuring User Defined Attributes .......................................................................145

Modifying User Defined Attributes ..........................................................................148

Data Importer ...............................................................................................................148

3 Admin Planning........................................................................................................ 151
Hatch Styles .........................................................................................................................151

About Hatch styles ......................................................................................................151

Hatch Styles Dialogue Box .........................................................................................151

Overview of Configuring Hatch Styles for Merchandiser/In-Store Space
Collaboration ................................................................................................................153

Configuring Hatch Styles for Merchandiser and In-Store Space Collaboration .154

Detail of Hatch Style Parameters for Merchandiser/In-Store Space Collaboration
........................................................................................................................................156



vii

Scales.....................................................................................................................................158

Overview of MSM Scales ............................................................................................158

Configuring Scales in Admin .....................................................................................159

Configuring Objects to be Scaled...............................................................................160
Using Scales in the Planner Module..........................................................................162

Text Styles ............................................................................................................................162

Overview of Text Styles ..............................................................................................162

The Text Style Wizard .................................................................................................176

The Text Styles Dialogue Box.....................................................................................180

The Text Style Rules Dialogue Box............................................................................187
Title Blocks...........................................................................................................................196

Overview of Title Blocks.............................................................................................196

Overview of Creating Title Blocks.............................................................................197

Canonical Media ..........................................................................................................199

Custom SQL..................................................................................................................199

Creating the Title Block in Planner............................................................................200
Data Taken from the Drawing ...................................................................................204

Registering the Title Block in Fixture Studio ...........................................................208

Adding Title Block Information in the Admin Module..........................................211

Deleting Title Blocks from Macro Space Management...........................................212

Placing Title Blocks in Planner...................................................................................213

Modifying Title Blocks in Planner .............................................................................214
Editing Attributes ........................................................................................................216

Zone Types & Definitions ..................................................................................................217

Purposes of Zones........................................................................................................217

Overview of Zone Types and Zone Definitions ......................................................218

Criteria for Arranging Zone Types and Descriptions.............................................220

Strategies for Zone Types and Descriptions.............................................................222
Overview of Clash Detection .....................................................................................223

How Clash Detection Works......................................................................................225

Zones and Hatch Styles...............................................................................................227

Zone Technicalities ......................................................................................................227

Zone Types ...................................................................................................................238

Zone Definition ............................................................................................................246



viii

4 Admin Merchandising ............................................................................................. 253
Adjacency Rules ..................................................................................................................253

Overview of Adjacency Rules ....................................................................................253

Severity Types ..............................................................................................................253

Setting Up Adjacency Rules .......................................................................................254

Keeping Adjacency Rules Updated...........................................................................256
Editing and Deleting Adjacency Rules .....................................................................256

Using Adjacency Rules................................................................................................257

Distances in Adjacency Rule Output ........................................................................259

Severity Types .....................................................................................................................262

About Severity Types ..................................................................................................262

Modifying the Severity Type List ..............................................................................264
Category Rules ....................................................................................................................265

Overview of Category Roles.......................................................................................265

Category Roles Menus and Toolbar ..........................................................................266

Using the Category Roles Dialog Box .......................................................................267

Planogram Financial Weighting .......................................................................................268

Planogram Financial Weighting ................................................................................268
Planogram Import Styles ...................................................................................................271

Overview of Planogram Import Styles .....................................................................271

Planogram Import style Menus and Toolbar ...........................................................272

Configuring Sources of Planogram Imports ............................................................273

Using the Planogram Import Style Dialog Box........................................................274

Planogram Substitution......................................................................................................275
Index to Planogram Substitution ...............................................................................276

Introduction to Planogram Substitution...................................................................276

Planogram Substitution Technicalities .....................................................................283

Accessing the Functionality........................................................................................293

Planogram Substitution Dialog Box ..........................................................................299

Planogram Substitution Definition Dialog Box .......................................................306
Planogram Substitution Assistant .............................................................................332

Find Dialog Box............................................................................................................346

Dry Run and Planogram Substitution Logs .............................................................359

Batch Operations..........................................................................................................362

Business Flows .............................................................................................................364

Product Code Types ...........................................................................................................372
Product Code Types ....................................................................................................372

Adding and Editing Product Code Types................................................................374

Ranges...................................................................................................................................375

About Ranges and Range Groups .............................................................................375

Where Ranges are Assigned.......................................................................................376

Where Ranges are Used ..............................................................................................377
About Ranges and Styles ............................................................................................378



ix

Seasons .................................................................................................................................379

About Seasons ..............................................................................................................379

Configuring Seasons....................................................................................................380

Assigning Seasons .......................................................................................................381
Strategies ..............................................................................................................................383

Overview of Strategies ................................................................................................383

Strategy Menus and Toolbar ......................................................................................385

Using the Strategies Dialog Box.................................................................................386

Styles .....................................................................................................................................387

Overview of Styles.......................................................................................................387
Using Styles ..................................................................................................................402

5 Tools ......................................................................................................................... 417
Next ID .................................................................................................................................417

Overview of Update ID Tables Option .....................................................................417

The Update ID Tables Option ....................................................................................417

Unlock Tables ......................................................................................................................418

Overview of Unlock Tables Option...........................................................................418

The Unlock Tables Option ..........................................................................................418
Purge.....................................................................................................................................418

Overview of Purge Options........................................................................................418

Purge Fixtures Option .................................................................................................419

Purge Products Option................................................................................................420

Purge Images Option...................................................................................................422

Purge Planograms Option ..........................................................................................424
Purge Logs Option.......................................................................................................425

Purge Targets Option ..................................................................................................427

Purge EPOS Data Option............................................................................................427

6 Logs .......................................................................................................................... 429
Overview of Logs................................................................................................................429

AVTTB_COMMAND_LOG...............................................................................................430

AVTTB_FILELOG ...............................................................................................................430

AVTTB_FILE_PROCESS_LOG..........................................................................................430
AVTTB_IMPORT_LOG......................................................................................................431

AVTTB_IMPORT_ERROR_LOG ......................................................................................432

AVTTB_PLANO_LOG .......................................................................................................433

AVTTB_POG_IMPORT_LOG ...........................................................................................434

AVTTB_POG_SUBST_LOG...............................................................................................434

AVTTB_PROCESS_LOG....................................................................................................434
AVTTB_USER_LOG Table.................................................................................................435

AVTTB_ERROR...................................................................................................................435



x

7 437Security............................................................................................................... 437
Overview of MSM Security ...............................................................................................437

Security Options..................................................................................................................437

About Security Options...............................................................................................437

Maximum Logins.........................................................................................................438

Minimum and Maximum Password Length............................................................439
Password Format .........................................................................................................440

Change Password Period............................................................................................441

Excluded Passwords....................................................................................................442

Exiting Security Options .............................................................................................443

Functional Security .............................................................................................................444

About Functional Security..........................................................................................444
The Functional Security Window ..............................................................................446

Functional Security Menus and Toolbar...................................................................447

Users and User Groups ...............................................................................................451

Group Relationships....................................................................................................467

Data Security - Edit - Planograms.....................................................................................472

About Data Security ....................................................................................................472
The Data Security Window ........................................................................................472

Data Security Menus and Toolbar .............................................................................473

Using Data Security .....................................................................................................474

Index............................................................................................................................... 487



xi

Send Us Your Comments
Oracle Retail Macro Space Management, Administration Guide, Release 13.2.1

Oracle welcomes customers' comments and suggestions on the quality and usefulness of
this document.

Your feedback is important, and helps us to best meet your needs as a user of our
products. For example:

 Are the implementation steps correct and complete?

 Did you understand the context of the procedures?

 Did you find any errors in the information?

 Does the structure of the information help you with your tasks?

 Do you need different information or graphics? If so, where, and in what format?
 Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us
your name, the name of the company who has licensed our products, the title and part
number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to
check that you have the latest version of the document and if
any concerns are already addressed.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number
(optional).

If you need assistance with Oracle software, then please contact your support
representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your
Oracle local office and inquire about our Oracle University offerings. A list of Oracle
offices is available on our Web site at www.oracle.com.

http://www.oracle.com/
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Preface
This guide enables you to perform administrative functions for Oracle Retail Macro
Space Management.

Audience
This User Guide is written for the following audiences:
 Database administrators (DBA)

 System analysts and designers

 Integrators and implementation staff

Related Documents
For more information, see the following documents in the Oracle Retail Macro Space
Management Release 13.2.1 documentation set:
 Oracle Retail Macro Space Management Administration Online Help

 Oracle Retail Macro Space Management Release Notes

 Oracle Retail Macro Space Planning Installation Guide

Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

 Product version and program/module name

 Functional and technical description of the problem (include business impact)

 Detailed step-by-step instructions to re-create
 Exact error message received

 Screen shots of each step you take

Review Patch Documentation
When you install the application for the first time, you install either a base release (for
example, 13.2) or a later patch release (for example, 13.2.1). If you are installing the base
release and additional patch and bundled hot fix releases, read the documentation for all
releases that have occurred since the base release before you begin installation.
Documentation for patch and bundled hot fix releases can contain critical information
related to the base release, as well as information about code changes since the base
release.

Oracle Retail Documentation on the Oracle Technology Network
Documentation is packaged with each Oracle Retail product release. Oracle Retail
product documentation is also available on the following Web site:
http://www.oracle.com/technology/documentation/oracle_retail.html

(Data Model documents are not available through Oracle Technology Network. These
documents are packaged with released code, or you can obtain them through My Oracle
Support.)

https://support.oracle.com/
http://www.oracle.com/technology/documentation/oracle_retail.html
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xiv

Documentation should be available on this Web site within a month after a product
release.

Conventions
Navigate: This is a navigate statement. It tells you how to get to the start of the procedure
and ends with a screen shot of the starting point and the statement “the Window Name
window opens.”
This is a code sample

It is used to display examples of code
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Overview

The Admin Module Window
The Admin Module window contains a menu bar.

Clicking on any of the options will disclose a pull down menu giving access to further
options.

The File Pull Down Menu
The File pull down menu has two options – Configure and Exit.

Configure brings up the Configuration Module, where a series of basic settings affecting
the local operation of Macro Space Management can be changed.
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Exit allows the user to close the Admin Module

The General Pull Down Menu
The General pull down menu gives access to options used for overall planning within
Macro Space Management.

Option Comment

Calendars Configure the calendars used for financial planning.

Custom Query This option allows users to set up customized queries for the Find dialog box using
Custom SQL
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Manufacturers Configure the list of manufacturers used for fixtures and for merchandise

Status Configure the statuses used for Store, Floors, Revisions, Files, Fixtures, Products
and Planograms

Status Levels Configure the sequence statuses will be used in

System Variables Change the values of the system variables used by Macro Space Management and
In-Store Space Collaboration

Tax Codes Set the values of the tax bands used for merchandise

Units Set the units used for information

User Defined
Attributes

Set the options for information associated with Users, Stores, Files, Fixtures,
Products and Planograms.

The Planning Pull Down Menu
The Planning pull down menu gives access to options used for laying out drawings
within Macro Space Management.

Option Comment

Hatch Styles Hatch styles allow the user to configure the patterns used to color in Zones.

Scales Scales allows the user to specify the scales used in Paper Space in AutoCAD (Planner
Module)

Text Styles Text Styles are the parameters used for annotation within the drawing

Title Blocks Title Blocks are used in Paper Space in AutoCAD (Planner Module) to display
information about the store plan

Zone Types Zone Types are the broad classes Zone Definitions fall into

Zone Definitions Zone Definitions are areas of a store plan used for a specific retailing purpose.

The Merchandising Pull Down Menu
The Merchandising pull down menu gives access to options used for Products and
Planograms.
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Option Comment

Adjacency Rules Allows the user to specify rules on which products should or should not be
adjacent to each other

Severity Types Allows the use to specify the comments associated with the adjacency rules

Category Rules

Planogram Financial
Weighting

This option allows the user to specify the methods used to rank the financial
performance of planograms

Planogram Import
Styles

Planogram Substitution Allows the user to specify which planograms to change in a drawing

Product Code Types This option allows the user to specify the masks used for Product Codes

Ranges Specifies temperature or weight options for products

Seasons Allows the user to specify the seasons specifying whether time sensitive
merchandise is valid to place.

Strategies

Styles This option allows users to configure Styles and Style Relationships

The Logs Pull Down menu
The Logs pull down menu gives access the logs used to record user activities.

Options on the Logs pull down menu allow users to call dialogue boxes displaying the
varying logs available
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The Security Pull Down Menu
The Security pull down menu gives access to options used for assigning access.

Option Comment

Security Options Security Options allows the users to specify options about passwords

Functional
Security

Functional Security allows Administrators to create users and to define the access
allowed to those users

Data Security Data security allows Administrators to specify access to stores, products and statuses

The Tools Pull Down Menu
The Tools pull down menu gives access to varying administrative options.

Option Comment

Purge Purge allows administrators to permanently delete items marked for deletion

Update ID Table This option causes the AVTTB_NEXTID table to be manually updated

Unlock Tables This option allows Administrators to check back in information in tables that might
have been checked out for some reason - for example a software failure

The Window pull down menu
The Window pull down menu allows the user to arrange the windows open in the
Admin module.

The Cascade function arranges open drawing windows so that they overlap.

The Minimize All function allows the user to minimize all open dialog interfaces.

The Maximize All function allows the user to open for view all minimized dialog
interfaces.
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The Help pull down menu
The Help pull down menu calls this Help File.

About displays information on the version of Macro Space Management currently in use.
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2
General Options

Calendars

Overview of Calendars
The Calendars Option allows the user to set up a series of calendars - each Calendar
covering a set period of time for retailing activities.

These Calendars can then be used to control information within Macro Space
Management including:

1. Financial Reporting

2. Importing EPOS data within specific date ranges.
3. Displaying KPI's for specific date ranges.

4. Roll ups - 4/5 week months

Calendars can be set up within the Admin Module.

It is more usual to import calendars using Data Importer. This means that the time
periods used within Macro Space Management will be aligned with the time periods
used in other databases - for example those used by accounting software.

Financial Reporting
Calendars are often used for financial reporting.
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When data is imported, it is normally associated with one or more Calendar Periods. This
allows users to identify the time period that the data is associated with. For example data
for a specific SKU might show Purchase Price, Sales Price, Sales Margin and Profit for the
past day, week, month, quarter and year.

Associating SKU (PRD_ID) with a Calendar Period (CAL_ID) enables KPIs, Reports, etc,
to be structured by time intervals.

Importing EPOS Data Within Specific Date Ranges
EPOS data for a specific product may be associated with many time periods. For
example, a product may have data based on:

1. Years

2. Quarters

3. Seasons

4. Months

5. Weeks

6. Days
If there are 50,000 products at SKU level and 'day' data is held for three years, there
would be nearly 55 million records in the EPOS table. Accordingly, many customers
choose to consolidate data. If an EPOS table was being deleted and re-populated weekly,
the data import might bring in:

1. Data by years for the last three years

2. Data by quarters for the last four quarters
3. Data by seasons for the last three seasons

4. Data by months for the twelve months

5. Data by weeks for the last three months

6. Data by days for the last four weeks

Note: EPOS data types are identified by Calendar ID
(CAL_ID).

This substantially reduces the amount of data held in the EPOS table and increases
performance when KPIs, etc, are run.

Note: performance can also be improved by indexing the
EPOS table, partitioning the EPOS table, etc.



Calendars

General Options 9

Using Calendars in KPIs
Calendars are used in KPIs to select data by date range. Using calendars is in four
stages:

1. The calendar is imported or set up
2. Data is imported into the table holding EPOS data

3. The KPI is configured

4. The KPI is selected and used

Importing or Setting up the Calendar
The calendar is either imported or set up. One option that can be set is the calendar type.

Data is imported into the table holding EPOS (Electronic Point Of Sale) Data
The table used to hold the imported EPOS data will differ from implementation to
implementation but will require certain mandatory columns.

1. PRD_ID (Product ID) identifies the Product

2. STR_ID (Store ID) identifies the Store
3. CAL_ID (Calendar ID) identifies the time period in the calendar

In addition at least one item of financial data is required.
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The KPI is Configured
The KPI is then configured. It can either be set up as a View or as a Stored Procedure. The
KPI will typically take financial information from the EPOS table and combine it with
information from other MSM tables. For example the AVTTB_PRODUCT table contains
information on which products are on what fixtures - enabling the KPI to specify
financial performance by fixture.

Where it is necessary to filter data by time period, the KPI should also include the
CAL_ID.

The KPI is Selected and Used
When the KPI is selected for use, the user selects a date and a data type. The options in
the data type drop down list match those in the Type drop down list in the Calendar
dialog box.

Note: selecting the Data Type is specifying the CAT_ID in
the AVTTB_CALENDAR table.

When a date and the data type has been selected, the software will select data from the
AVTTB_CALENDAR table where the date is within the CAL_ID or the required
Calendar Type (CAT_ID)
For example, if a customer selects a date of 5/6/09 and a data type of 'Month', the
software will identify the calendar period (CAL_ID) of calendar type (CAT_ID) = 4
containing the date 5/6/09. The calendar period (CAL_ID) is then used as a filter to
select data.

Roll-ups
Sometimes, for accounting purposes, it is necessary to know exactly how a calendar
period is sub-divided, or how many weeks are in each month (some may contain 4 weeks
and some may contain 5). After Calendar Information has been imported, it is possible to
use the AVTTB_CALENDAR table to concatenate information for reporting purposes.
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All calendar periods (with the exception of the root) have a Calendar ID (CAL_ID) and a
Calendar Parent ID, (CAL_PID).

The type of calendar period can be identified from the Calendar Type ID (CAT_ID). This
is a foreign key to the AVTTB_CALENDAR_TYPE table. The CAT_ID's are as follows:

CAT_ID Description

0 All

1 Year

2 Season

3 Quarter

4 Month

5 Week

6 Day

It is then possible to use SQL to produce very specific reports. For example, all weeks
have a CAT_ID of 5. By looking at the Parent ID's of each week, (CAL_PID), it is possible
to assign each weeks to a specific month, thus allowing Administrators to identify 4 and
5 week months within a report.

The Calendars Dialogue Box
The Calendars Dialogue Box has a number of parts.
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The Menu Bar gives access to a series of options.
The Toolbar also gives access to most of those options.

The Calendar Hierarchy allows users to see the available calendars.

The Calendar Details section gives more information on the selected calendars.

The Status Bar gives information on the number of calendars in the selected section.

Calendars Menu Bar and Toolbar
The File pull down menu allows users to exit the application.

The Edit pull down menu allows users to add, edit and delete calendars. It also allows
users to expand or collapse sections of the calendar hierarchy.

The View pull down menu allows users to turn the Toolbar and status bar display on or
off. It also enables users to refresh the hierarchy with any changes made by other users.
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The Help pull down menu allows users to call help and to get information on the
version of the software.

Exit

Add Calendar

Edit Calendar

Delete Calendar

Refresh Calendars

Adding a Calendar
To Add a Calendar, pick the point in the hierarchy to add a calendar and then click on
the Add Calendar icon.
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This will open a new line in the Calendar Details section.

Type in the details and press <Return>. The calendar will be added to the list.

Note: If <Return> is not pressed, the data will not be saved
to the database.

Calendars are set by means of a drop down calendar option.
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There are two ways of selecting the month.

Users can use the left or right arrows (left hand image) to move between months.

Alternatively, position the mouse pointer over the month bar and hold down the left
mouse key. This will bring up a scrollable menu of months.

Hold the mouse pointer just above or below it to move through it.

Editing and Deleting Calendars
Editing a Calendar is done by selecting the appropriate entry and changing the selected
values.



Custom Query

16 Oracle Retail Macro Space Management

Note: Caution should be used in editing calendars in case
Import Routines and KPI's reference the calendar.

To Delete a Calendar highlight the required calendar and click on the delete icon

The calendar will be deleted without further warning if not in use. If in use, a delete
conformation will be requested.

Custom Query

Custom Queries
All Find dialog boxes have the option to use a Custom SQL statement. This can be used
to develop a client specific search option. The Custom SQL statement is invoked by
checking the Use Custom Search Query in the Find dialog boxes.

Custom queries are set up in the Administration module by invoking the Custom Query
from the General menu. This dialog box allows Administrators to set up a client specific
query using Custom SQL. At present three forms of search can be customized:

1. Stores

2. Planograms

3. Planogram Substitution Events
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Custom SQL is specific to Space Planning and is an extension of standard SQL. The code
is able to insert items of data into the curly brackets {Braces} to modify the SQL statement
every time a user enters a text string into the text box of the Find dialog box.

In the above example, the query will use the text entered into the Search String Text box
in the Find dialog box and substitute the values in the 'Where ' clause in the Custom SQL
statement.

For example, if the user entered a Store Code of ABC-123 into the Search String Text box
the 'Where' clause would be converted to WHERE STR_NAME LIKE '%ABC-123%'. The
results tab of the Find dialog box would then populate with all Store Name s matching
the text in the Search String Text box in the Find dialog box.

Note: The information within the curly brackets {Text}
assumes implied wild cards.

In order to save a new or modified piece of Custom SQL it must first be tested. This is
done by clicking the Search Query Test icon on the toolbar. If the Custom SQL
satisfactorily passes test, the Save icon will be enabled and the new or modified piece of
Custom SQL can be saved.

Manufacturers

Overview of Manufacturers Option
The Manufacturers Option is used to create a list of manufacturers for use within the
Macro Space Management software.



Manufacturers

18 Oracle Retail Macro Space Management

The list of manufacturers is used in two places in the software:

1. It allows Manufacturers to be assigned to Fixtures in Fixture Studio.

2. It allows Manufacturers and Suppliers to be assigned to Products at the SKU level in
Product Studio.
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Note: A Manufacturer would typically be the company that
produces the product, a Supplier the wholesaler that
supplies it.

The list of manufacturers can either be entered manually in the Admin Module, or
imported from a third party database using Macro Space Management's Data Import
module. The Manufacturers option in the Admin Module allows this list of
manufacturers to be reviewed, and then edited.

Adding a Manufacturer
To Add a Manufacturer click on the Add Manufacturer icon.
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(Alternatively, click in the name box if a manufacturer has already been added).

Type in the Manufacturers Name and Code into the pertinent boxes.

Select the Manufacturer's Type from the drop down list.

Manufacturers classed in the Fixtures Category will become available in the Fixture
Studio Module. Similarly, manufacturers classed in the Products Category will become
available in the Product Studio Module.
Finally, press <Return>. This will store the Manufacturer in the central Macro Space
Management database.

Note: Ensure <Return> is pressed for every entry. If not, the
information will not be stored in the central Macro Space
Management database.

Editing a Manufacturer
To Edit a Manufacturer click on the entry in the table of manufacturers...
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Edit the entries as required.
Finally, press <Return>. This will store the changes to that Manufacturer in the central
Macro Space Management database.

Note: Ensure <Return> is pressed for every entry. If not, the
information will not be stored in the central Macro Space
Management database.

Deleting a Manufacturer
Deleting a manufacturer is a three stage operation.

First, the required manufacturer is highlighted in the list then the Delete icon is clicked.

A confirmatory dialogue will appear.
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Clicking on Yes will delete the selected entry.

Note: at present the software does not validate if the
Manufacturer is referenced elsewhere in the software - for
example by Fixtures or Products. Before manually deleting a
Manufacturer, it is suggested that it is verified that the
Manufacturer is not in use. This may require a query in the
database.

Refreshing and Exiting
Refreshing is of use when multiple people are using the same option in Admin.

Clicking on the Refresh Icon will cause the list of manufacturers to be updated based on
current information from the central Macro Space Management database.
This allows users to see changes being made by other users.

Users can exit the Manufacturers dialogue box by clicking on the exit icon.
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Note: Ensure <Return> is pressed for the entry before
exiting. If not, the information will not be stored in the
central Macro Space Management database.

Using Manufacturers in Data Import
Macro Space Management has a Data Import module. This can be used to import data
from third party software.

Information on Manufacturers is held in the AVTTB_MANUFACTURER table.
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Using Manufacturer Information for Products
Data from this table can then be used for Products (MAN_TYPE = 0) in the
AVTTB_PRODUCT_DEF Table. The AVTTB_PRODUCT_DEF table holds two fields that
are foreign keys for the AVTTB_MANUFACTURER table;

MAN_ID holds the name of the manufacturer that appears in the Manufacturers Drop
down list on the SKU dialog box in Product Studio

MAN_ID_SUPPLIER holds the name of the Supplier that appears in the Suppliers Drop
down list on the SKU dialog box in Product Studio

Using Manufacturer Information for Fixtures
Data from this table can also be used for Fixtures (MAN_TYPE = 1) in the
AVTTB_BLOCK_DEFINITION Table. This table holds the MAN_ID field that acts as a
foreign key for the AVTTB_MANUFACTURER table.

Note: Before manufacturer related data can be added to
Fixtures or Products during imports via the Data Importer
module, it is first necessary to make sure that the list of
Manufacturers in the database contains all the
manufacturers referenced in the data to be imported.

Status & Status Levels

Overview

Overview of Statuses
Statuses are used within Macro Space Management to indicate where an object is within
a business life cycle. They also influence the behavior of In-Store Space Collaboration.
Statuses are maintained using the Status dialogue box accessed from the General menu.
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Note: Customizing Macro Space Management may be done
to customer specific requirements. Because of that
customization, there may be small differences between the
generic examples in this Help file and a specific
implementation of Macro Space Management. For advice on
any aspect of customization or terminology, please contact
Oracle's Technical Support Team.

For example a store could have Proposed status, Open status or Closed status depending
on whether it was at the planning stage, was in operation, or had been closed for
refurbishment. Similarly, a planogram could be at the planning stage (Proposed status),
in use (Current status), or superseded by a newer version (Historical status).

IMPORTANT NOTE: Once a status flow has been set up and
is in use, it is generally difficult to change it because the
software will not allow you to significantly edit or delete
statuses that are in use. Accordingly, status flow should be
carefully planned during the implementation of the software
so that subsequent changes are not required.

Statuses can be given to:

Some objects have independent status: for example Stores and Floors can have their
status changed without affecting the status of any objects below them in the hierarchical
tree.
Other objects have their behavior determined by their status. For example, it is not
possible to place a product of Historical status in a drawing.

Some status changes are reversible. For example a file may generally be swapped
between Proposed and Authorized status. Other changes are irreversible. For example,
once a file's status has been changed from Current to Historical it cannot normally be
changed back.
Understanding the changing status of objects is fundamental to the operation of Macro
Space Management.

Object Comment

Blocks Blocks are typically fixtures and other AutoCAD objects used in the Planner
environment

Files Files are store plans associated with a floor of a store

Floors A floor is the layout for a specific level within a store

Planograms Planograms are arrangements of products designed to go onto specific fixtures

Products Products can be given statuses at all levels in the hierarchy

Reports Statuses can be given to Planogram Report Layouts (not to the report themselves).

Revisions Revisions are folders containing a specific implementation of a store plan

Stores A store is a specific retail outlet.
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Status Levels
Each status must be assigned to a unique status level. The Status Level determines the
sequence the Status is used in. Status Levels are maintained using the Status Level
dialogue box accessed from the General menu.

Factors Affecting Statuses

System Variables
Some System Variables have an influence on Statuses.

Note: System Variables can be changed using the System
Variable option on the General Menu.

ENABLE_FILE_TRIGGER_DATES
ENABLE_FILE_TRIGGER_DATES can be set to one of three values:

Value Result Other Actions

0 or 1 UpdateStatus.exe is disabled and has no
effect on File or Revision statuses. Publish
and Effective dates are disabled and cannot
be set.

Publish and Current statuses need to be
selectable so that files can manually be taken
through the software cycle.

2 Effective date is enabled. UpdateStatus.exe
will change file status if the Effective date is
exceeded.

Publish needs to be manually selectable.

3 Publish and Effective dates are enabled. Publish and Current status should not be
selectable by the user so that update status
is the required method to change them.

Note: If ENABLE_FILE_TRIGGER_DATES is set to 0,
running UpdateStatus.exe will still change the status of a
store from Proposed to Open or from Open to Closed if the
Birth or Death dates are exceeded.

Note: this system variable should not be changed with the
Planner or Merchandiser modules open or unpredictable
results may occur.

MERCH_TREE_EFFECTIVE_DATE
This system variable can be set to On (1) or Off (0). If set to On, it affects whether fixtures,
products and planograms can be selected from the hierarchy in the object browser.

Effective Date Set
If an Effective date has been set for the drawing, fixtures, products and planograms
cannot be placed if:

1. Their Effective date is after the Effective date of the drawing

2. Their Expiry date is before the Effective date of the drawing
If an Active date has been set for the drawing, this overrides the Effective date for the
drawing. Then, fixtures, products and planograms cannot be placed if:

3. Their Effective date is after the Active date of the drawing
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4. Their Expiry date is before the Active date of the drawing

Note: MERCH_TREE_EFFECTIVE_DATE does not affect the
Object Grid

Custom SQL
Custom SQL can be used in conjunction with statuses to control what displays in the
hierarchies in the object grid. With the right custom SQL it is possible to:

1. Restrict the display of fixtures to those of Current status

2. Restrict the display of products to those of Current status
3. Restrict the display of planograms to those of Current status

At present the default is to display fixtures, products and planograms of all statuses.
Modifying the SQL to restrict the display of objects in the Object Browser can only be
done by administrators with access to the database.

Data Importer
If data is imported using Data Importer, it is possible to set the status for imported
objects to some default value - for example 'Proposal'.

Statuses and UpdateStatus.exe
UpdateStatus.exe is found in the C:\Program Files\Oracle Retail\MSM\APPS. When
run, it will:

1. Change the status of a file from Authorized to Published if the Publish Date has been
exceeded

2. Change the status of a file from Published to Current if the Effective Date has been
exceeded

3. Change the status of a file from Current to Historical if another file in that floor has
had its status changed to Current
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4. Change the status of a Store from Proposed to Open if the Opened Date has been
exceeded

5. Change the status of a store from Open to Closed if the Closed date has been
exceeded
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For UpdateStatus.exe to work correctly, the generic statuses associated with ID's in the
Status Levels dialogue box in the Administration module should not be changed. For
example, when UpdateStatus.exe changes statuses from Authorized to Current, it
changes the ID in the database from 4 to 2.

Making (for example) Current Status anything other than ID 2 will cause problems with
UpdateStatus.exe (and other Macro Space Management functionality.

Where Statuses are Set in the Software
Statuses can be manually set in the software.
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Note: Customizing Macro Space Management may be done
to customer specific requirements. Because of that
customization, there may be small differences between the
generic examples in this Help file and a specific
implementation of Macro Space Management. For advice on
any aspect of customization or terminology, please contact
Oracle's Technical Support Team.

Clusters
Clusters (and sub clusters) do not have statuses.

Stores
Store status is set in the Store Manager Module from the Add or Edit Store dialogue
boxes.

Floors
Floor status is set in the Store Manager Module from the Add or Edit Floor dialogue
boxes.
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Revisions
Revision status is set in the Store Manager Module from the Add or Edit Revision
dialogue boxes.

Files (Store Plans)
File status is set in the Store Manager Module from the Properties dialogue box.
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The status of a file can also be changed by clicking the Accept or Reject buttons on exiting
a changed store plan in In-Store Space Collaboration.

Blocks (Fixtures)
Block (fixture) status is set in the Fixture Studio Module from the Block Details dialogue
box.
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Products
Product status is set in the Product Studio module. They can be set at all levels in the
hierarchy except for display styles. For levels in the hierarchy between Company to Item,
the status is set in dialogue boxes similar to that below.
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For items at SKU level, the status is set in the Product SKU dialogue box.
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Planograms
Planogram status is set in the Merchandiser module from the Details tab of the
Planogram Design dialogue box.
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Reports
Report Status is set in Report Designer in the Report Properties dialogue box (accessed
from the File menu when a report is open).
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Statuses and In-Store Space Collaboration

Overview
Although statuses cannot be directly configured in In-Store Space collaboration:

1. The status of a store plan determines whether it can be seen in In-Store Space
Collaboration or not.

2. Clicking on Save Submit when closing a drawing in In-Store Space Collaboration
changes the status of the drawing. This will affect whether the drawing is still visible
in In-Store Space Collaboration and the status it is at in Macro Space Management.

Status of Store Plan
Store Plans can only be seen at specific statuses. This is configured using the Data
Security option in the Admin Module. User Groups can be assigned to Statuses.
Members of those User Groups will be able to see Store Plans (Files) belonging to those
statuses in In-Store Space Collaboration.

In the above example, users in the In-Store user group will be able to see files that have
been set to ISSC status in Macro Space Managements' Store Manager module.

Effect of Accept or Reject in In-Store Space Collaboration
When a drawing is closed in In-Store Space Collaboration (after making changes) a Save
dialogue box comes up with 'Accept' and 'Reject' options on it. (The nature of the
dialogue box seen by a specific user may vary slightly depending on settings in the
database).
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Clicking Accept will change the current status of the drawing to one further on in the
status flow for the drawing; clicking Reject will change the status of the drawing back to
a prior status.

Although the status itself can be set up using the Status Level and status dialogue boxes,
the statuses it changes to on 'Accept' or 'Reject' can only be set up directly in the database.

Configuring Statuses in Admin

Overview of Status Levels
Status Levels are the generic stages where actions related to statuses can be triggered in
the software. Status levels are called from the General menu.

This will bring up the Status Levels dialogue box
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Generic Status Levels
On installation, the software contains a series of generic statuses, each associated with a
status ID. The software (particularly for Stores, Files and Revisions) will carry out specific
actions associated with the Status Level ID (not the Status Level Description).
1. In some circumstances, manually changing the status of a Revision will change the

status of the files within it.

2. In some circumstances, the status of files and revisions can be changed automatically
by UpdateStatus.exe.

3. In some circumstances, the status of stores can be changed automatically by
UpdateStatus.exe.

These generic statuses should not be edited or deleted or there may be problems with
software functionality. The generic statuses are that should not be changed are:

1. Authorized

2. Published

3. Current

4. Historical

Custom Status Levels
It is possible to add custom status levels to the default status levels. This is because each
status must be associated with a unique status level. If a status work flow has ten statuses
in it, there must be ten status levels configured in the Status Levels dialogue box.
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Accordingly, the generic description can be slightly modified - for example changing
'Proposed' to 'Proposal' - but the generic description associated with a particular Status
Level ID should not be changed. For example associating 'Historic' status with Status
Level ID 4 (rather than 3) will cause problems with the operation of the software.

Custom Status Levels should therefore be added to the generic Status Levels and not
substituted for them.

Using Status Levels
The Descriptions in the Status Level dialogue box appear within the Status dialogue
box as the Level for a specific status. Each status must be associated with a specific and
unique status level.
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In the example below it has been decided to add an ISSC status to the statuses to denote
store plans (files) available to users in In-Store space collaboration. In order to add the
Status in the Status dialogue box, it is first necessary to add an ISSC status level to the
Status Levels dialogue box.



Status & Status Levels

42 Oracle Retail Macro Space Management

If you attempt to create a new status and associate it with a status level that is not unique
to that status, a warning will result.

About Status Options
The Status dialogue box is used to configure the varying Statuses used to control
business flows within Macro Space Management. It can also be used to partially
configure the behavior of statuses within In-Store Space Collaboration, although the rest
of this configuration has to be done directly in the database.
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Note: Customizing Macro Space Management may be done
to customer specific requirements. Because of that
customization, there may be small differences between the
generic examples in this Help file and a specific
implementation of Macro Space Management. For advice on
any aspect of customization or terminology, please contact
Oracle's Technical Support Team.

Statuses may be added, edited or deleted by selecting the appropriate options from the
menu bar or toolbar.

It is recommended each status type contain a minimum of three status levels. These
would normally include Proposed, Current and Historic.

Note: As changes to the configuration of statuses may have
wide effects within Macro Space Management, it is
suggested that modifications are only made after consulting
Oracle's Technical Support Team.

Type
Type defines the type of object the status will be assigned to. It is selected from a drop
down list that is not user configurable.

Level
Level indicates where in the flow for that object that status comes. Each level must
correspond to a unique status level defined in the Status Levels dialogue box.
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Note: Status Levels are assigned a Status ID in the database.
These Status ID's are not visible to or configurable by the
user. Certain Macro Space Management actions are tied to
those Status ID's. For example archiving is carried out on
files with a Status ID of 4. If superseded (Historical) files are
given a Status with an ID of anything other than 4, archiving
will not work.

Description
This is a user configurable field that allows users to customize the description of
associated with the level. This description then appears in the varying dialogue boxes
that use status. For example, it would be possible to assign the description 'Superseded'
to the Historical level.

Order
This is the order that the statuses will be used (and the order they will appear in any
dialogue boxes).

Reversible
If a status is set to reversible, it can be changed back to a status lower in the order by the
user. If a status is not reversible, then the user cannot revert to an earlier status. It would
not be normal (for example) for the change between Authorized and Current Status to be
reversible.

Note: at present only file statuses are non-reversible.

Read Only
If a Status is set to read only status, all associated objects and files will be able to be
viewed, but not altered. Objects with Statuses that are not set to read only status may be
freely edited. As example of an object set to read only status would be a fixture that has
been set to historic status - as the fixture is no longer in service, there would be no need
to edit it.

Note: at present only files are set to read only status. This
can be directly as a result of the file having its status
changed, or indirectly as a result of the parent store, floor or
revision having its status changes to one with read only
attributes. For example, changing a floor to closed status
will generally result in the files associated with that floor
becoming 'read only'.

Selectable
If a status is selectable it can be set by the user. If it is not selectable, then the status can
only be changed by the software.

Accept
The Status specified in the Accept column is the status that the original status will be
changed to if a User:

1. Clicks the Accept or Submit buttons in the Save dialog box of In-Store Space
Collaboration

2. When prompted to Submit or to Accept in Planogram Substitution
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Reject
The Status specified in the Reject column is the status that the original status will be
changed to if a User:

1. Clicks the Reject button in the Save dialog box of In-Store Space Collaboration

2. When prompted to Reject in Planogram Substitution

Approve
The Approve check box will enable and disable the existing functionality of listing of files
for approval via the District Manager button in ISSC. This will only have an effect for file
statuses.

Each file status that has the Approve check box ticked will appear in the list of available
files in the Select Store dialog box when the district Manager button is clicked.

Code
The code column allows uses Administrators to enter any status codes in use in third
party software. When data is imported from that software, the code column can be used
as a 'look-up' to map the third party status to its Macro Space Management equivalent.

Basic Example of Configuring Statuses
A basic example for configuring statuses is the flowchart below for planograms designed
within the Merchandiser module.

This allows planograms to be started at the design stage, be accepted by a manager, go
into service and be retired (historical). This is set up in the Status dialogue box as follows:
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Type
This is obviously set to planogram.

Levels and Descriptions
These are selected from the Status Levels dialogue box, ensuring that the description we
will use later matches up to the appropriate level.

In this instance the Proposed Status Level is matched to the Design description, the
Authorized Status Level is matched to the Accepted Description, the Current Status
Level to the In Service description and the Historic Status Level to the Historical
description.

Order
The order is set to the sequence the statuses will be used in: 1 for Design, 2 for Accepted,
3 for in Service and 4 for Historical.
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Reversible
Only Authorized status needs to be reversible - giving the option of revering back to
Design status. Current and Historical statuses should not be reversible as planogram in
service or having been retired (historical) should not be capable of being edited.

Read Only
Typically statuses would be set to read only when the planogram design has been fixed -
for example at 'In Service' or 'Historical' status.

Note: at present setting planograms to Read Only status has
no effect.

Selectable
Statuses have to be marked as selectable to be visible in the Planogram design dialogue
box. In this case, we need all statuses to be selectable, so all have been checked. They will
then be available in the Planogram Design dialogue box.

Advanced Example of Configuring Statuses
An advanced example of configuring file statuses can be seen in the flowchart below.
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Here the file has three statuses that are set in Macro Space Management's Store Manager
Module. The third of these statuses (ISSC) is also visible in In-Store Space Collaboration,
where users can click the Accept or Reject buttons on exiting the drawing.

Clicking the Accept button in In-Store Space Collaboration will change the status to
authorized; clicking the Reject button in In-Store Space Collaboration will change the
status back to Accepted.

When the drawing reaches Authorized status (and Publish and Effective dates have been
set), the UpdateStatus.exe tool will result in the file successively changing to Published,
Current and Historical status.

This is set up in the Status dialogue box as follows:
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In order to add two additional statuses (Accepted and ISSC) to the existing statuses, two
additional levels must first be added to the Status Levels dialogue box.

The additional statuses can then be added to the Status dialogue box.

Type
This is obviously set to planogram.

Levels and Descriptions
These are selected from the Status Levels dialogue box, ensuring that the description we
will use later matches up to the appropriate level.
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In this instance the Proposed Status Level is matched to the Proposed description, the
Accepted Status Level is matched to the Accepted Description, etc.

Note: care was taken to map the Authorized, Published, Current and Historical
descriptions to their respective levels in the status levels dialogue box. This is because the
software will carry out specific actions associated with these statuses.

Order
The order is set to the sequence the statuses will be used in: 1 for Proposed, 2 for
Accepted, etc.

Reversible
Several statuses have been made reversible (Authorized, ISSC and Accepted). This allows
users to change the status back to a prior one if the store plan is not regarded as
acceptable.

Read Only
Statuses have been set to Read Only at Published, Current and Historical status. This is
because once a drawing has been published (sent to a store for implementation) it should
be 'locked' to prevent further changes in it.

Selectable
Statuses have to be marked as selectable to be visible in the Properties dialogue box. In
this case, we need the Proposed, Accepted and ISSC statuses to be selectable, so they
have been checked.

Authorized status has not been made selectable. This means that the status can only be
reached by clicking the Accept button in In-Store Space Collaboration. This is an example
of how statuses can be used to ensure business processes are followed.

Accept
The Status specified in the Accept column is the status that the original status will be
changed to if a User clicks the Accept or Submit buttons in the Save dialog box of In-
Store Space Collaboration. This is set to 'Authorized'.

Reject
The Status specified in the Reject column is the status that the original status will be
changed to if a User clicks the Reject button in the Save dialog box of In-Store Space
Collaboration. This is set to 'Accepted'.

Approve
The Approve check box will enable and disable the listing of files for approval via the
District Manager button in ISSC.
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Any status for files that should appear when the District Manager button is clicked
should have the Approve checkbox ticked.

Code
The code column allows uses Administrators to enter any status codes in use in third
party software. When data is imported from that software, the code column can be used
as a 'look-up' to map the third party status to its Macro Space Management equivalent.

System Variables

Index to System Variable Options
This section of the Help File explains about System Variables.

System Variables

Overview The basics of System Variables

Macro Space Management System Variables

Adjacencies System Variables that affect Adjacency Calculations

Area Calculations System variables that affect Area Calculations

LDAP and MSM How LDAP (Lightweight Directory Access Protocol) can be integrated
with MSM

Merchandiser System variables that affect the operation of Merchandiser.

Planogram Importer System variables that affect the operation of the Planogram Import
module

In-Store Space Collaboration System Variables

General Options In-Store Space Collaboration system variables that have a general effect.

Controlling Text System variables that have affect ISSC text

Dimensions, Markups
and Notes

System variables that affect ISSC Dimensions, Mark ups and Notes

Fixture Attributes System variables that affect ISSC Fixture Attributes
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N
o

te: the System Variables that are described are those that can
only be set through the System Variables dialogue box in the
Administration module. System variables that can be set
using dialogue boxes, etc in the varying modules are not
described.

Links within this page will take users to the selected part of the Help File.

Note: It is also possible to find information via the Index or
Search options provided.

The following principles should be followed when working with system variables:

1. System Variables should not be added or deleted.

2. The only information that should be edited for a System Variable is the Description
and the Value.

System Variables

Overview of System Variables
A System Variable is a parameter within the Macro Space Management database that
specifies how one aspect of the software operates. System variables are often used as
switches to toggle features on and off, hold dimensions and positions of dialogue boxes,
etc.
The following principles should be followed when working with system variables:

1. System Variables should not be added or deleted.

2. The only information that should be edited for a System Variable is the Description
and the Value.

System Variables can be changed in several ways.

1. Through dialogue boxes in the software

2. Through the Configuration Module
3. Through the Administration Module

Not in Use ISSC System Variables that currently have no effect
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Through the Software
System variables can be changed through the software. This may be explicit, as when the
user deliberately selects a value in a dialogue box. It may also be implicit, as some system
variables are used to hold the values of (for example) the positions and sizes of dialogue
boxes.

For example, the Merchandiser Module allows the 'Add Shelf with Product Silently'
option to be toggled on or off. The value of this setting is stored in the
ADD_PRODUCT_WITH_SHELF system variable.

Through the Configuration Module
The Configuration Module allows a series of settings to be customized by the user. Some
are saved as system variables.
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For example, the colors for the connection points set in the Fixturing tab are stored in a
series of system variables called MALE_BACK_COLOUR, MALE_BOTTOM_COLOUR,
etc

Through the Administration Module
This option allows system variables to be directly changed instead of doing it via the
software. This is done using the System Variable option from the General Menu.

This allows a user with Administrator's privileges to change the value of a system
variable.
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Changing system variables can have wide ranging effects on the way Macro Space
Management. Before making a change it is recommended users should:

1. Ensure they understand the effect of changing the system variable

2. If necessary seek advice from Oracle's Technical Support team

System Variable Options
Each System Variable has a series of options associated with it.

Name
This is the name of the system variable. The name should not be changed as the software
references these names - changing a name will result in the software failing to find data
in the database.

Description
This describes what the system variable does. It can be edited to suit customer needs.

Type
This specifies whether the system variable is System (global), User (specific to an
individual) or File (associates properties with a file). System Variable Types are
determined by the software code and changing the type from the Type dropdown list has
no influence on where the system variable value is stored. The Type should not be
changed from the value it was set to on implementation. More Information

Value
This is the current value held for the system variable. The value must be consistent with
the data type.

Note: System variables of the form 100|100|100|100 are
known as pipe-delineated system variables. They hold the
multiple values required for that system variable.

Data Type Example

String Any alphanumeric input (ABC123)

Integer Any Integer (1,2,3) in the range -2 billion to +2 billion
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Long Any Integer (1, 2, 3) in the range -9 x 1018 to 9 x 1018.

Single Any number (1.23, 2.2345) in the range -3 x 1038 to 3 x 1038.

Double Any number (1.23, 2.2345) in the range -2 x 10308 to 2 x 10308.

Date Date (10/10/07 12.15:00:00)

Boolean True or False values (0,1)

Image Bit Maps, GIF and JPG images

Currency Financial data (£1234.00)

For example, a system variable holding the position of a dialogue box might be of the
form 100|300|600|600 where the data specifies the left bottom and top right co-
ordinates of the dialogue box. When editing a pipe-delineated system variable, all
pertinent values must be entered or the system will error.

Data Type
This is the type of data. It must be consistent with the value to be stored for the system
variable. Types can selected from a drop down list, but should not be changed from those
set on implementation. They are of the following types:

Active
This specifies whether the system variable is in use or not. Settings should not be
changed from those set on implementation.

Category
This specifies which module the system variable affects. Settings should not be changed
from those set on implementation as the software uses this setting to see which system
variables should be read when opening a module.

System Variable Types
The System Variable Type determines the purpose of the system variable. There are
three system variable types:

1. System

2. User

3. File

System
System Variables of type 'System' are global system variables. Changing the value of this
type of system variable will affect all users of the system. The values of this type of
system variable are written to the AVTTB_SYSTEM_VARIABLE table in the database.

User
System Variables of type 'User' are specific to one user. They are typically used to hold
that users' preferences. The values of this type of system variable are written to the
AVTTB_USER_VARIABLE table in the database.
When a user first uses functionality on becoming a Macro Space Management, they start
with the defaults from the AVTTB_SYSTEM_VARIABLE table, thereafter; their
preferences are stored in the AVTTB_USER_VARIABLE table.
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File
System Variables of type 'File' are used to assign properties to files on creation. Users can
then overwrite the default with their own value. The values of this type of system
variable are written to the AVTTB_SYSTEM_VARIABLE table in the database. The
default value is then also written to the appropriate table for a file when that file is
created.

AVTTB_SYSTEM_VARIABLE and AVTTB_SYSTEM_VARIABLE_TYPE Tables
There is some information on the AVTTB_SYSTEM_VARIABLE and
AVTTB_SYSTEM_VARIABLE_TYPE Tables that may be useful to Database
Administrators.

The SVR_TYPE field in the AVTTB_SYSTEM_VARIABLE table does not hold
information on the Type field in the System Variables dialogue box. Information is
determined from the SVR_IS_USER_DEF and SVR_ISFILE_PREF fields. If both these
fields are set to false (0) the system variable will be of type 'System'. If either of the fields
are true (1), the system variable type will be set to 'User' or 'File'. (The fields cannot both
be set to true simultaneously).
The SVR_TYPE field corresponds to the category for the system variable. It references the
AVTTB_SYSTEM_VARIABLE_TYPE table - which contains a list of the different parts of
the application the system variable could apply to.
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Adding, Editing and Deleting System Variables
Adding, Editing or Deleting system variables is via the options on the Toolbar or Menu
Bar.

The following principles should be followed when working with system variables:

1. System Variables should not be added or deleted.
2. The only information that should be edited for a System Variable is the Description

and the Value.

Adding System Variables
There is no purpose in adding system variables. These will only have an effect if they are
referenced the code in the software.

Editing System Variables
System variables can be edited via the Admin Module as an alternative to changing them
via the software. This should be done with caution.

Deleting System Variables
System Variables should only deleted after consulting the Oracle Support team. Deleting
a system variable in use with the software can cause significant problems.

Note: Deleting keys system variables referenced by the
software may cause the system to suffer a critical failure.

Grouping by Columns
The user has the option of grouping system variables together by column header types.
To do this drag a column header into the indicated space at the head of the dialogue box.

This will group all the system variables by the selected criteria - for example Type.
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Clicking on the '+' sign will expand the list and allow users to see all system variables in
that group.

To return to the default display, just drag the selected column header out of the space at
the head of the dialogue box.

System Variable Descriptions

In-Store Space Collaboration

General Options



System Variables

60 Oracle Retail Macro Space Management

CLIENT_VERSION

The CLIENT_VERSION system variable is set automatically on installation of In-Store
Space Collaboration. It will be updated automatically if upgrade scripts, etc, are run.
There is no need to manually change the value.

SERVER_VERSION

The SERVER_VERSION system variable is set automatically on installation of In-Store
Space Collaboration. It will be updated automatically if upgrade scripts, etc, are run.
There is no need to manually change the value.

IN-STORE_SMTPSERVER

The IN-STORE_SMTPSERVER system variable is used to identify the email server that
will be used to send messages when authentication for In-Store Space Collaboration is
done via LDAP (Lightweight Directory Access Protocol). The value stored for the system
variable must be a valid address for the STMP server.

The emails are triggered when the status of the drawing is changed; either through the
'Save and Submit' button or via the Accept and Reject buttons.

Note: Which a form of the dialogue box a user can see is
determined by settings in the AVTTB_PROCESS table in the
database.

Save and Submit Button
(This dialogue box is typically assigned to a Store Planner).

If the Save and Submit button is clicked, the status of the drawing will be changed and an
email sent to the manager defined as the user's manager in the LDAP system.

Accept and Reject
(This dialogue box is typically assigned to a Store Planner's Manager).

If the Accept or Reject buttons are clicked, the status of the drawing will be changed and
an email sent to the last person to work on the drawing before the manager accepted or
rejected the drawing.
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Email Template
The template for the email message that will be sent is located in the C:\Program
Files\Oracle Retail\ISSC\ISSC Server Service folder. It is the EmailFormat.xml file.

IN-STORE_HELPLOCATION

The IN-STORE_HELPLOCATION system variable contains the URL (Uniform Resource
Location) for the help files for In-Store-Space Collaboration. It should detail both the path
to the directory and the name of the file used to open the help.

Note: In-Store Space Collaboration Help is in Webhelp
format. This differs from the CHM files used for Macro
Space Management.

IN-STORE_TIMEOUT

The IN-STORE_TIMEOUT system variable sets the time in seconds that the In-Store
Space Collaboration Client will wait for a response from the database before it detects a
time out has occurred.

Once the time out time has been exceeded, a warning dialogue will appear. The time the
dialogue box displays is controlled by the IN-STORE_TIMEOUT_MESSAGE system
variable.
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IN_STORE_TIMEOUT_MESSAGE

The IN-STORE_TIMEOUT_MESSAGE system variable determines the amount of time
the warning message will display after a time out has occurred. After the time set in the
IN-STORE_TIMEOUT_MESSAGE has expired, In-Store Space Collaboration will
automatically shut down (unless the wait button is clicked).

Note: The time before a time out is triggered is determined
by the IN-STORE_TIMEOUT system variable.

IN-STORE_MERGE_PLANOGRAMS

The IN-STORE_MERGE_PLANOGRAMS system variable allows the user to specify
whether planograms are merged or not. There are two possible values:

0 - do not Merge Planograms

1 - Merge Planograms

If Merge Planograms is on, the software looks for instances of the same planogram
placed on multiple adjacent fixtures and converts then to a single, multiple bay
planogram in the database.

Note: this feature is not yet fully implemented.

MODULE_BLK_ID

The MODULE_BLOCK_ID system variable is used to identify the block used when
moving products temporarily into an aisle. This functionality is used in In-Store Space
Collaboration, but not in Macro Space Management. The value should correspond to the
ID of a suitable block in the table of Block Details in Fixture Studio.
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SKIP_ZONE_SELECT

The SKIP_ZONE_SELECT system variable affects whether the Select Data dialogue box
is shown during the process of selecting a store plan to work on in In-Store Space
Collaboration. All users see the Select Store dialogue box.

When a store has been selected, an optional Select Data dialogue box allows users to
select which of the zones they wish to display.
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SKIP_ZONE_SELECT determines where the Select Data dialogue box displays or not;
1. If set to 0, the dialogue box will display and users will be able to select zones before

opening the store plan

2. If set to 1, the dialogue will not appear and the store plan will open displaying all
zones

Controlling Text

OPTIONS_LEGEND_FONT

The OPTIONS_LEGEND_FONT system variable is used to specify the fond used for the
legend displayed on screen and in printed output for KPI's.
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Users may choose any font in the Windows Collection.

Note: it is suggested a common, easily read font is selected.
Such fonts include Arial, Times New Roman, Tahoma or
Verdana.

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will
default to a suitable font.

Note: this functionality is not yet fully implemented.

OPTIONS_LEGEND_FONT_SIZE

The OPTIONS_LEGEND_FONT_SIZE system variable is used to specify the font size
used for the legend displayed on screen and in printed output for KPI's.
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Note: this functionality is not yet fully implemented.

OPTIONS_FOOTER_FONT

The OPTIONS_FOOTER_FONT sets the font used for the footer in all printed reports.
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Users may choose any font in the Windows Collection.

Note: it is suggested a common, easily read font is selected.
Such fonts include Arial, Times New Roman, Tahoma or
Verdana.

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will
default to a suitable font.

OPTIONS_FOOTER_FONT_SIZE

The OPTIONS_FOOTER_FONT_SIZE sets the size used for the font in the footer in all
printed reports.
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OPTIONS_HEADER_FONT

The OPTIONS_HEADER_FONT sets the font used for the header in all printed reports.



System Variables

General Options 69

Users may choose any font in the Windows Collection.

Note: it is suggested a common, easily read font is selected.
Such fonts include Arial, Times New Roman, Tahoma or
Verdana.

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will
default to a suitable font.

OPTIONS_HEADER_FONT_SIZE

The OPTIONS_HEADER_FONT_SIZE sets the size used for the font in the header in all
printed reports.
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Dimensions, Mark-ups and Notes

IN-STORE_DIMENSION_AROW

The IN-STORE_DIMENSION_ARROW system variable currently has no effect.

IN-STORE_DIMENSION_STYLE

The IN-STORE_DIMENSION_STYLE system variable controls the way dimensions
display.



System Variables

General Options 71

There are three options for the system variable:

0 will display the dimension without ticks or arrows (left hand image)

1 will display the dimension using ticks (centre image)

2 will display the dimension using arrow heads (right hand image).

IN-STORE_MARKUP_LINEWIDTHMAX

The IN-STORE_MARKUP_LINEWIDTHMAX System Variable is used in In-Store space
collaboration. User can select the Mark Up option from the toolbar then draw a freehand
mark round part of the drawing. The IN-STORE_MARKUP_LINEWIDTHMAX system
variable controls the weight of the heavy line produced when the user holds down the
right mouse button while drawing the Mark Up.

IN-STORE_MARKUP_LINEWIDTHMIN

The IN-STORE_MARKUP_LINEWIDTHMIN System Variable is used in In-Store Space
Collaboration. User can select the Mark Up option from the toolbar then draw a freehand
mark round part of the drawing. The IN-STORE_MARKUP_LINEWIDTHMIN system
variable controls the weight of the thin line produced when the user holds down the left
mouse button while drawing the Mark Up.
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IN-STORE_MARKUP_TEXT_SIZE

The IN-STORE_MARKUP_TEXT_SIZE System Variable allows users to select the Font
Size used for annotating dimensions.

The font size is in arbitrary units and users may need to experiment before finding a
suitable setting.

IN-STORE_MARKUP_TEXT_FACE

The IN-STORE_MARKUP_TEXT_FACE System Variable allows users to select the Font
Type used for annotating dimensions.

Users may choose any font in the Windows Collection.
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Note: it is suggested a common, easily read font is selected.
Such fonts include Arial, Times New Roman, Tahoma or
Verdana.

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will
default to a suitable font.

NOTE_FONT

The NOTE_FONT system variable determines the font used for Notes (initiated from the
toolbar) within In-Store Space Collaboration.

Users may choose any font in the Windows Collection.

Note: it is suggested a common, easily read font is selected.
Such fonts include Arial, Times New Roman, Tahoma or
Verdana.

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will
default to a suitable font.

NOTE_FONT_SIZE

The NOTE_FONT_SIZE system variable determines the size of the font used for Notes
(initiated from the toolbar) within In-Store Space Collaboration.
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Fixture Attributes

IN-STORE_FIX_ATTRIBUTES_VERSION

The IN-STORE_FIX_ATTRIBUTES_VERSION system variable allows users to control
the type of Attributes dialogue box that appears when the Fixture Attributes option is
selected from the toolbar.

There are two options:

1. A setting of 1 will show a basic dialogue box.

2. A setting of 2 will show a more complex dialogue box.

Note: At present only the 'complex' dialogue box is available
- changing the system variable has no effect.

IN-STORE_FIX_ATRIB_VER

The IN-STORE_FIXTURE_ATTRIB_VER system variable is not current used.
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IN-STORE_FIX_ATTRIBUTES_PRINT_FONT

The IN-STORE_FIX_ATTRIBUTES_PRINT_FONT system variable changes the font used
for the information in the Fixture Attributes report.

Users may choose any font in the Windows Collection.

Note: it is suggested a common, easily read font is selected.
Such fonts include Arial, Times New Roman, Tahoma or
Verdana.

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will
default to a suitable font.

The Fixture Attributes Report is called by clicking the Print button in the Fixture
Attributes dialogue box called from the Fixture Attributes icon on the toolbar.

IN-STORE_FIX_ATTRIBUTES_PRINT_FONT_SIZE

The IN-STORE_FIX_ATTRIBUTES_PRINT_FONT_SIZE system variable is used to set the
size of the font used in the information in the Fixture Attributes report.
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The Fixture Attributes Report is called by clicking the Print button in the Fixture
Attributes dialogue box called from the Fixture Attributes icon on the toolbar.

IN-STORE_FIX_ATTRIBUTES_PRINT_HEADING FONT

The IN-STORE_FIX_ATTRIBUTES_PRINT_HEADING_FONT system variable changes
the font used for the Heading in the Fixture Attributes report.

Users may choose any font in the Windows Collection.

Note: it is suggested a common, easily read font is selected.
Such fonts include Arial, Times New Roman, Tahoma or
Verdana.

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will
default to a suitable font.
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The Fixture Attributes Report is called by clicking the Print button in the Fixture
Attributes dialogue box called from the Fixture Attributes icon on the toolbar.

IN-STORE_FIX_ATTRIBUTES_PRINT_HEADING_FONT_SIZE

The IN-STORE_FIX_ATTRIBUTES_PRINT_FONT_SIZE system variable is used to set the
size of the font used in the Heading in the Fixture Attributes report.

The Fixture Attributes Report is called by clicking the Print button in the Fixture
Attributes dialogue box called from the Fixture Attributes icon on the toolbar.
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IN-STORE_FIX_ATTRIBUTES_PRINT_HIGHLIGHTS

The IN-STORE_FIX_ATRIBUTES_PRINT_HIGHLIGHTS system variable allows users to
select whether the report output when the print button is clicked on the Fixture attributes
dialogue box will have highlighted information in it.

Note: this functionality is not currently operating.

ISSC System Variables not in Use

IN-STORE_GRIP_COLOUR

The IN-STORE_GRIP_COLOUR system variable is for future functionality and has not
yet been implemented.

IN-STORE_GRIP_HOTCOLOUR

The IN-STORE_GRIP_HOTCOLOUR system variable is for future functionality and has
not yet been implemented.

IN_STORE_GRIP_SIZE

The IN-STORE_GRIP_SIZE system variable is for future functionality and has not yet
been implemented.

IN_STORE_PROMOTION_USER_GROUP

The IN_STORE_PROMOTION_USER_GROUP system variable is not presently in use.

IN-STORE_STORE_SELECTION_LEVEL

The IN-STORE_STORE_SELECTION_LEVEL system variable is not currently in use.
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IN-STORE_SUBMIT_STATUS

The IN-STORE_SUBMIT_STATUS system variable used to determines what happened
when the Accept button in the Save dialogue box is clicked.

Note: there are three versions of this dialogue box. Which a
user can see is determined by settings in the
AVTTB_PROCESS table in the database.

This has now been superseded by entering the required information into the
AVTTB_STATUS table in the STA_ACCEPT and STA_REJECT columns. This system
variable is therefore no longer used.

MAX_FIXTURE_SELECTION

The MAX_FIXTURE_SELECTION system variable was used in In-Store Space
Collaboration to set the maximum number of fixtures that could be included in a
selection set.
It is no longer used and has no effect on the software.

OPTIONS_FONT

The OPTIONS_FONT system variable is not in use. It relates to an older version of In-
Store Space Collaboration.

OPTIONS_FONTSIZE

The OPTIONS_FONTSIZE system variable is not in use. It relates to an older version of
In-Store Space Collaboration.

OPTIONS_PREPOPULATEDPRODUCTS

The OPTIONS_PREPOPULATEDPRODUCTS system variable is no longer in use.

Macro Space Management

Adjacency Calculations

Overview of Adjacency Calculations

Adjacency Calculations are used to establish the relationship of objects to one another.
There are three forms of Adjacency Calculations:

1. Fixture Adjacency is the relationship of one fixture to another.

2. Product Adjacency is the relationship of one product to another.
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3. Aisle Adjacency identifies which products share an aisle.

Fixture Adjacency calculations can be initiated from the Planner and Merchandiser
modules in Macro Space Management and from In-Store Space Collaboration. Product
and Aisle Adjacency calculations are initiated from the Planner module in Macro Space
Management

Fixture Adjacency
There are a series of System Variables that affect how the Fixture Adjacency calculations
work. These are:

1. ADJACENCY_FIXTURESIZE

2. ADJACENCY_FRONTBACK

3. ADJACENCY_LATERALGAP

4. ADJACENCY_MAX_ANGLE

5. ADJACENCY_OVERLAP
6. ADJACENCY_SEARCH

7. ADJACENCY_TOLERANCE

8. ADJACENCY_VERTICALGAP

Note: some of these system variables are not currently in
use.

Product Adjacency
Product Adjacency relies on the relationship of fixtures to one another - determined by
the Fixture Adjacency calculation. This relationship can then be used to determine what
products are on the fixtures, and hence which products are adjacent to one another.

There is no system variable associated with Product Adjacency.

Aisle Adjacency
Aisle Adjacency is used to establish which fixtures are adjacent to an aisle (defined as a
line in a Planner store plan). This relationship can then be used to determine what
products are on the fixtures, and hence which products share the aisle.

There is a single system variable affecting Aisle Adjacency: ADJACENCY_AISLESIZE.

Fixture Adjacency Calculations

Fixture Adjacency is the relationship of one fixture to another. It is called from three
places within the software:
1. From the Calculations menu or toolbar in the Planner module

2. From the Calculate menu in the Merchandiser Module

3. From the toolbar in In-Store Space Collaboration

In each instance, the same functionality is called and the results written back to a
common table in the database.

Note: Fixture Adjacency only applies to fixtures. Fittings,
shelves, etc are excluded from the calculations

For Fixture Adjacency calculations, fixtures may be:

1. To the right of another fixture
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2. To the left of another fixture

3. Behind another fixture

4. In front of another fixture

5. Sharing an aisle with a fixture
6. Above another fixture

A specific adjacency for a fixture may be a combination of these options.

In the example above:

Fixture 1 is adjacent to the left of fixture 2.

Fixture 3 is adjacent to the right of fixture 2.

Fixture 6 is adjacent to the left and behind fixture 2.
Fixture 5 is adjacent behind fixture 2.

Fixture 4 is adjacent to the right and behind fixture 2.

Fixture Adjacency is subsequently used in Product Adjacency calculations, where the
relationship of one fixture to another can be used to establish the relationship between
the products they have been merchandised with.

ADJACENCY_FIXTURESIZE

The ADJACENCY_FIXTURESIZE System Variable is used to filter out fixtures below a
certain size for the purpose of Fixture Adjacency calculations.

In the above example, the central fixture is narrow. If its length (width) is above the value
of the ADJACENCY_FIXTURESIZE System Variable, the central fixture will be included
in the fixtures used for Fixture Adjacency calculations. If its length (width) is below the
value of the ADJACENCY_FIXTURESIZE System Variable, the central fixture will be
excluded from the Fixture Adjacency calculations.

ADJACENCY_FRONTBACK

The ADJACENCY_FRONTBACK System Variable is used to specify the maximum
distance between fixtures that are back to back that allows then to be regarded as
adjacent behind a specific fixture.



System Variables

82 Oracle Retail Macro Space Management

In the example above, fixture 2 is separated by a gap from fixture5. If this gap is below
the value specified in ADJACENCY_FRONTBACK, fixture 5 will be regarded as adjacent
(behind) fixture 2. If the gap is above the value specified in ADJACENCY_FRONTBACK,
fixture 3 will not be regarded as adjacent.

Note: At present the Front/Back distance used for fixture
adjacency calculations is taken from the
ADJACENCY_LATERALGAP System variable.

ADJACENCY_LATERALGAP

The ADJACENCY_LATERALGAP System Variable is used to specify the maximum
lateral distance between fixtures that allows them to be regarded as adjacent to left and
right of a specific fixture.

In the example above, fixture 3 is separated from fixture 2 by a gap. If this gap is below
the value specified in ADJACENCY_LATERALGAP, fixture 3 will be regarded as
adjacent (to the right) to fixture 2, if the gap is above the value specified in
ADJACENCY_LATERALGAP, fixture 3 will not be regarded as adjacent.

It is possible to set ADJACENCY_LATERALGAP to a value such as 24 inches (610 mm)
so that fixtures that are either side of a pillar are regarded as adjacent.

ADJACENCY_MAX_ANGLE

The ADJACENCY_MAX_ANGLE System Variable is used for gondolas.

If the angle between adjacent fixtures is less than the ADJACENCY_MAX_ANGLE
System Variable, the fixtures will be regarded as belonging to the same side. If the angle
between adjacent fixtures is greater than the ADJACENCY_MAX_ANGLE System
Variable, the fixtures will be regarded as belonging to the different sides.

In the double sided gondola with endcaps below, the ADJACENCY_MAX_ANGLE
System Variable was set to 30 degrees. Each time the angle between two successive
adjacent fixtures have an angle exceeding thirty degrees, a new side is created. The
fixtures making up the example gondola have been numbered according to the gondola
numbering convention: Gondola Number/Side/Level/Fixture Number. The gondola
thus has four sides.
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In the snake gondola below, the angle between the second and third fixtures is below that
specified in the ADJACENCY_MAX_ANGLE System Variable, so the first three fixtures
are treated as belonging to a single gondola side. The angle between the third and fourth
fixtures is above that specified in the ADJACENCY_MAX_ANGLE System Variable, so
the last two fixtures are treated as belonging to another gondola side.

ADJACENCY_OVERLAP

The ADJACENCY_OVERLAP system variable is not presently in use.

ADJACENCY_SEARCH

The ADJACENCY_SEARCH system variable is not presently in use.

ADJACENCY_TOLERANCE

The ADJACENCY_TOLERANCE system variable is not presently in use.

ADJACENCY_VERTICALGAP

The ADJACENCY_VERTICALGAP System Variable is used to specify the maximum
distance between fixtures that are stacked vertically that allows them to be regarded as
adjacent above a specific fixture.
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In the example above, one fixture is above another. If the vertical gap between the
fixtures is less than the ADJACENCY_VERTICALGAP System Variable, the top fixture
will be regarded as adjacent above the lower fixture. If the vertical gap between the
fixtures is more than the ADJACENCY_VERTICALGAP System Variable, the top fixture
will be regarded as adjacent above the lower fixture.

Note: the ADJACENCY_VERTICALGAP System Variable is
not taken into account by the software at present, so any
fixture above another is regarded as 'adjacent above'.

ADJACENCY_AISLESIZE

The ADJACENCY_AISLESIZE system variable is used to establish a distance tolerance
from an Aisle. Fixtures within this distance from an aisle are regarded as adjacent to it;
fixtures outside this distance are not.
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Depending on the setting of the ADJACENCY_AISLESIZE system variable, Fixtures 15
and 16 may or may not be regarded as adjacent to the Aisle. It is then possible to
determine which products are on the fixtures adjacent to the aisle, and hence which
products share the aisle.

Note: Aisle adjacencies are calculated relative to the front
direction of the fixture. Fixtures 1, 8 and 9 - 14 will not be
shown as adjacent to the drawn aisle because a line drawn
out perpendicular from the front face of the fixtures will not
intersect the aisle.

Area Calculations

Overview of Area Calculations

Area Calculations are used to establish the amount of floor area apportioned to
individual fixtures. The function can only be called in the Planner Module from the
Calculations menu or the Calculations toolbar. This will bring up the Area Calculation
dialogue box.
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This shows the area allocated to specific fixtures - lighter shades of blue indicating that
areas shared by two or more fixtures.

The settings in the Area Calculation Directions frame in the Category tab of the Block
Details dialogue box affect the nature of area calculations - areas will only be calculated
in the ticked directions.

This can be seen by comparing the two examples of are calculations below. The top
image shows an area calculation based on fixtures set for West East and South Directions.
The bottom image shows and area calculation based on South Direction only.



System Variables

General Options 87

Note: the results of the Area Calculations are subsequently
used in Space Calculations.

Theory of Area Calculations

Area Calculations are used to apportion areas to all fixtures that are within the Internal
Area zone.

The first factor affecting area calculations is the Area Calculation Directions specified in
the Category Tab of the Block Details dialogue box in Fixture Studio.
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The maximum area available for Area Calculations is based on the Internal Area Zone
and the AREA_BOUNDARY_DISTANCE System variable.

1. If an Internal Area zone is present, no fixture can be allocated any area that is outside
of the zone boundary.

2. The maximum distance a fixture can be allocated area within is determined by the
AREA_BOUNDARY_DISTANCE System variable.

In the above example, the maximum distance the fixture can be allocated area within is
determined by the AREA_BOUNDARY_DISTANCE System variable (red box). The
fixture can therefore only be allocated part of the area within the Internal Area Zone
(blue box). However, at one point the Internal Area Zone boundary is closer that the
distance set by the AREA_BOUNDARY_DISTANCE System variable, so part of the
potential area available to the fixture is excluded from the area calculations because it lies
outside of the boundary of the Internal Area Zone.

Each fixture then establishes the distance of other fixtures from it using the
AREA_LARGE_INCREMENT, AREA_MEDIUM_INCREMENT and
AREA_SMALL_INCREMENT System Variables.
The fixture starts out using the Large Increment. It feels out one 'large
increment' distance from the fixture. If it does not detect anything, it feels out another
large increment distance from the fixture until it detects something, or reaches an
Internal Area Zone Boundary or the Area Boundary distance.

Once another fixture had been detected using large increment, the software starts using
the Medium Increment distance to get a more precise 'range'. It keeps feeling out using
'medium increment' using as a starting point the last 'large increment' distance that did
not find a fixture in that direction. It feels out one 'medium increment' distance. If it does
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not detect anything, it feels out another medium increment distance until it detects
something, or reaches an Internal Area Zone Boundary or the Area Boundary distance.

Once a fixture has been identified by feeling out a 'medium increment distance, the same
process starts with the 'small increment' distance using as the last 'medium increment' as
a starting point.

The process can be seen in the above example. Fixture 1 starts feeling out with large
'increment' (500 inches) and detects that there is a fixture within that distance. It then
starts feeling out with 'medium increment' (50 inches). It detects there is no fixture within
50 inches, but there is one within 100 inches. Finally, it starts feeling out using 'small
increment' (5 inches) using the 50 inch medium increment datum as a starting point. It
does not detect a fixture within the first small increment distance, but does within the
second. Fixture 1 has therefore detected another fixture (Fixture 2) within 50 + 5 = 55
inches of its position.

Finally, the software takes into account the Area Calculation Directions, the limits within
which the area calculation will be carried out (Internal Area Zone, etc) and the position of
the fixtures. It then apportions areas to each fixture. If an area is ‘shared’ by multiple
fixtures, the shared area is subdivided up between the fixtures.
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In the example above, both Fixture 1 and Fixture 2 have areas exclusive to them. There is
a shared area between then. The software will detect this and allocate part of this shared
area to Fixture 1 and part to Fixture 2.

This can be seen in the Allocated Areas dialogue box (below) where the dark areas blue
areas represent areas that have been exclusively allocated to specific fixtures and the
lighter blue areas represent areas that will be apportioned pro rata to different fixtures.
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AREA_BOUNDARY_CLIPPING_LEVEL

The AREA_BOUNDARY_CLIPPING_LEVEL System Variable is allows users to specify
whether the area calculations for a fixture should be relative to the Internal Area Zone or
the Department Zone that it is in.

This functionality has not yet been implemented and area calculations can only be done
relative to the Internal Area Zone

AREA_BOUNDARY_DISTANCE

The AREA_BOUNDARY_DISTANCE System Variable is not presently in use.

AREA_LARGE_INCREMENT

AREA_LARGE_INCREMENT is one of three system variables affecting the logic of how
the Area calculation is carried out, the other two being AREA_MEDIUM_INCREMENT
and AREA_SMALL_INCREMENT.
The three work in conjunction, the software 'feeling out' from the fixture using
AREA_LARGE_INCREMENT setting until a fixture is encountered. The software
successively then uses AREA_MEDIUM_INCREMENT and
AREA_SMALL_INCREMENT to establish a progressively more accurate distance
between fixtures.

AREA_MAX_DISTANCE

The AREA_MAX_DISTANCE System Variable specifies the maximum distance from a
fixture the software will take into account when allocating areas. This distance will apply
unless the Area Max distance exceeds crosses the boundary of the internal Area Zone. If
this is the case, any part of the AREA_MAX_DISTANCE outside of the boundary will be
excluded for calculation purposes.
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AREA_MEDIUM_INCREMENT

AREA_MEDIUM_INCREMENT is one of three system variables affecting the logic of
how the Area calculation is carried out, the other two being
AREA_LARGE_INCREMENT and AREA_SMALL_INCREMENT.

The three work in conjunction, the software 'feeling out' from the fixture using
AREA_LARGE_INCREMENT setting until a fixture is encountered. The software
successively then uses AREA_MEDIUM_INCREMENT and
AREA_SMALL_INCREMENT to establish a progressively more accurate distance
between fixtures.

AREA_SMALL_INCREMENT

AREA_SMALL_INCREMENT is one of three system variables affecting the logic of how
the Area calculation is carried out, the other two being AREA_LARGE_INCREMENT
and AREA_MEDIUM_INCREMENT.

The three work in conjunction, the software 'feeling out' from the fixture using
AREA_LARGE_INCREMENT setting until a fixture is encountered. The software
successively then uses AREA_MEDIUM_INCREMENT and
AREA_SMALL_INCREMENT to establish a progressively more accurate distance
between fixtures.

The setting for AREA_SMALL_INCREMENT will affect the accuracy of the calculation. If
set to a high value, the Area Calculation exercise will complete quickly, but with a lower
degree of accuracy. If set to a small value, the result will be more accurate but the
processing time will be significantly longer.

AREA_UNIT_OF_MEASURE

The AREA_UNIT_OF_MEASURE system variable is used to set the type of unit used for
the results of Area Calculations. The value of the AREA_UNITS OF_MEASURE System
Variable refers to the Unit ID in the Units dialogue box.



System Variables

General Options 93

For example, if the results are wanted in Square Feet, Unit ID 31 would be selected, if the
results were wanted in Square Meters, Unit ID 32 would be selected.

Note: This functionality is not yet fully implemented.

Automated Calculations

AUTOMATION_CALCS

The AUTOMATION_CALCS System Variable holds information on the types of
Automated Calculations selected.

It is a bitwise system variable:

Value Calculation

0 No selection

1 Area Calculations
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2 Face Plane
Calculations

4 Space
Measurements

8 Fixture Adjacencies

16 Product
Adjacencies

AUTOMATION_CALC_STATUS

The AUTOMATION_CALC_STATUS System Variable holds information on the types of
Status selected for Automated Calculations.

The statuses are stored as pipe delimited STA_ID's from the AVTTB_STATUS table: for
example 23|25|27.

General

BATCH_USE_UTC

The BATCH_USE_UTC System Variable is used to specify whether the Batchrunner.exe
file (used for batch operations) in the C:\Program Files\Oracle Retail\MSM\Apps
directory uses local or UTC time.

0 = Local tome

1 = UTC time

DBSCHEMADATE

The DBSCHEMADATE System Variable holds the date the schema was last updated by
means of an upgrade script. (The upgrade script must be set to update the date).

The information is purely held in the database.

DBVERSION

The DBSCHEMADATE System Variable holds the information on the version the schema
has been updated to by an upgrade script. It is used in the status bar of the configuration
module. (The upgrade script must be set to update the version).
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LDAP

Overview of LDAP

The Lightweight Directory Access Protocol (LDAP) [and its associated information
directories] provides a simple, organization wide method of storing information that is
often read but only infrequently updated. For example, it might hold information on
personnel employed by an organization. The information held might include:

 Name

 Position

 Address

 Telephone Number

 User ID
 Password

 Application 1 privileges

 Application 2 privileges

 Macro Space Management privileges

The information can then be used for multiple purposes; for example Human Resources
can access details of address and telephone number, while the assigned User ID and
Password can be used to log into multiple applications, including Macro Space
Management.

LDAP is an entirely separate application to Macro Space Management, but Macro Space
Management has the ability to link to it and exchange information. It does this by means
of:

1. Code within the software allowing it to link to LDAP and access data.
2. System Variables holding parameters used to connect to LDAP

The configuration and use of LDAP is outside of the scope of this help file and will not be
discussed further.
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LDAP and Macro Space Management

The Lightweight Directory Access Protocol (LDAP) provides an alternative method of
password authentication to that provided by Macro Space Management.

1. If the AUTHENTICATION system variable is set to 0, Macro Space Management
(and In-Store Space Collaboration) uses the Functional Security option in the
Administration Module to determine if a user is a valid user, what user groups the
user belongs to and what privileges have been assigned.

2. If the AUTHENTICATION system variable is set to 1, when a user logs in to Macro
Space Management (or In-Store Space Collaboration), the User Group they belong to
(and the privileges they have) are determined using LDAP. This information is
passed back to Macro Space Management, allowing three activities to be carried out:
 Authentication - validating the user's ID and password

 Authorization - determining which Macro Space Management privileges have
been assigned

 Notification - in some circumstances, email messages will be sent reporting
changes to statuses of objects

Note: LDAP is an external application to Macro Space
Management. Configuring LDAP is beyond the scope of this
help file.

Authentication using Functional Security in Macro Space Management
The Administration Module contains a Functional Security option.

User Groups can be created - each user group specifying a particular set of privileges.
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Users can then be assigned to the User Group and will be able to use the MSM privileges
associated with that user group.

Users and User Groups can either be manually created, or can be imported using Data
Importer.
When the user logs in to Macro Space Management, the user name and password they
use are compared to entries in the database to ensure they are a valid user and to
determine what privileges they have.

Authentication using LDAP
When authentication is done using LDAP, a different procedure is followed:

Authentication
When a user logs into Macro Space Management (or In-Store Space Collaboration), they
are queried against information held in the LDAP directory. If the user has the correct
access rights, they will be able to log into the application. If the user has not previously
accessed MSM or ISSC, an entry for that user will be created in the MSM database.

Authorization
Once an individual has been authenticated as a valid Macro Space Management or In-
Store Space Collaboration user, their privileges are assigned according to which user
groups they belong to.

 The required User Groups and their associated privileges must previously have been
created/assigned in the Functional Security module. This cannot be done by LDAP.

 If the user has not previously accessed MSM or ISSC, links will automatically be
created in the database between that user and the pre-configured User Groups. (If a
user has previously accessed MSM or ISSC, the links will already exist).

 The software uses the User Groups to which an individual belongs to determine
what privileges they have in the software.

Notification
If LDAP contains email addresses for individuals and Macro Space Management/In-
Store Space Collaboration have been appropriately configured, email notifications can be
sent when specific objects within MSM/ISSC change their status.

LDAP, User Groups and User Group Types

Information on User Groups is stored in the AVTTB_USER_GROUP table in the Macro
Space Management database.

There are two fields that are of interest to the user; USG_CODE and UGT_ID

USG_CODE
The USG_CODE (User Group Code) has to be manually added to the
AVTTB_USER_GROUP by a data base administrator. It provides a field that can be
mapped to a field in the LDAP directory. Accordingly, it should be unique to a specific
user group.
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Note: The field has been provided to make it easier for
LDAP administrators. It is easier to map 'Admin' to an item
in the LDAP directory that it is to map the USG_ID (for
example '1').

UGT_ID
The UGT_ID (User Group Type) in the AVTTB_USER_GROUP table is a foreign key for
the AVTTB_USER_GROUP_TYPE table. This read only table specifies the type (and
hence access) a user group has.

Macro Space Manager will only allow access to User Group Types 1 (Admin User) and 2
(Designer User).

In-Store Space Collaboration will allow access to User Group types 1 (Admin User), 2
(Designer User), 6 (District Manager), 7 (MEDS Manager) and 9 (Validation User).

Note: If a user group is set to type 6 (District Manager), 7
(MEDS Manager) or 9 (Validation User), the members of the
user group will only be able to access ISSC and not MSM.

The User Group Type also determines the type of access:

 If set to 1 (Admin User), 2 (Designer User) or 9 (Validation User) access to stores, etc
is set manually, through MSM's Data Security options in the Admin Module.

 If set to 6 (District Manager) or 7 (MEDS Manager) access to stores is dynamically
determined by permissions set in LDAP. This allows additional permissions to be set
using LDAP including emails and dynamic store access.

Note: care should be taken not to mix the two sorts of
permissions. If one ISSC User Group has manually
determined permissions (Functional Security in MSM) and
another ISSC User Group has dynamically determined
permissions (LDAP), then confusion could result from
differences between the permissions set in MSM Functional
Security and the LDAP permissions.

Because of the complexity of this topic, further information can be obtained from Oracle's
Technical Support Department.
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AUTHENTICATION

The AUTHENTICATION system variable is used to control what form of password
authentication is used.

0, 1 = Use Macro Space Management's password authentication system.

2 = Use LDAP to authenticate passwords.

Note: LDAP is an external application that can be used for
password authentication (and other tasks). Configuring
LDAP is beyond the scope of this help file.

LDAP_APPBASEDN

The LDAP_APPBASEDN system variable holds the base Distinguished Name (DN)
value for the application within the LDAP directory structure. This is used to uniquely
identify Macro Space Management and In-Store Space Collaboration.

The value of the Distinguished Name must be obtained from the LDAP administrator
and is made up of a series of Relative Distinguished Names separated by commas. This
information can be entered as a text string.

LDAP_APP_PROPERTY

The LDAP_APP_PROPERTY system variable specifies the custom property that holds
authentication information.

LDAP_APPID

The LDAP_APPID system variable references a dummy user in the Macro Space
Management database that serves as a portal into LDAP. This dummy user must map to
a parallel valid entry in the LDAP directory.

When a real user attempts to log into Macro Space Management (or In-Store Space
Collaboration), MSM uses the dummy user referenced by the LDAP_APPID system
variable to connect to LDAP. Once connected to LDAP, MSM can then read the required
information from LDAP, and (if necessary) create entries in the MSM database.

The LDAP_APPID system variable must reference the USR_ID for the entry in the
AVTTB_USER table.

As the User Log-in and associated password are not used manually, it does not matter
that they will eventually 'expire' when the Change Password Period in Security Options
is exceeded after the user is created.
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Note: Manually logging in to this dummy entry after the
password has been 'expired' will clock out all access to
LDAP.

LDAP_CORPORATION

The LDAP_COROPRATION system variable is of four system variables than can be
used to control dynamic access (i.e. access controlled through LDAP rather than Macro
Space Management's Functional Security Module). The other three system variables are
LDAP_DIVISION, LDAP_DISTRICT and LDAP_STORE.

Each system variable maps to a level in the hierarchy; the first three to clusters and sub-
clusters, and LDAP_STORE to stores.
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The values that the system variables reference are the Cluster or Store Codes. In the
example below, the Cluster has a Cluster Code of H-2.

These cluster or store codes can then be used within LDAP to specify which specific parts
of the hierarchy an individual has permissions to modify.
For these dynamic permissions to work, the information help in LDAP and the hierarchy
in store manager must be in sync. Modifications to the hierarchy must first be made in
LDAP, and then the hierarchy in Store Manager changed to match.

LDAP_DIVISION

The LDAP_DIVISION system variable is of four system variables than can be used to
control dynamic access (i.e. access controlled through LDAP rather than Macro Space
Management's Functional Security Module. (The other three system variables are
LDAP_CORPORATION, LDAP_DISTRICT and LDAP_STORE).

Each system variable maps to a level in the hierarchy; the first three to clusters and sub-
clusters, and LDAP_STORE to stores.
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The value that the system variables reference are the Cluster or Store Codes. In the
example below, the Cluster has a Cluster Code of H-2.

These cluster or store codes can then be used within LDAP to specify which specific parts
of the hierarchy an individual has permissions to modify.
For these dynamic permissions to work, the information help in LDAP and the hierarchy
in store manager must be in sync. Modifications to the hierarchy must first be made in
LDAP, and then the hierarchy in Store Manager changed to match.

LDAP_DISTRICT

The LDAP_DISTRICT system variable is of four system variables than can be used to
control dynamic access (i.e. access controlled through LDAP rather than Macro Space
Management's Functional Security Module). The other three system variables are
LDAP_CORPORATION, LDAP_DIVISION and LDAP_STORE.

Each system variable maps to a level in the hierarchy; the first three to clusters and sub-
clusters, and LDAP_STORE to stores.
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The value that the system variables reference are the Cluster or Store Codes. In the
example below, the Cluster has a Cluster Code of H-2.

These cluster or store codes can then be used within LDAP to specify which specific parts
of the hierarchy an individual has permissions to modify.
For these dynamic permissions to work, the information help in LDAP and the hierarchy
in store manager must be in sync. Modifications to the hierarchy must first be made in
LDAP, and then the hierarchy in Store Manager changed to match.

LDAP_MAIL

The LDAP_MAIL system variable is used to specify the name of the property in the
LDAP database used to hold details of email addresses. This enables Macro Space
Management to initiate sending notification emails to specific individuals.

LDAP_SERVER

The LDAP_SERVER system variable hold details of the server that hosts the LDAP
system. The information should be of the form:
\\Server.CompanyName.com:PortNumber
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LDAP_STORE

The LDAP_STORE system variable is of four system variables than can be used to
control dynamic access (i.e. access controlled through LDAP rather than Macro Space
Management's Functional Security Module). (The other three system variables are
LDAP_CORPORATION, LDAP_DIVISION and LDAP_DISTRICT).
Each system variable maps to a level in the hierarchy; the first three to clusters and sub-
clusters, and LDAP_STORE to stores.

The value that the system variables reference are the Cluster or Store Codes. In the
example below, the Store has a Store Code of SE-1

These cluster or store codes can then be used within LDAP to specify which specific parts
of the hierarchy an individual has permissions to modify.
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For these dynamic permissions to work, the information help in LDAP and the hierarchy
in store manager must be in sync. Modifications to the hierarchy must first be made in
LDAP, and then the hierarchy in Store Manager changed to match.

LDAP_USERBASEDN

The LDAP_USERBASEDN system variable holds the base Distinguished Name (DN)
value for the users within the LDAP directory structure. This is used to uniquely identify
Macro Space Management and In-Store Space Collaboration.

The value of the Distinguished Name must be obtained from the LDAP administrator
and is made up of a series of Relative Distinguished Names separated by commas. This
information can be entered as a text string.

LDAP_USER_PREFIX

The LDAP_USER_PREFIX system variable allows an LDAP prefix to be 'stripped off' if a
user name is imported into Macro Space Management.

For example, if the LDAP name is of the form Company_Name_User_Name, the
LDAP_USER_PREFIX system variable can be used to remove the Company_Name_ part
of the user name before it is inserted into the MSM database.

Merchandiser

ADDITIONAL_FIXTURE_HEIGHT

The ADDITIONAL_FIXTURE_HEIGHT system variable is used to increase the height
of the merchandisable area for all fixtures in the Merchandiser module beyond that set in
the Merchandisable Areas Tab of the Block Details dialogue box in Fixture Studio.
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It has the following effects:

Fixture Studio
It is added onto the setting for the upper part of the Merchandisable area. For example, if
the Z value for offset is set to 0, the merchandisable area will finish at the top of the
fixture (left hand image above). If the ADDITIONAL_FIXTURE_HEIGHT system
variable is set to 12 inches, the merchandisable area will extend above the top of the
fixture despite the offset being set to 0 (right hand image above).

Merchandiser Module
There will be two effects in the Merchandiser module.

1. The AutoFill command (Standard toolbar) will fill to a volume that includes the
ADDITIONAL_FIXTURE_HEIGHT setting.
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2. All fixtures and shelves will fill to a volume that includes the
ADDITIONAL_FIXTURE_HEIGHT setting.

FINGER_GAP

The FINGER_GAP system variable is used in the Merchandiser module. It specifies the
minimum gap between the top of a group of products and the shelf above it.

The purpose of the system variable is to ensure that there is always sufficient space for a
customer to reach in and lift products off of a shelf.

Note: The 'Vertical Gap' setting on the Size and Shape tab of
the Display styles dialogue box may also influence the gap
between the topmost item of merchandise and the shelf
above.

Planogram Importer

About Planogram Importer

Planogram Importer is a standalone Macro Space Management tool that can be used to
import planograms from third party planograming tools like Apollo, Galleria and
ProSpace.

Note: The Planogram Importer tool can be found in the
C:\Program Files\Oracle Retail\MSM\APPS directory.

When planograms are imported, they need to be matched to suitable fixtures and shelves
in the Macro Space Management database. (This is done by using the planogram
dimensions and data in the AVTTB_STYLE_IMPORTMAP table. If no suitable fixtures
are found, then defaults can be assigned using three system variables:

1. DEFAULT_IMPORT_FIXEL_BLK_ID specifies a default shelf.

2. DEFAULT_IMPORT_FIXTURE_BLK_ID specifies a default fixture
3. DEFAULT_IMPORT_BLOCK_ID specifies a default product block.

DEFAULT_IMPORT_FIXEL_BLK_ID

The DEFAULT_IMPORT_FIXEL_BLK_ID system variable is used for Planogram
import. The value should correspond to the ID of a suitable default shelf in the table of
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Block Details. This default shelf will be associated with the imported planogram if no
more suitable match exists in the Macro Space Management database.

Note: it would be usual for the default shelf to be
'stretchable', allowing it to suit any size of planogram.

DEFAULT_IMPORT_FIXTURE_BLK_ID

The DEFAULT_IMPORT_FIXURE_BLK_ID system variable is used for Planogram
import. The value should correspond to the ID of a suitable default fixture in the table of
Block Details. This default shelf will be associated with the imported planogram if no
more suitable match exists in the Macro Space Management database.

Note: it would be usual for the default fixture to be
'stretchable', allowing it to suit any size of planogram.

DEFAULT_IMPORT_BLOCK_ID

The DEFAULT_IMPORT_BLOCK_ID system variable is used for Planogram import.
The value should correspond to the ID of a suitable default product block in the table of
Block Details. This default product block will be associated with the imported planogram
if no more suitable match exists in the Macro Space Management database.
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Planner

CMDECHO

The CMDECHO system variable can be used to turn on or off echoing commands to the
AutoCAD command line in the Planner Module.

0 = suppress showing some AutoCAD commands in the command line

1 = show all AutoCAD commands in the command line.

Note: Setting CMDECHO to 1 increases the number of
prompts that appear in the command line - this may be
useful to new users of the software.

MENUECHO

The MENUECHO system variable can be used to turn on or off echoing which toolbar or
menu items were selected to the AutoCAD command line in the Planner Module.

0 = suppress showing menu items selected.

1 = show menu items or toolbar items selected in the command line.

LAYER_STANDARD

The LAYER_STANDARD system variable is used to specify the AutoCAD Layer
Standard used in the Planner module. The value of the system variable refers LAS_ID in
the AVTTB_LAYER_STANDARD table.
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There are two default standards:

1. Retail Focus (Macro Space Management) which contains information on layers
specific for Retail Focus

2. BS1192/ISO13567 which contains information on the ISO13567 International
standard

Note: It is possible to add additional standards to the
database, but this should be done in conjunction with
Oracle's Technical Support department as additions need to
be made to a number of different tables.

Planogram Substitution

PLANOGRAM_SUBSTITUTION_COPY_FILE

The PLANOGRAM_SUBSTITUTION_COPY_FILE system variable is used to
determine whether planogram substitutions can be made in files of Current status.

0 = Off

1 = On

If set of 0 (Off) Current status will not be available for selection in the Planogram
Substitution Definition dialog box and the Planogram Substitution Assistant. If set to 1
(On) current status will be available for selection and planogram substitutions can be
carried out based on files of Current status.

Because files of Current status are set to 'read only' status the actual substitutions cannot
be made in the current file. Instead, they will be made in an Authorized file belonging to
the floor the Current file is associated with. This authorized file could already exist, or it
could be created by the Planogram Substitution Process (cloning).

What Authorized file is used depends on the Floor Plan Effective Date set in the
Properties Tab of the Planogram Substitution Definition dialog box.
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If an existing Authorized file exists in the same floor with an Effective Date that falls
within the range set in the Floor Plan Effective Date, substitutions will be made in that
file.

If no existing Authorized file exists in the same floor with an Effective Date that falls
within the range set in the Floor Plan Effective Date, an Authorized file will be created in
the same Revision holding the Current file. This Authorized file will have its Effective
Date set to the earliest date in the Floor Plan Effective Date.

PLANOGRAM_SUBSTITUTION_LOG_EXPLODED

This system variable has been superseded and is no longer in use.

PLANOGRAM_SUBSTITUTION_RUN_CALCS

The PLANOGRAM_SUBSTITUTION_RUN_CALCS system variable determines
whether Product Adjacency calculation are automatically run on a drawing immediately
prior to carrying out a planogram substitution.

0 = Do not run Product Adjacency calculation.

1 = Run Product Adjacency calculation.
Whether this system variable is set to on of off depends on whether planogram
substitutions are being run as a batch process or not. If (for example) Automated
Calculations are run immediately prior to planogram substitution, there is no need to re-
run Product Adjacency. If Automated Calculations are not being run, there is merit in
using the PLANOGRAM_SUBSTITUTION_RUN_CALCS system variable to force an
automatic run of Product Adjacency prior to making substitutions.
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PLANOGRAM_SUBSTITUTION_WARNING_SHOW

The PLANOGRAM_SUBSTITUTION_WARNING_SHOW system variable determines
whether an individual user has chosen to suppress display of the warning dialog for
removing planograms without replacement when specifying Planogram Substitutions.

0 = Individual user has suppressed warning
1 = Warning will be displayed for individual user

The results are stored referenced by User ID (USR_ID) in the AVTTB_USER_VARIABLE
table.

PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED

The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a
significant impact on the way planogram substitutions are carried out. It can be set to 0,
1, 2, 3 or 4.

Planogram Form
There are three forms planograms can be placed in the merchandiser module.

1. 2D Planogram (Placeholder)

2. 3D planogram (called 2.5 D in the Merchandiser Module).

3. 3D with Product Items (Full Detail).

These appear in the Merchandiser module as follows:
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A 2D planogram is purely a placeholder. A 3D planogram (2.5 D in Merchandiser) shows
the shelves and a simple product block to show the shelves are occupied. A 3D
planogram with Product items shows the shelves, together with full details of the
products.

Note: Planograms are only represented in placeholder (2D)
form in the Planner module and in Top Graphical View in
In-Store Space Collaboration.

Once placed in the Merchandiser module planograms can be manually toggled between
2D and 3D mode by means of the Implode or Explode options on the toolbar.
Merchandiser floor plans can therefore contain planograms in a variety of states. The
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable determines
how planogram substitution caters for the different cases.

System Variable Values

System
Variable

Description

0 Only planograms in 2D form will be substituted - with planograms in 3D form being
ignored. The substituted planograms will be placed in 2D form. No information on the
planograms that have been ignored for substitution will be written to the Planogram
Substitution Log.

1 Only planograms in 2D form will be substituted - with planograms in 3D form being
ignored. The substituted planograms will be placed in 2D form. Information on the
planograms in 3D form that have been ignored for substitution will be written to the
Planogram Substitution Log.

2 Planograms in 2D form will be substituted with planograms also in 2D form. Planograms
in 3D and 2.5D form will be placed in 2D form when substituted.
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3 3D and 2.5D planograms will be substituted by 2D planograms. A warning will be written
to the Planogram Substitution Log identifying the 3D and 2.5 D planograms that were
placed in 2D form during the substitution.

4 Planograms in 3D form will be substituted with planograms also in 3D form. Planograms
in 2D form will be placed in 3D form when substituted. Planograms in 2.5D form will be
replaced by a 2.5D form if that is the way the planogram design has been defined.
Alternatively, it will be replaced by a 3D form if the planogram design is in 3D format.

Revision Substitution
The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has no
effect on Revision Substitution (the changing of a planogram for a later version of that
design.

Impact on Reporting Accuracy
Whether planograms are in 2D, 2.5D or 3D form affects the form of information held in
the database. For example, a planogram in 2D form will only contain 'header'
information with no entries for individual products of shelf objects. This impacts on
reporting accuracy.

For example, if planograms are in 2D mode, this needs to be taken into account when
generating a bill of materials for the equipment in the floor plan as shelf information will
not be stored in the AVTTB_SHELF table.

PLANOGRAM_SUBSTITUTION_LENGTH_TOLERANCE

The PLANOGRAM_SUBSTITUTION_LENGTH_TOLERANCE system variable sets
the default values for the plus and minus tolerance for planogram length that appear in
the Rules Tab of the Planogram Substitution Definition dialog box called from the
Planogram Substitution dialog box in the Admin Module.

These default values can be over-ridden in the Planogram Substitution Definition dialog
box by the user when setting up individual definitions.
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PLANOGRAM_SUBSTITUTION_HEIGHT_TOLERANCE

The PLANOGRAM_SUBSTITUTION_HEIGHT_TOLERANCE system variable sets the
default values for the plus and minus tolerance for planogram height that appear in the
Rules Tab of the Planogram Substitution Definition dialog box called from the Planogram
Substitution dialog box in the Admin Module.

These default values can be over-ridden in the Planogram Substitution Definition dialog
box by the user when setting up individual definitions.

PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE

The PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE system variable sets the
default values for the plus and minus tolerance for planogram depth that appear in the
Rules Tab of the Planogram Substitution Definition dialog box called from the Planogram
Substitution dialog box in the Admin Module.
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These default values can be over-ridden in the Planogram Substitution Definition dialog
box by the user when setting up individual definitions.

PLANO_SUBS_WARNING_DATES

The PLANO_SUBS_WARNING_DATES system variable determines whether an
individual user has chosen to suppress display of the warning dialog for manually
running Planogram Substitutions when the current date is outside of the date range the
selected planogram substitutions are valid for.

0 = Individual user has suppressed warning

1 = Warning will be displayed for individual user
The results are stored referenced by User ID (USR_ID) in the AVTTB_USER_VARIABLE
table.

Report Designer
About Report Designer

Report Designer is a module within Macro Space Management. It allows customized
reports to be produced for planograms. Report Designer can be invoked in one of two
ways:

1. From the File > Print > Planogram menu. This allows printing of planogram reports,
but does not allow editing
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2. From the C:\Program Files\Oracle Retail\MSM\APPS\AVT5PogReporter
directory. This allows both editing of the report layout and printing of planogram
reports.

RPTDSG_HELPFILE

The RPTDEG_HELPFILE system variable contains the URL (Uniform Resource Location)
for the help files for Report Designer. It should detail both the path to the directory and
the name of the file used to open the help.

Note: Report Designer Help is in Webhelp format. This
differs from the CHM files used for Macro Space
Management.

RPTDRPTDSG_TESTPOGID

The RPTDSG_TSTPOGID system variable specifies the planogram that will be
displayed for testing the Planogram Report. The planogram is identified by its POG_ID
in the AVTTB_PLANO table.
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Space Calculations

Overview of Space Calculations

Space Calculations are used to calculate a set of parameters for fixtures and the products
occupying them. These parameters can then be used in reports specifying the efficiency
with which a store has been merchandised. These Space Calculations are:

Base Linear
Base Linear is the greater value of:

1. The merchandisable length of the fixture as defined in the Merchandisable Areas tab
of the Block Details dialogue box.

2. The nominal length of the fixture as defined in the Sizes tab of the Block Details
dialogue box.

Shelf Linear
Shelf Linear is the total merchandisable length of the shelves on a fixture. Shelf Linear
may also include the length of the fixture itself, if that fixture is populatable.

Footprint
Footprint is the greater value of:

1. The merchandisable area of the fixture as defined in the Merchandisable Areas tab of
the Block Details dialogue box.

2. The nominal area of the fixture as defined in the Sizes tab of the Block Details
dialogue box.

Allocated Area
Allocated Area is calculated using the Calculate Areas option on the Calculate Menu and
toolbar in Planner. It will not be discussed further here.

Display Volume
The display volume is the actual volume occupied by a specific product and is calculated
from the length, depth and height assigned to it, multiplied by the number of instances
placed on a specific fixture.

Nominal Volume
The nominal volume is the base linear of a fixture multiplied by the depth specified in
the CALC_STND_DEPTH system variable and the height defined in the
CALC_STND_HEIGHT system variable.
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Allocated Volume
The allocated volume is the Allocated Area multiplied by the height defined in the
CALC_STND_HEIGHT system variable.

CALC_STND_DEPTH

The CALC_STND_HEIGHT system variable is used by Space Calculations in the
Planner Module. It is used in conjunction with the CALC_STND_DEPTH system variable
and the Base Liner of a fixture to calculate the nominal volume.

CALC_STND_HEIGHT

The CALC_STANDARD_HEIGHT system variable is used by Space Calculations in the
Planner Module. It has two purposes:

It is used in the calculation of Nominal Volume

It is used in the calculation of Allocated Volume.

Nominal Volume
The nominal volume is the base linear of a fixture multiplied by the depth specified in
the CALC_STND_DEPTH system variable and the height defined in the
CALC_STND_HEIGHT system variable.

Allocated Volume
The allocated volume is the Allocated Area multiplied by the height defined in the
CALC_STND_HEIGHT system variable.

Store Manager

PUBLISH_DATE_LEAD_PERIOD

The PUBLISH_DATE_LEAD_PERIOD system variable is used in Store Manager. It
affects the file Properties dialogue box
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When a user sets a file to Authorized status, the previously grayed out Publish and
Effective dates become active. The value of the PUBLISH_DATE_LEAD_PERIOD system
variable is added onto the current date to set a default Publish Date - for example if the
current date is the 7th January and the PUBLISH_DATE_LEAD_PERIOD system variable
is set to 7, then the default Publish Date will be set to 14th January.

EFFECTIVE_DATE_LEAD_PERIOD

The EFFECTIVE_DATE_LEAD_PERIOD system variable is used in Store Manager. It
affects the file Properties dialogue box
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When a user sets a file to Authorized status, the previously grayed out Publish and
Effective dates become active. The value of both the PUBLISH_DATE_LEAD_PERIOD
and EFFECTIVE_DATE_LEAD_PERIOD system variables are added onto the current
date to set a default publish date - for example if the current date is the 7th January, the
PUBLISH_DATE_LEAD_PERIOD system variable is set to 7 and the
EFFECTIVE_DATE_LEAD_PERIOD system variable is set also to 7, then the default
publish date will be set to 21st January.

ENABLE_FILE_TRIGGER_DATE

The ENABLE_FILE_TRIGGER_DATE system variable determines the behavior of both
the File Properties dialogue box and UpdateStatus.exe.

Value Result Other Actions

0 or 1 UpdateStatus.exe is disabled and has no
effect on File or Revision statuses. Publish
and Effective dates are disabled and cannot
be set.

Publish and Current statuses need to be
selectable so that files can manually be taken
through the software cycle.
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2 Effective date is enabled. UpdateStatus.exe
will change file status if the Effective date is
exceeded.

Publish needs to be manually selectable.

3 Publish and Effective dates are enabled. Publish and Current status should not be
selectable by the user so that update status is
the required method to change them.

Tax Codes

About Tax Codes
The Tax Codes Option in the Admin Module allows users to enter rates for varying
types of tax. These rates can then be assigned to products at SKU Level in Product
Studio.

The Tax Code Window has three main parts.

Pull down menus give access to various Tax Code options.

The Toolbar gives access to other Tax Code options.

The Tax Codes are displayed in the Tax Code Grid.

Menus and Toolbars
The File Menu allows users to exit the option.
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The Edit Menu allows users to Add, Edit or Delete Tax Codes

The View Menu allows users to switch On and Off display of the Toolbar and Status
Bars. It also allows them to refresh the Tax Code grid.
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The Help Pull Down Menu

Clicking on About displays the current version number of the software.

The Toolbar gives access to varying Tax Code options

Exit

Add Tax Code

Exit Tax Code

Delete Tax Code

Refresh

Adding, Editing and deleting Tax Codes
To Add a Tax Code click on the Add Tax Code icon or select Add from the edit pull
down Menu.
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Type a description into the Description text box then click in the Rate text box and enter
the required Tax Rate.
Press <Return> to send the values to the central Macro Space Management database.

Note: The values will not be stored in the central database
until return has been pressed.

Editing the Tax Codes can be done by clicking in the relevant box in the Tax Code grid,
then typing in the amended values. Alternatively, highlight the relevant tax code and use
the edit options in the edit menu or in the toolbar.

Press <Return> to store the changed values in the central Macro Space Management
database.

Note: The values will not be stored in the central database
until return has been pressed.

To Delete a Tax Code highlight the required Tax Code then click on the Delete icon or
select the Delete option from the Edit pull down menu.
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Warning: The tax code will be deleted without confirmation
being requested.

Refreshing and Exiting
Refreshing is of use when multiple people are using the same option in Admin.

Clicking on the Refresh Icon will cause the list of Tax Codes to be updated based on
current information from the central Macro Space Management database.

This allows users to see changes being made by other users.
The Exit option will cause users to exit this part of the Admin Module.
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Note: If data has been entered in the Tax Code Grid, ensure
that <Return> has been pressed before exiting or data will be
lost.

Assigning Tax Codes
Tax Codes are assigned in the SKU dialogue box in Product Studio



Units

128 Oracle Retail Macro Space Management

Importing Tax Codes
Tax Codes are stored in the AVTTB_SEASON table in the database.

This table can be populated by using the Data Importer module as an alternative to
entering data manually via the Admin Module.

The AVTTB_TAX_CODES table must be populated before Tax Codes can be assigned to
Products (AVTTB_PRODUCT_ITEM table)

Units

Overview of Units Option
The Units Option within the Admin Module allows the user to specify the units that will
be available within Macro Space Management. They are specified relative to fundamental
SI units and can be specified according to the users needs.

The Units Window contains three main parts.
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The Menus and the Toolbar allow the user to access varying options concerning units.
The Unit Details section allows the user to see the values assigned to specific units.

About SI Units
The International System of Units (abbreviated SI from the French le Système
International d'unités) is the modern form of the metric system.

It contains seven basic units;

Name Symbol Measurement

Metre (Meter) m Length

Kilogram Kg Weight

Second s Time

Ampere A Electric current

Kelvin K Temperature

Mole mol Quantity of matter

Candela cd Light intensity

All units used in Macro Space Management are relative to these basic units.

For example grammes are 1/1000th of a kilogram.

Note: For convenience Macro Space Management uses the
degree Centigrade rather than degrees Kelvin as the
measurement of temperature.
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About Scientific Notation
Scientific Notation is just shorthand for writing large or small numbers.

It is sometimes used in Macro Space Management. Some examples of scientific notation
are:

Scientific
Notation

Decimal
Equivalent

1 x 106 1,000,000

1 x 103 1,000

1 x 102 100

1 x 101 10

1 x 10-1 0.1

2 x 10-2 0.01

2 x 10-3 0.001

The File Pull Down Menu
The File pull down menu allows users three options.

Reload Units
This option allows users to reload the display grid with the values for the units when
they were last saved. This will overwrite any alterations made to the values of the units
but not saved.

Save Units
This option allows users to save any changes made to the values for units.

Exit
This allows users to exit the unit option. If changes have not been saved, then a warning
dialogue will appear.



Units

General Options 131

The Units Pull Down Menu
The Units pull down menu allows users to Add a new unit or Delete an exiting one.

To Add a Unit, click on the Add option. This will add a new line in the table of units.

To Delete a Unit highlight a line and click on the Delete option. The Unit will then be
deleted from the table of units.

Additions or deletions will not be permanent until the Save option has been used in the
File pull down menu. More Info

The Dimensions Pull Down Menu
The Dimensions pull down menu allows users to bring up the Dimensions dialogue
box.
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When entering a new dimension, it has to be related to the basic dimensions of Number,
Length, Mass, time, Charge, Intensity, Money, or Angle.
The power is that which the original basic dimension has to be changed to describe the
new one. This will normally only affect the length basic dimension.

Basic
Dimension

Power Result

Length 1 Length

2 Area

3 Volume

The Help Pull Down Menu
The Help pull down menu allows users to call this Help File. Clicking on About will
bring up a small dialogue box showing the current version of the software.
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The Toolbar
The Toolbar allows users to access varying options affecting the addition, editing,
deletion and saving of units.

Exit

Save

Add Unit

Delete unit

Refresh

Edit Unit

Unit Details
The Unit ID is used internally within the central Macro Space Management database.

It is not editable by the user.

The Symbol is used in Reports, etc.
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The Description is used to prompt users as to the purpose of the dimension.

Prefixes are used before units.

An example would be where a £ or $ sign was wanted before a monetary value.

The Suffix is the symbol that will be displayed after the unit if it appears in a drawing
etc.

The suffix for Kilograms is Kg so weights will be displayed as follows:
5 Kg, 10.7 Kg, 0.3 Kg

Similarly the suffix for meters is m so lengths will be displayed as follows:

5 m, 10.7m, 0.3 m

The Order is used to specify the order units appear in a drop down list.

The Offset Option is used where the unit is related to a base dimension by a y = mx + c
relationship. It represents the constant c in the equation.
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For example the offset for degrees Kelvin is -273.16. The relationship between degrees
Centigrade and Kelvin is Degrees Kelvin = Degrees Centigrade - 273.13.

Offsets are sometimes used in conjunction with SI Factors. For example the offset
between degrees Centigrade and Fahrenheit is -32 and the SI Offset is 0.555. Degrees
Fahrenheit = (Degrees Centigrade x 0.555) -32

The SI Factor is used where the unit is related to a base dimension by a y = mx + c
relationship. It represents the co-efficient m in the equation.

The SI factor is the factor by which the basic dimension has to be scaled by to give the
correct value for the unit. For example there are 2.204 pounds to the kilogram, so the SI
Factor is 0.454: 1 lb = 0.454 Kg

As another example, there are 39.37 inches to the meter, so the SI factor is 0.0254: 1 in =
0.0254 meters.

The Display Option allows the user to select whether a unit will be displayed in the
appropriate drop list when used in Macro Space Management.

Units with a tick will be displayed. Units without a tick will not.

Precision determines the number of decimal places that will display when the value of a
unit is shown.
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Number of
decimal
places

Result

0 10

1 10.1

2 10.25

3 10.375

Note: This functionality is being implemented, and not all
variables may display to the set number of decimal places.

Mandatory Units are units that cannot be deleted.

These are units that are fundamental to Macro Space Management and correspond to the
fundamental SI units, plus the Number, Money and Angle options. More on SI Units

Note: In current releases of Macro Space Management it is
possible that the Mandatory and Default column headings
have been swapped.

Default Units are the units that will be preferentially displayed when the selected
measurement system is in use.

For example, if the imperial system is used, the default units might be selected as inches,
pounds and degrees Fahrenheit. For the metric system, the default units selected might
be centimeters, kilograms and degrees centigrade.

Note: In current releases of Macro Space Management it is
possible that the Mandatory and Default column headings
have been swapped.

User Defined Attributes

Overview of User Defined Attributes
User Defined Attributes (UDA's) allow a Macro Space Management Administrator to
designate customizable fields for Users, Stores, Files, Fixtures, Products and Planograms.
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Each object with UDA's designated can then have object specific data assigned to them.
Once assigned, the attributes can be used in two main ways:

1. All MSM users can see customized, organization specific information for those
objects with UDA data assigned.

2. Reports can be produced based on the information in the User Defined Attributes.

User Defined Attributes require two stages:

Configuring UDA's in Admin
The required UDA's are configured in the Admin Module.

Individual UDA's can be assigned specific names, date types, default values, etc. In the
above example, UDA fields have been designated for planograms.

User Designed Attributes are used in:

UDA Where Used Module

Block Fixture (Block) definitions Block (Fixture) Definition/Fixture Studio

File File Properties Information File Properties dialogue box/Store Manager

Planogram Planogram Definitions Planogram Definition/Merchandiser

Planogram
Equipment

Planogram Definitions Planogram Definition/Merchandiser

Planogram
Products

Planogram Definitions Planogram Definition/Merchandiser

Planogram
Profiles

Planogram Definitions Planogram Definition/Merchandiser

Product Product Definitions SKU Product Dialogue/Product Studio

Store Store Definition Store Dialogue/Store Manager

User User Definition Functional Security/Admin Module
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Assigning UDA's in Modules
Once UDA's have been configured in the Admin Module, individual values can be
assigned to instances of Blocks, Files, Planograms (general properties, profile
information, equipment information, product information), Products, Stores and Users.
In the example below, UDA's are being assigned to a store - each field being populated
having previously been designated in the Administration Module.

Values can be entered or selected from drop down lists (depending on how the UDA has
been configured in the Admin Module).

Dialogue Boxes where UDA's are Set
UDA's can be assigned to specific Users, Stores, Files, Fixtures, Products and
Planograms. The dialogue boxes where this can be done are as follows:

Users
UDA's for Users are set in the Attributes tab of the User dialogue box accessible from the
Functional Security Option in the Administration Module.
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Stores
UDA's for Stores are set in the Attributes tab of the Add or Edit Store dialogue box in
Store Manager.

Files
UDA's will be visible for files in the File Properties dialogue box in Store Manager. This,
as yet, does not contain an Attributes tab.
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Fixtures
Fixture UDA's are visible in the Block Details dialogue box.

There are two forms of attributes in this dialogue box; Fixed Attributes and Variable
Attributes.

1. Fixed Attributes are set in the User Defined Attributes section of the Administration
module. These attributes are common to all fixtures of that type.

2. Variable Attributes are configured using the Edit Menu > Edit Attribute Definitions
option in Fixture Studio. They can then be set for individual instances of fixtures in
Planner, Merchandiser and In-Store Space Collaboration by selecting a fixture in the
drawing and clicking the Attributes option in the respective toolbars.

Products
UDA's for Products are set at SKU level in Product Studio using the Custom Tab of the
SKU dialogue box.

Planograms
Four sorts of UDA's are associated with planograms.

 UDA's Associated with the general planogram design

 UDA's associated with Planogram Profiles (bays) in the planogram design

 UDA's associated with specific items of equipment in the planogram design
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 UDA's associated with specific products in the planogram design

UDA's associated with the general planogram design
General UDA's for Planograms are set in the UDA tab of the Planogram Design dialogue
box in the Merchandiser module.

UDA's associated with Planogram Profiles (bays) in the planogram design
UDA's associated with a specific profile (bay) in a planogram can be seen by highlighting
that bay in the Planogram Design window in the Merchandiser module and clicking the
Object Properties icon on the toolbar.

This will bring up the Profile User Defined Attributes dialog box.

Note: the number after the parent fixture for the profile (23
in the above example) is the PRD_ID from the
AVTTB_PROFILE table. It is a unique identifier for the
profile/bay the UDA refers to.

UDA's associated with specific items of equipment in the planogram design
UDA's associated with a specific item of equipment in a planogram can be seen by
highlighting that item of equipment in the Planogram Design window in the
Merchandiser module and clicking the Object Properties icon on the toolbar.
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This will bring up the Equipment User Defined Attributes dialog box.

Note: the number after the item of equipment (62 in the
above example) is the FXL_ID from the AVTTB_POG_FIXEL
table. It is a unique identifier for the item of equipment the
UDA refers to.

UDA's associated with specific products in the planogram design

UDA's associated with a specific product in a planogram can be seen by highlighting that
item of merchandise in the Planogram Design window in the Merchandiser module and
clicking the Object Properties icon on the toolbar.

This will bring up the Product User Defined Attributes dialog box.
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Note: the number after the item of merchandise (67 in the
above example) is the PPR_ID from the
AVTTB_POG_PRODUCT table. It is a unique identifier for
the item of merchandise the UDA refers to.

Overview of Configuring User Defined Attributes
Configuring User Defined Attributes is done using the User Defined Attribute Option
from the General menu of the Administration Module. This will bring up the User
Defined Attributes dialogue box.
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Close Option
The close option (available from the toolbar or File pull down menu) closes the User
Defined Attributes dialogue.

Refresh Option
The refresh option refreshes the UDA dialogue box with the latest information from the
database. This is useful when other users are simultaneously working on UDA's as it
allows the effects of their changes to be seen.

UDA Options
Users can see the varying UDA options as gray bars. They can be expanded or contracted
by using the '+' or '-' signs. There are a fixed number of options for each UDA type. These
are:

UDA Number of
Fields

Block 60

Planogram
Design

60

Planogram
Profile

60

Planogram
Equipment

60

Planogram
Product

60

Product 60

File 10

Store 10

User 10

For each UDA, the user can configure the following options:
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Option Description

Name The name describing the UDA

Number The number of the column that the item of data
occupies in the database

Data Type The type of data for the UDA (set from a drop
down list)

Mandatory Whether the UDA is mandatory to complete

Sequence The order the UDA will appear in the list of
UDA's seen by the user.

Default The default value for the UDA

Lookups Values for a drop down list that users can select
from

Configuring User Defined Attributes
Configuring User Defined Attributes is done by setting the Name, Data Type,
Mandatory, Sequence, Default and Lookup options.

Note: when entering data, it will not be added to the
database until <Return> has been pressed.

Type
There are currently nine options as to where the UDA will be configured.

UDA Type Where Used Dialogue Box and Module

Block Fixture (Block)
definitions

Block (Fixture) Definition/Fixture Studio

Planogram Design Planogram
Definitions

Planogram Definition/Merchandiser Module

Planogram Profile Planogram
Definitions

Planogram Definition/Merchandiser Module
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UDA Type Where Used Dialogue Box and Module

Planogram Equipment Planogram
Definitions

Planogram Definition/Merchandiser Module

Planogram Products Planogram
Definitions

Planogram Definition/Merchandiser Module

Product Product Definitions Product SKU Dialogue/Product Studio

File file Properties File Properties/Store Manager

Store Store Definition Store Dialogue/Store Manager

User User Definition Functional Security/Admin Module

Name
Name is entered by the user. It is the description that will appear in the dialogue box that
uses that particular UDA. The description can be a maximum of 50 characters.

Number
This is the number of the column that the item of data occupies in the database. It should
not normally be necessary to modify this value.

Data Type
This is selected from a drop down list. Data will be validated against the data type
selected.

Data Type Example

String Any alphanumeric input (ABC123)

Integer Any Integer (1,2,3) in the range -2 billion to +2 billion

Long Any Integer (1, 2, 3) in the range -9 x 1018 to 9 x 1018.

Single Any number (1.23, 2.2345) in the range -3 x 1038 to 3 x 1038.

Double Any number (1.23, 2.2345) in the range -2 x 10308 to 2 x 10308.

Date Date (01/01/2009)

Boolean True or False values (0, 1). Boolean fields will appear as a check box for users.

Image Bit Maps, GIF and JPG images

Currency Financial data (£1234.00)

1. Data type date will accept dates in any format. Note that format may vary from
country to country - the US displays dates in a different format (MM/DD/YYYY) to
the UK (DD/MM/YYYY).

2. If data type Boolean is selected, the only permissible values for the default are 0 and
1. No look up values should be entered. In the example below, a user can be
designated as a permanent employee by clicking the checkbox.
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3. Data type Image is currently not enabled and has no effect.

Mandatory
This specifies whether the data is mandatory (must be entered) or not. If this check box is
ticked, the user will not be allowed to close the associated dialogue box (for example the
Planogram Definition) until the data has been entered.

Sequence
This is the sequence the UDA's will be display in the dialogue box they are associated
with. For example, assigning a UDA the sequence number of 3 means it will display 3rd
in the list of UDA's.

Default
This specifies the default value that will appear when the dialogue box is first opened to
enter UDA's. This can be left blank if no default is required.

Lookups
This field specifies values that may be selected from a drip down list. Values must be
entered using a pipe (vertical bar) to separate them. An example would be A|B|C.

If a look up is entered in this column, users can only select values from the look ups. If no
value is entered, the user will have to manually enter data. In the example below
Building Orientation, Ethnicity, Climate and Size are selected from look ups via drop
down lists.
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Modifying User Defined Attributes
Modifying UDA's in the Administration Module should be done with caution. They
are normally configured on implementation and subsequent changes may cause
problems.

1. Additional UDA's may be added in the Admin Module. Items in the database before
the UDA was added will not have information associated with that UDA.

2. If UDA's are edited or deleted this may cause problems within the database.
Accordingly, UDA's should not be edited or deleted without advice as to the
consequences. If it is necessary to edit or delete a UDA, it may be necessary to
modify the database with SQL upgrade scripts.

3. Modifying UDA's may also require changes to the Import Definitions in Data
Importer.

Data Importer
Once UDA's have been set up in the Administration module, it is possible to populate
them in one of two ways:

1. Manually
2. Via Data Importer. (See the Data Importer help file for more information).
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If it is decided to populate UDA's via Data Importer, it will be necessary to create a new
import routine as UDA's are not included within the Standard Import. Each UDA has its
own table within the database. These are:

UDA Table Primary
Key

File AVTTB_FILE_UDA FIL_ID

Fixture AVTTB_BLOCK_UDA BLK_ID

Product AVTTB_PRODUCT_UDA PRD_ID

Planogram AVTTB_PLANO_UDA POG_ID

Store AVTTB_STORE_UDA STR_ID

User AVTTB_USER_UDA USR_ID
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3
Admin Planning

Hatch Styles

About Hatch styles
The Hatch Styles Option allows users to set up Hatch Styles to indicate the dimensions
of Zones, etc.
These hatch styles can be customized in the Admin Module and are used in both the
MSM Merchandiser Module and In-Store Space Collaboration.

In Macro Space Management the hatch styles are predefined for the Planner Module,
only the rotation and scale being variable.

Hatch Styles can be defined for use in In-Store Space Collaboration - and can only be
configured for that application using the Macro Space Management Admin module.
Hatch Styles in the Planner Module is based on the pre-configured hatch styles in
AutoCAD. Changing Hatch Styles in Admin thus has no effect on this module.

Hatch Styles Dialogue Box
The Hatch Styles dialogue box gives brief details of the available styles.
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The Menu Bar gives access to the drop down menus.

The Toolbar gives access to many of the options available from the menus.
The Style List lists the styles that have been defined.

The Status Bar gives the total number of styles.

Selecting the Add or Edit option from the toolbar will bring up the Add/Edit Hatch Style
dialogue box.
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This allows users to specify the pattern details to be used in Merchandiser and In-Store
Space Collaboration.

Overview of Configuring Hatch Styles for Merchandiser/In-Store Space Collaboration
The data structure for a hatch pattern is very similar to an AutoCAD hatch pattern file
(*.PAT):

The hatch pattern is made up of one or more pattern lines. These pattern lines are
repeated until they fill the area defined for hatching.

Pattern lines can be specified to have a specific start point, length, gap between segments,
and angle.

Hatch patterns can be made up of multiple pattern lines. In the example below (coded
red and blue for ease of understanding) two separate pattern lines have been combined
to make a zigzag pattern.
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Configuring Hatch Styles for Merchandiser and In-Store Space Collaboration
To Add or Edit a Hatch style for Merchandiser, respectively click on the Add Hatch Style
icon [outlined in red/left], or highlight a hatch style and click on the Edit hatch style icon
[outlined in red/right].

This will bring up the Add (or Edit) Hatch Styles dialogue box. The settings to be
configured are in the Merchandiser/In-Store Space Collaboration Representation frame.
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Angle should be a numeric value between 0 and 360o.

X Origin and Y Origin values can be positive or negative decimal numbers. They specify
the offset relative to the 0, 0 datum the Zone is drawn from.
X Delta and Y Delta specify the spacing between the lines in the X and Y planes. Delta
spacing’s are specified in the drawing units (normally inches or mm).

X Delta is only meaningful for dashed lines and gives the offset for each successive line.
In the example below, the left hand example has X Delta offset = 0, while the right hand
example has X Delta offset = 1. (One line in each family of dashes has been highlighted in
red to show the effect).

Y Delta affects the vertical gap between the lines. The example on the left has a Y Delta
offset = 1, while the example on the right has Y Delta offset = 2.
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Dash and Gap determine the length of each dash in a line, and the gap between them. Up
to three dash lengths and gaps can be specified for each line.

In the example below the first unit has been colored in blue, and the second in red.

The dash and gap lengths are as follows:

Dash 1 Gap 1 Dash 2 Gap 2 Dash 3 Gap 3

1 1 2 0.5 1.5 0.5

If the first dash and gap are not defined, then a continuous line will be drawn.

Dash 2 and Gap 2 cannot be defined until Dash 1 and Gap 1 have been entered.

Dash 3 and Gap 3 cannot be defined until Dash 2 and Gap 2 have been entered.

Detail of Hatch Style Parameters for Merchandiser/In-Store Space Collaboration

The Angle of the line is the angle measured anticlockwise from horizontal. Angles can
take up any value between 0 and 360 degrees.
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The X and Y origins are specified in terms of Cartesian coordinates.

1. The Red dot has an X origin of 0 and a Y origin of 0.

2. The Green dot has an X origin of 1 and a Y origin of 2.

3. The Blue dot has an X origin of 3 and a Y origin of 1.

The X and Y offsets are the distances between lines.

1. The Green lines have a Y offset of 1.
2. The Red lines have a Y offset of 2.
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The Dash and Gap give respectively the length of a section of the line and the gap
between the next part of the line.
1. The Green Line has a Dash of 2 and a gap of 1.

2. The Red Line has a Dash of 1 and a Gap of 1.

Scales

Overview of MSM Scales
Scales potentially affect Text Styles and Symbols as they are inserted into a drawing in
the Planner Module.

There are two drawing environments in the Planner Module, Model Space and Paper
Space. Users can toggle between the two using tabs at the bottom of the drawing.

Model Space
Model Space is where an object is designed in Planner. Objects can be drawn in 3
dimensions in model space, and can be viewed at any degree of magnification.

Objects drawn in model space are always drawn at a 1:1 ratio; 1 unit in model space = 1
unit of the chosen setting. For example, if the units in model space are inches, 1 unit = 1
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inch. Similarly, if the units in model space are centimeters, 1 unit = 1 cm. Users can zoom
in or out to see the drawing at any scale.

Paper Space
Paper Space is where the drawing produced in model space is prepared for printing.
Because a drawing in model space is always drawn at a 1:1 ratio, it will generally have to
be scaled to get it to print within the limits of A2, A3 or A4 paper. For example 1 inch
may represent 8 feet (1:96) in the printed output. This enables an 11" x 7" section of paper
to represent an 88 ft x 56 foot section of floor - adequate to represent an entire
department. Using a yet smaller scale would enable an entire store to be represented.

Scales
Because of the scaling applied to get an object to print in paper space, some objects that
may have been easily readable at a 1:1 ratio in model space may become very difficult to
see when the drawing has been scaled for printing purposes in paper space. The Scales
functionality allows users to automatically scale up the size of specific items when
inserted into model space, so that when they are scaled back in paper space, they remain
readable.
For example, if it is known that the drawing will be plotted at 1" = 8ft (1:96) scale in paper
space, it is possible to set the drawing scale to 1" = 8ft in model space. Text Styles (if the
Scale option has been selected in the text style rules) and Symbols will then be scaled up
by this factor. This means they will appear very large in model space. When scaled in
paper space, they will effectively be drawn at a 1:1 size because the scaling up in model
space will exactly counteract the scaling down in paper space.

Overview of MSM Scales
Scales are used for setting the scales used for annotative objects (Text styles, etc), so that
they are readable when set up in viewports in Paper Space in Planner for printing out.

Configuring Scales in Admin
Scales can be configured using the Scales option on the Planning menu in the
Administration module. This brings up the Scales dialogue box.
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Scales can be added, edited or deleted using the option on the menu bar or toolbar.
Refresh will update the Scales dialogue box with the latest information from the
database:

Imperial Units
For imperial units the scales will depend on the base units of the drawing in Model
Space. In the table below, the results are based on inches.

Units Scale Result in Model Space

Inches 48 1 inch is scaled to 4 feet.

Inches 120 1 inch is scaled to10 feet

Inches 240 1 inch is scaled to 20
feet.

Metric Units

Similarly, for metric units the scales will depend on the base units of the drawing in
Model Space. In the table below, the results are based on millimeters

Units Scale Result in Model Space

mm 100 1 mm is scaled to 10 cm.

mm 500 1 mm is scaled to 50 cm

mm 1000 1 mm is scaled to 1
meter

Configuring Objects to be Scaled
Scaling is applied to two types of objects:

1. Symbols

2. Text Styles
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In order for them to be scaled in the Planner environment, they must first be configured
accordingly.

Symbols
Symbols are shapes like arrows, etc, that are used to indicate points of interest in a store
plan.

In order to designate an AutoCAD block as a symbol, the Symbol radio button must be
selected in the Categories Tab of the Block Details dialogue box in Fixture Studio. Once
an object has been designated as a Symbol, the Drawn 1:1 checkbox also has an effect:

1. If left unchecked, the symbol will be drawn at 1:50 scale

2. If checked, the symbol will be drawn at 1:1 scale - i.e. at the nominal size of the block.

Note: Symbols are currently not scaling properly in the
Planner module.

Text Styles
In order for a text style to scale when added into a Planner store plan, the Scale options
must be checked in the Text Style rules dialogue box of Text Styles in the Admin Module.
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1. If Scale (and Scale Offset) are left unchecked, the Text Style will be drawn at a 1:1
scale

2. If Scale (and Scale Offset) are checked, the Text Style will be drawn at the scale set in
the Set Up dialogue box in the Planner module. More Information

Using Scales in the Planner Module
The Scales setting in the Admin Module is picked up in Planner via the Drawing Setup
option in the Format pull down menu.

This calls the Setup dialogue which allows the user to set the required scale for the
drawing. The required scale must correspond to the scale it is intended to use in paper
space. For example, if it is decided to plot at 1 in: 16 feet in paper space, the same scale
should be selected in set up.

Symbols and specified Text Styles will then be scaled up by a factor of 192:1 when placed
in model space, and scaled down by 1:192 when plotted at 1 in: 16ft in paper space. This
enables the specified objects to be visible in the printed store plan.

Text Styles

Overview of Text Styles

Overview of Text Styles
Text Styles are used to annotate objects in the Planner environment. Different Text Styles
can be defined and assigned to the varying classes of objects.
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In the above example, text styles have been defined so fixtures are annotated in black,
planograms in red with the profiles (bays) numbered in blue. Products have been
annotated in purple. The annotation has been defined so it does not overwrite itself.

Text Styles can be assigned to all three types of Zone:

• Department Zone
• Internal Zone
• Zone

Text styles can also be assigned to:

• Fixtures
• Products
• Planograms

Both products and planograms can have different types of annotation associated with
them. Products are often configured with one form of annotation for placeholders and
another form of annotation for products at SKU level. Multi bay planograms are often
configured with both planogram details and the numbers of the profiles (bays).

Text styles can be set to draw automatically when an object is placed in the drawing.
Alternatively, text styles can be set so that they will only annotate specific objects in the
drawing that have been selected by a user.

Note: Manual annotation is controlled using the 'Annotate'
option on the Retail toolbar in Planner.

It is also possible to make text styles conditional so that they only apply in specific cases.
This is done through changes in the custom SQL used to extract information used in the
text styles.

The Text Styles Admin Tool
The Text Styles Admin Tool is used to display details of all available text styles.
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Options can be selected from the menu bar or from the toolbar. These include:

Exiting from the Text Styles Admin Tool dialogue box
Exiting from the Text Styles Admin Tool will not save any changes made since the last
time the Save option was used.

Saving changes to Text Styles back to the Database

Note: changes to text styles will not be saved back to the
database until the Save option has been used (toolbar icon or
from the File menu).

If there are no outstanding changes to be saved back to the database, the save icon will be
grayed out.

Adding a new Text Style
Text styles can be added by selecting the 'Add Text Style' option from either the Edit
menu or the toolbar. This will bring up the Text Styles dialogue box.

Editing an Existing Text Style
Existing text styles can be edited by highlighting the required style in the list of available
styles and selecting the 'Edit Text Style' option from either the Edit menu or the toolbar.
This will bring up the Text Styles dialogue box.

Deleting an Existing Text Style
Text styles can be deleted by selecting the delete Text Style' option from either the Edit
menu or the toolbar. System text styles cannot be deleted. (The 'System' attribute can only
be set within the database).
Before the text style can be deleted, confirmation will be required.
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Copying a Text Style
Existing text styles can be copied by highlighting the required style in the list of available
styles and selecting the 'Copy Text Style' option from either the Edit menu or the toolbar.
This will bring up a Text Styles dialogue box containing a duplicate of the selected style.
This duplicate can then be edited to produce a text style that is slightly different from the
original.

Refreshing from the Database
The Refresh option (available from the toolbar or from the View Menu) updates the Text
Styles Admin Tools dialogue box (and its associated dialogue boxes) with the
information currently held in the database. Using the Refresh option will overwrite any
changes made in Text Styles that have not yet been saved back to the database.

If changes have been made to the Text Styles a warning message will be displayed.

Text Style Wizard
The Text Style Wizard provides an alternative to manually configuring a text style. Four
screens take users through creating a text style and automatically create the SQL required
to extract information from the database.

Overview of Configuring Text Styles
Text Styles are specific to Planner and are integrated with AutoCAD functionality. (A
different form of annotation is used in the Merchandiser Module).
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The Text Styles Admin Tool contains a list of the available text styles. Some of these text
styles will be in use, others may be temporarily inactive.

The list of text styles can be added to, selected for editing or deleted. In addition, a Text
Style Wizard can be used to simplify creating text styles.
The Text Styles dialogue box allows the broad details of a text style to be configured.

This includes the font type and color, AutoCAD layer, type of object the text is to be
associated with, etc. Using Ctrl + A toggles the Text Styles dialogue box to show the
custom SQL that extracts the information from the database used for the annotation.
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The Text Style Rules dialogue box is used to configure the details of a text style.
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It is possible to have multiple text style rules for a specific text style. When the annotation
is drawn, each text style is 'tested' in sequence. The first text style that meets the
requirements is used. For example text styles might be configured with text sizes of 6
inches, 4 inches and 3 inches. Each text style will be tested in turn, until the largest text
size that will allow all the text to be displayed is identified.

Types of Text Styles
It is possible to set up a variety of generic types of text styles. They can be selected from
the Auto Placement options in the text styles dialogue box,
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Alternatively, they can be selected from the third page of the Text Style wizard.

Department Zone
The Department Zone is one form of zone: specifically the Zone - Fixture Links ensure
that Fixtures in the AVTTB_FIXTURE Table are only associated with a single department

Internal Zone
The Internal Zone is one of three types of zones. It denotes the maximum area of the store
used for sales purposes.

Zone
The 'Zone' zone is a third type of Zone that gives an alternative to zones of type 'Internal
Area' or 'Department'.
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Fixture
This text style is used for fixtures.

Note: for fixtures to annotate, the 'Include Fixture
Annotation' option must be checked in the Categories Tab of
the Block Definitions dialogue box in Fixture studio. More
Information

Product SKU
This text style is used for products that have been placed at SKU (Stock Keeping Unit)
level from the product hierarchy

Product Placeholder
This text style is used for products that have been placed at Placeholder level (i.e. above
SKU level) from the product hierarchy

Planogram
This text style is used to annotate planograms. Planogram information can sometimes
include profile annotation - information on specific bays within a multi-bay planogram.

General
This text style is not yet implemented.

Turning on Fixture Annotation
Whether Fixture Annotation for a specific fixture (or fitting) displays in Planner depends
on settings in Fixture Studio.
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For a specific fixture to annotate in Planner, the Include in Fixture Annotation option
must be checked.

This allows flexibility in what gets annotated. One option is to specify all fixtures will
annotate, but that fitting will not. This simplifies the annotation for gondola runs contain
a mixture of fixtures and fittings.

Note: the Auto Placement option (set in the Text Styles
dialogue box) determines whether fixture annotation for
fixtures that have had the 'Include in Fixture Annotation'
check box ticked is placed automatically, or has to be drawn
as a result of a command from a user.

Annotation in Planner
Annotation in Planner is first determined by the Auto Placement settings in the Text
Styles dialogue box in the Admin Module.
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1. If a Text Style has an Auto Placement option selected, (for example Planogram), then
when that type of object is placed, the annotation will automatically be added.

2. If a Text Style has Auto Placement option set to 'None', then when that type of object
is placed, no annotation will automatically be added. (It can subsequently be
manually added by a user).

The Retail Toolbar within Planner is used gives three options to annotate objects in
the drawing

3. Annotate Fixtures will cause fixture annotation to be drawn according to the text
style rules currently active in Planner

4. Annotate Products will cause product and planogram annotation to be drawn
according to the text style rules currently active in Planner

5. Annotate allows the text style rules currently active in Planner to be updated from
the database. It also allows objects to be manually annotated when Auto Placement
has been set to None in Text styles in the Admin Module.

Note: the text style rules active in planner are those present
when the application was opened, or when text style rules
were last refreshed using the Annotate dialogue box.

Annotate Fixtures
If the Auto Placement option is set to 'Fixtures', fixtures will be re-annotated with the
currently active text style(s).
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Annotate Products
If the Auto Placement options are set to 'Products' or 'Planograms', merchandise will be
re-annotated with the currently active text style(s).

Annotate
The Annotation dialogue box gives more control over what annotation is displayed in the
drawing.

The Refresh Button will update all text styles currently held in Planner with the latest
version held in the database.

Note: this would be applicable if an Administrator is
updating text styles in the Administration Module and
simultaneously testing the effects of the changes in the
Planner Module.

The Annotation dialogue box contains a list of text styles. Any individual text style can
be selected by highlighting it.

1. If the OK button is clicked, all instances of annotation associated with that text style
in the drawing will be updated.

2. If the Select button is clicked, the user will be taken to the drawing. Objects can then
be selected using standard AutoCAD selection methods On completing the selection
sequence with a right click, all selected objects will have their annotation updated.

Using Multiple Text Styles for a Specific Object
It is possible to use multiple text styles to annotate a specific type of object.
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In the above example of the Annotation dialogue box there are four text styles for
planograms:

1. Basic Planogram Details

2. Clothing Planogram Details
3. Electrical Planogram Details

4. Food and Drink Planogram Details

If the Auto Placement option in the Text Styles dialogue box is set to 'None', then
planograms will not be annotated on insertion. It is then possible to highlight a text rule
and select the planograms to be annotated. Working in this way, it is possible to annotate
Food and drink planograms in a completely different style to clothing planograms.

Text Style Placement Logic
The Logic of Text Style placement is as follows:
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1. When a text style is placed, the software checks to see whether Auto Placement is on.

2. If Auto Placement is On, the annotation will be added when the object is inserted.

3. If Auto Placement is set to 'None', the object will be placed in the drawing but
annotation will not be drawn during insertion.

4. Annotation can be added or updated manually by the user by means of the
Annotation option in the Retail toolbar in Planner.

5. When annotation is added, the software checks to see if there are multiple text style
rules.

6. If there is only a single text style rule the annotation is placed immediately.

7. If there are multiple text styles rules, the text styles rules are tested in sequence. As
soon as a text style rule passes, the annotation is placed.

Text Styles and Custom SQL
The Text Style Wizard can be used to generate the Custom SQL statement used to
retrieve the information used in annotation. This Custom SQL can then be seen in the
Text Style dialogue box. (Use Ctrl + A top reveal it).
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It is possible to modify this Custom SQL statement to customize the annotation for each
type of object being annotated. For example fixtures that are children of the 'Racking'
node in the Fixture Hierarchy could have different annotation from fixtures that are
children of the 'Fittings' node in the Fixture Hierarchy.

When fixtures are annotated, all text styles of type 'Fixture' will be applied, but specific
fixtures will only be annotated if they meet the conditions set out in the Custom SQL -
one type of annotation will be applied if the item of equipment is determined to be
'Racking' and another if it is determined to be a 'Fitting'.

The Text Style Wizard

Overview of the Text Style Wizard
The Text Style Wizard provides an alternative way to manually configuring a text style.
It consists of a series of four screens that the user moves through in sequence.
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Once the screens have been completed, a Text Style will have been configured.

Text Style Wizard - First Page
The First Page of the Text Style Wizard is used to select whether the user wished to
create a new Text Style or overwrite (edit) an existing one.

To overwrite an existing rule it must be highlighted in the main Text Styles Admin Tool
Window before the Wizard is invoked.

Click on Next > to move to the next stage.
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Text Style Wizard - Second Page
The Second Page of the Text Style Wizard is used to input the name and description
(type) of the Text Style.

Enter the Text Style Name and Description as required.

Click on Next > to move to the next stage.

Text Style Wizard - Third Page
The Third Page of the Text Style Wizard is used to specify the type of Macro Space
Management feature the Text Style is to be associated with.
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Select the required type of Text style. This is done by means of a radio button, so only
one type of Text Style can be selected at one time. If a Text Style already exists a warning
dialogue will appear.

It is not possible to have a second version of the same Text Style, so if it is desired to
change this Text style it must be edited.

Click on Next > to move to the next stage.

Text Style Wizard - Final Page
The Fourth (and last) Page of the Text Style Wizard is used to set the characteristics of
the Text style.



Text Styles

180 Oracle Retail Macro Space Management

The Font can be set from a drop down list of available fonts.

The Font Color can be set by clicking on the color button and selecting the required color
from the pallet.

The Font Size can be set using the spin controls.

Bold or Italic fonts can be selected by ticking the relevant check boxes.

The Layer determines what AutoCAD layer the annotation is to be placed on.
The Text that will be displayed can be selected by ticking the appropriate check boxes.
The items of text that can be displayed will vary with the type of text style selected in the
previous screen. For example, the Zone Text Style will have a different set of options to
the Planogram Text style.

Note: Checking the list of items in the Text Box causes a
custom SQL statement to be generated. This extracts
information from the central Macro Space Management
database and annotates Zones, Fixtures or Merchandise
accordingly.

Click on Finish to add the Text style to those available.

The Text Styles Dialogue Box

The Text Styles Dialogue Box
The Text Styles dialogue box allows the basic rules of Text Styles to be configured. Using
Ctrl + A toggles between two different views in the right hand pane. One view gives a
list of the available Text Style rules for that Text Style. The other view shows the custom
SQL used to extract information from the database to be used in the text styles.
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The Style Options Frame
The Style Options frame allows
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Style Name is the name assigned to a text style.

Style Description allows a longer, more comprehensive description to be associated with
the Style Name

Layer Alias specifies which AutoCAD layer the annotation is placed on. It is selected
from a drop down list of the layers that make up the AutoCAD store plan on the Planner
module. (The store plan can be regards as being made up of all the objects on all the
layers in the drawing. AutoCAD provides ways to control objects on the individual
layers, for example by turning their visibility on or off).

In the above example, when fixtures are placed, they would be placed on the Fixtures
layer. If the fixtures are annotated, the text would go on the Fixture Text Layer -
similarly, if bay numbering is added, it would go on the Bay Numbering layer.
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So, although the above example looks like a single entity, it is made up of three separate
layers.

Auto Placement allows the user to specify whether annotation will be added
automatically on inserting an object into the Planner environment, or whether the user
will have to manually initiate annotation. There are a series of options:

Option Description

None Setting a text style to 'None' disables automatic annotation of objects when they are
added in the planner environment. Annotation can be added manually via the
Annotation dialogue box at user discretion. More Information

Department Zone Associates the text style with zones of type 'Department Zone' - see Zone Types option
from Planning menu.

Internal Zone Associates the text style with zones of type 'Internal Area' - see Zone Types option
from Planning menu.

Zone Associates the text style with zones of type ‘Zone’ - see Zone Types option from
Planning menu.

Fixture Associates the text style with fixtures

Product SKU Associates the text style with products placed as SKU level

Produce
Placeholder

Associates the text style with products placed as placeholders (above SKU level)

Planogram Associates the text style with planograms

Multi-Profile Offset is used when two or more instances of the same annotation are
associated with an object. An example would be if two products were placed onto a
fixture. Each product would have separate annotation.

In the above example, bacon and fresh milk have been placed on a fixture. In the left
hand image, no offset has been used and the text has overwritten itself. In the right hand
image, a multi profile offset has been applied and the text appears without overwriting
itself.
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Note: this will not work if Word Wrap has been selected in
the Fit Within frame of the Text Style Rules dialogue box.
Because the word wrap fixture puts text onto multiple lines,
the second line of the first product to be placed will be
overwritten by the first line of the second line to be placed.

Scale Offset
The Scale Offset checkbox is used in conjunction with Multi Profile Offsets. It is
applicable when a scale has been applied to the drawing (Format > Drawing set up in the
Planner module.

Font can be selected from a drop down list.

Color refers to the color of any text. It can be selected from a standard color pallet.

Dimension Color refers to the color of any dimension and extension lines. These can be
set to be different from the text. Dimension color can be selected from a standard color
pallet.
The Bold and Italic check boxes result in the text font being changed to bold or italic as
required.

Bring Text to Front results in the text overwriting any objects that are present in the
drawing. For example, it there is a fixture present where the text is to be written, the
annotation will be placed on top of the fixture. (If Bring Text to Font is not selected, the
text might be obscured by the fixture).
Keep Parallel is used when fixtures are not in a straight line. It will only apply if the
Keep Separate Text check box is not checked. It will draw the annotation parallel to the
average direction of the fixtures.

Note: this functionality is not fully implemented.

Keep Separate Text is used when a run of adjacent objects are similar. An example
would be if three adjacent fixtures contain identical products.

In the above examples, if Keep Separate Text is not checked, objects that are similar and
adjacent will be annotated as a single item. If Keep Separate Text is checked, then each
item will be annotated separately, even if they are adjacent.
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The Text Style Rules Frame
The Text Style Rules frame allows users to configure a number of text style rules for a
given text style. When adding annotation based on that text style, each rule will be tested
in turn and the first rule that complies will be applied. (Using Ctrl + A will toggle to the
SQL frame).

In the example above, the two test style rules are based on text size. The annotation first
tries to use text of 6 inch size. If that will not fit into the existing space, the text size is
reduced to three inches.

In the above example, the annotation for the product placed on the left (Tea) will fit into
the available space using 6" high letters. The annotation for the product placed on the
right (Juice) is too long to fit into the available space using 6" high letters, so the software
applies the next rule - which is to apply 3" letters.
(For information on how to configure Text style rules, see the section on the Text Style
Rules dialogue box).

The toolbar options are as follows:

Option Description

Add Text Style Rule

Edit Text style Rule
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Delete Text Style Rule

Copy Text Style Rule

Move selected item up
in list

Move selected item
down in list

The SQL Frame
The SQL frame is toggled into view by means of Ctrl + A.

The SQL can be derived from one of two sources:
1. It can be produced using the Wizard.

2. It can be input directly.

Note: Direct Input of SQL is not recommended unless the
user has good SQL skills and is familiar with the Macro
Space Management database. Also note that the SQL
contains custom additions such as {FIL_ID} and {IDS}. (More
Info)

The SQL is used to select information from the database. Which information is displayed
in the annotation is determined by settings in the Options frame of the Text Style Rules
dialogue box. (The required options have to be toggled into view using Ctrl + A).
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The Field Index specifies the items of data required.

The Field Separator determines the character use to separate items of data.

Note: the Fix ID and AutoCAD are used to identify specific
objects. The selectable items of data start after these items. In
the above example, the first item that can be selected is
BLK_NAME (Block Name).

The Text Style Rules Dialogue Box

The Text Style Rules Dialogue Box
The Text Style Rules dialogue box is used to configure the details of specific Text Style
rules.



Text Styles

188 Oracle Retail Macro Space Management

The Options frame allows users to specify the appearance of the text that appears.

The Fit Within frame allows users to specify what happens if the text is too long relative
to the length of the fixture.

The Use Dimensions frame allows users to specify whether dimension and extension
lines are used when annotating the object.

The Position frame details with how text is justified.

The Options Frame
The Options frame
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Size is the size used for the text that annotates objects. If an imperial size, the value is in
inches, if a metric size, the value is in millimeters.

Width Factor determines the ratio of width to height of the text. Values of less than 1
result in the width being reduced relative to the height. Values of greater than one result
in the width being increased relative to the height. Width Factors may be set within a
range of 0.5 - 1.5.

In the example on the left, the width factor has been set to 0.5. In the example on the
right, the width factor has been set to 1.5.

Line Spacing determines the spacing between successive lines of text if word wrap (Fit
Within options) is on.

Scale and Scale Offset are used when an AutoCAD drawing has been given a scale via
the Format > Drawing Set Up option in the Planner module.

If Scale and Scale Offset are selected and the drawing has been assigned a scale, the text
and dimension arrows will be scaled up relative to the scale of the drawing, so they stay
at a standard size. For example, if the drawing is at a 1:100 scale, text will be scaled up
100 times, so it draws at an absolute size.

If Scale and Scale Offset are not selected, the text and dimension arrows will draw at the
scale of the drawing. For example, if the drawing is at a 1:100 scale, text will be drawn at
a hundredth of its absolute size.

Note: scaling does not fully work at present.

Field Index can be accessed by means of Ctrl + A. It allows the user to select the items
that will be displayed from the SQL statement for a specific text style in the Text Style
GUI.
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The SQL is revealed by highlighting a text style, and selecting CTRL + A. The SQL
statement is in the form of a 'Select' statement that identifies specific items of data from
the database. The first two items in the statement are the ID of the object in the MSM
database and the AutoCAD handle (ID). Any further items can be selected by entering a
number giving its position in the SQL statement (after the Block and AutoCAD ID's).
Successive values can be separated by a comma. In the example below, the description,
length and with have been selected.

The Field Separator is also accessed by means of Ctrl + A. It can be selected by means of
a drop down list.

In the example below, the block description, length and depth have been selected and a
separated by a '/'.
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The Fit Within Frame
The Fit Within options control how text appears if the selected text is too long to fit on a
single line. Rotate Vertically (accessed by Ctrl + A) can be selected by means of a check
box, the other four options are selected by mans of a radio button.

Rotate Vertically is normally hidden, but can be accessed by use of Ctrl + A. If text is too
long to be written horizontally relative to the fixture, it will be rotated through 90 o so
that it can be written vertically relative to the fixture.

Note: Rotate Vertically is not functioning correctly at
present.

Selecting None results in no text being displayed if the text is too long for the available
space.

Note: None is not functioning correctly at present.

Selecting Abbreviate results in a shortened version of the text string being displayed.

Selecting Truncate results in the text string being truncated to fit
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Selecting Word Wrap results in the description being wrapped onto several lines.

The Dimensions Frame
The Dimensions frame is used to specify how dimension and extension lines appear.

Note: Dimension and extension lines are not available for all
three types of zone annotation.

The Use Dimensions check box can be used to toggle dimension lines On or Off in their
entirety.

The Dimension Lines checkbox will toggle dimension lines on or off.

The Extension Lines checkbox will toggle extension lines on or off.

The Arrows checkbox will toggle the arrow head display on or off.
The Arrow Size can be set by means of the spin control.

The Arrow Type can be selected from the drop down list.
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The Position Frame
Relative Position, Justification and Offsets determine how text places relative to the
fixture.

Relative Position determines where the text starts within the fixture - each button in the
position frame corresponds to a specific point within a fixture.

Justification determines how the text positions in relation to the Relative Position. It is
designed to operate in a similar way to the equivalent AutoCAD functionality. In the
example below, the text is top justified in relation to the Relative Position.
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In the example below, the text is left justified in relation to the Relative Position.

The advantage of this means of operation is that it is possible to position text outside of
the parent object.
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Finally, it is possible to use the X Offset and Y Offset to fine tune the position of the text.
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For example if different offsets are specified for fixture and product information, it will
be possible to avoid these two types of annotation overwriting each other.

Title Blocks

Overview of Title Blocks
Title Blocks are used to put a frame round a drawing in preparation for printing it. Title
Blocks can also contain information on the drawing.
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The Title Block is an AutoCAD DWG file that overlays the store plan on model space. It
contains information on the drawing and one or more viewports to display the drawing.

The Viewport is a specified area within the Title block where the drawing appears.
Viewports can be set to precise scales.

The Title Block Information is a specific part of the Title Block. It contains fields that
populate with data about the drawing. In the above example the fields include the store
name and store code. The data to populate these fields is read from two sources:

1. From information imbedded into the drawing by the software

2. From the database by using custom SQL

Each Title Block is designed for a specific size of paper, so if drawings are to be printed
off in a range of sizes, title blocks should be created for each size. A metric
implementation of Macro Space Management may contain title blocks for A0, A1, A2, A3
and A4 size paper, while and imperial one may contain title blocks for ANSI A, ANSI B,
ANSI C, ANSI D and ANSI E size paper.

Overview of Creating Title Blocks
Title Blocks are created using the following sequence of actions.



Title Blocks

198 Oracle Retail Macro Space Management

Preparation
There are two actions required to prepare for the use of Title Blocks:

Ensure Canonical Media is Correct
Canonical Media are the range of paper sizes recognized by AutoCAD for printing
purposes. They typically need to be installed once immediately after installing the
software.

Create Custom SQL to Extract Information
It is possible to populate the fields in the title block with information extracted from the
database. The information must be extracted from the database with a Custom SQL
statement that is stored in the AVTTB_CUSTOM_SQL database.

Implementation

Creating Title Block in Planner Module
The initial stage to creating a Title Block is to draw it in the Planner Module. All
information that will automatically be added must have an Attribute Definition assigned.
When the Title Block has been drawn, it is turned into a block with the 'block' command,
and then written to an appropriate directory in the MSM directory structure with the
'WBlock' command.

Registering the Title Block in Fixture Studio
Once a Title block has been created in the Planner Module, the next stage is to create the
appropriate entry (registering) in Fixture Studio. This ensures that the title block will be
available for the functionality that references it, be drawn on the right layer, be drawn at
the correct size, etc.

Adding Title Block Information in the Admin Module
Once the Title Block has been registered in Fixture studio, the final stage is to enter
details of the title block in the Admin Module. This enables users to specify the
description of the Title Block, size of view ports, etc.

Use
Once the Title block has been implemented, it can be used in the Planner Module by the
Add Title Block command on the Insert Menu. It can be updated using the Insert Title
Block command on the Insert Menu.
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Canonical Media
Canonical Media are the range of paper sizes recognized by AutoCAD for printing
purposes. They typically need to be installed once immediately after installing the
software. To add (or update) the list, open the Planner module and type vbarun into the
command line.

This will bring up the Macros dialogue box.

Select C:\Program Files\Oracle
Retail\MSM\2007\acad.dvb!ThisDrawing.RFV5CanonicalMedia and click Run. The
software will detect all printers the user's computer is connected to (including network
printers) and generate a list of all paper sizes recognized by those printers.

This command only needs to be run once, and then the user's computer will be set up to
print drawings and their associated title blocks on those printers.

Custom SQL
Custom SQL is used to populate anything other than the default Attribute Names. The
Custom SQL for Title Blocks is stored in the AVTTB_CUSTOM_SQL table with a CSQ_ID
of 69. Only one set of Custom SQL can be used for title blocks. There are three points of
interest in the simple example below:

1. Qualifying the Select Statement

2. Use of Column Alias
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3. Marker

Qualifying the Select Statement
Sometime the select statement has to be qualified to get the data to display in the most
appropriate format. Here, the Truncate command has been used to remove the hours and
minutes from the date before it is displayed.

Use of Column Alias
The Column Alias matches the Attribute Definition it is wished to populate in the Title
Block. In the above example, the Publish Date for the file will be displayed using the
attribute definition PUB_DATE. The Column Alias has been set to be the same. When the
Title block is Added or Updated the code will match up the Attribute Definition and the
Column Alias and populate the Title Block with the specified information.

Note: the Attribute Definition and the Column Alias must be
an exact match. Misspelling of one or the other will result in
the Title Block not populating.

Markers
Markers are column names from MSM database tables enclosed in curly brackets:
{FIL_ID}. This part of the Custom SQL is specific to Macro Space Management. In a
normal SQL statement the 'where' clause might be something like FIL_ID = 1234. Here,
the Title Block is going to populate with information relative to the active drawing in
Planner. The FIL_ID (File ID) is one of the items of information 'stamped' into the active
drawing. The where FIL_ID = {FIL_ID} clause allows the code to identify the FIL_ID of
the currently active drawing and filter the information derived from the SQL statement
accordingly.

Note: without using the Marker {FIL_ID} as a filter, the SQL
statement would have returned all Publish Dates for all files
recorded in the AVTTB_FILE directory.

Creating the Title Block in Planner
Creating the Title Block in the Planner Module requires a series of actions to be carried
out.

Establishing Required Dimensions
Title Block Size has to take into account the printable area on the selected paper size. For
example, A3 paper is 297 x 420 mm. However, printers (and plotters) cannot make use of
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all that area and a border (called the non-printable area) that cannot contain any lines or
text exists around the edges of the paper.

The size of the title block needs to take into account the non-printable area. For example,
if A3 paper is used, and the non-printable area is 6 mm wide, then the title block needs to
be drawn at 285 x 408 mm to fit exactly into the printable area of the paper. The insertion
point of the title block is normally set at 0, 0 as 0, 0 in the paper space layout is defined as
the lower left corner of the printable area.

Note: the size of the printable area is printer/plotter specific.
It is helpful to allow a small margin for these differences.

Draw Frame and Text Boxes
After the size has been established a frame can be drawn in planner, and text boxes
added.

The Title block is usually drawn with the origin at 0, 0.

Add Attribute Definitions
Attribute Definitions are used to set up the 'template' Attributes for the text boxes. They
are invoked by typing the ATTDEF command into the AutoCAD command line in
Planner.
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This will bring up the Attribute Definition dialogue box.

The Attribute Definitions can then be put into the drawing.

Attribute Tags should always be continuous text. If necessary, join two words with an
underscore: WORD1_WORD2.

The Attribute Tags should either match the names of the data 'stamped' into the drawing
(More Info) or the Column Aliases in the Custom SQL (More Info).
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Turn into Block
The Title Block can then be turned into a block with the 'block' command. This can either
be initiated from the Draw toolbar, or from the command line.

The individual components of the Title Block will then be combined to make a single
object. This block definition is stored in the current drawing and is not yet globally
available.

Write Block (Wblock) to Make Externally Available
The Write Block (WBlock) command is used to write the block definition to an external
directory where it can be used in any Macro Space Management drawing. The command
is invoked by typing WBLOCK into the command line.
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The destination should be a directory specified in the Directories Tab of the
Configuration Module.

Data Taken from the Drawing
Data is imbedded into a drawing when a drawing is created. This data is used for a
number of purposes by Macro Space Management. One of these purposes is to populate
the Attribute Definitions in Title Blocks. The data 'stamped' into a drawing has specific
names assigned. If these match the name of an Attribute Definition in a Title Block, the
information will be written into the Title Block on insertion into the drawing.

STORECODE
Store Code brings in the Store Code specified in the Add/Edit Store dialogue box in
Store Manager.
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STORE
Store brings in the Store Name specified in the Add/Edit Store dialogue box in Store
Manager.

REVISION
Revision brings in the Revision Description specified in the Add/Edit Revision dialogue
box in Store Manager.
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FLOORCODE
Floor Code brings in the FLT_NAME (a numerical value) from the AVTTB_FLOORTYPE
table that is associated with the corresponding Floor Type specified in the Add/Edit
Floor dialogue box in Store Manager.

Note: FLOORCODE is currently not working correctly. If it
is desired to add this information to a Title Block, it should
be done using custom SQL and a slightly modified attribute
name.

FLOOR
Floor brings in the Revision Description specified in the Add/Edit Floor dialogue box in
Store Manager.
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Note: FLOOR is currently not working correctly. If it is
desired to add this information to a Title Block, it should be
done using custom SQL and a slightly modified attribute
name.

SCALE
Scale brings in the scale set in the Drawing Setup option of the Format menu in Planner.

DATE
Date brings in the date that the title block was generated or updated on.
DWGNAME

Drawing name brings in the name of the AutoCAD DWG file as specified on the Details
Tab of the File Properties dialogue box in Store Manager.
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FULLFILENAME
File Full Name brings in the name and path to the file specified in the Location text box
of the Details Tab of the File Properties dialogue box in Store Manager.

The full file name can be long; for example:

\\qa2k10g\clientdata\Standard\RF_Data\Stores_Root\Example Store\Level
2\Revision 1\Example Drawing.dwg

If the FULLFILENAME attribute definition is used, this length should be taken into
account when defining the attribute.

Registering the Title Block in Fixture Studio
Registering the Title Block in Fixture Studio requires the following steps.
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Selecting the Parent Fixture Group
All blocks within Fixture Studio are arranged within a hierarchy. The default hierarchy
contains a Fixture Group called Title Blocks. This is the usual location for title blocks.

Create a Block and Enter the Block Name
Create a block by invoking the Add Block option from the Edit menu or the toolbar. This
will bring up the New block name dialogue box.

Ensure that the block name entered exactly matches the block name specified in the
WBlock command used in planner. On clicking OK, the Block Details dialogue box will
appear for editing.

Enter Settings in the Block Details Dialogue Box
The Block Details dialogue box allows custom properties to be assigned to the title block.
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Full details of how to use this dialogue box can be found in the Fixture Studio help file.
The principal settings pertinent to title blocks are:

Category Tab
1. Set the Retail Type to Title Block.

2. Set the Directory to match that specified in the WBlock command when the block
was saved in Planner.

3. Set the Units as appropriate.

4. Set the Icon to Title Block.

Insertion Tab
1. Set the Layer to Other > TITLEBLOCK.

2. Level can be left as 'Undefined'.

Size Tab
1. The Sizes should be set as appropriate.

2. Height can be left as 0.00001 - this nominal value is to avoid 'divide by zero' errors in
the code.
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Adding Title Block Information in the Admin Module
Adding Title Block Information in the Admin Module is in two stages:

Specifying Title Block Details
Title Blocks are Added, Edited or Deleted using the Title Blocks option from the Planning
menu. This will bring up the Title Blocks dialogue box.

Name is the nominal name of the title block.

Blockname is the name of the block for the title. It can be selected from a drop down list.
This list contains the name of all blocks of type 'Title Block' is Fixture Studio.

Width is the nominal with of the paper the title block is designed for. It is for display
purposes only
Height is the nominal height of the paper the title block is designed for. It is for display
purposes only.

Width Offset is the offset of the insertion point of the title block in the 'X' plane relative
to the lower left corner of the printable area on the paper the title block is designed for.

Height Offset is the offset of the insertion point of the title block in the 'Y' plane relative
to the lower left corner of the printable area on the paper the title block is designed for.
Default Scale is the default scale that will be applied to the viewports when they are first
defined in the Title Block dialogue box.

Note: this option is currently not setting the default in the
Title Block dialogue box.

Canonical Media is selected from a drop down list. It should be set to the size of paper
the title block is designed for.

Note: Any entries will only be added when the [Return] key
is pressed.

Title Blocks can be added or deleted using the appropriate options on the Edit menu or
the toolbar. Selecting the edit option on the edit menu or the toolbar will bring up the
Title Block dialogue box.
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Specifying Viewport Details
The Title Block dialogue box is used to specify the details of the viewports in the Title
Block. It is invoked by the edit option in the Title Blocks dialogue box.

The information to the left of the dialogue box mirrors that of the Title Blocks dialogue
box. The information on the right of the dialogue box is used to set up viewports. Title
blocks may have multiple viewports.

Width is the dimension of the viewport in the 'X' plane.

Height is the dimension of the viewport in the 'Y' plane.

Width Offset is the offset of the viewport in the 'X' plane relative to the insertion point of
the title block.

Height Offset is the offset of the viewport in the 'Y' plane relative to the insertion point
of the title block.

Scale is the scaling factor applied to the viewport.

Note: Scaling is not working correctly at present.

View is the direction the drawing will be presented in the viewport. Options include
Plan and a number of isometric projection directions.

Note: View is not working correctly at present.

Note: Any entries will only be added when the [Return] key
is pressed.

Deleting Title Blocks from Macro Space Management
Deleting Title Blocks from Macro Space Management takes place in three stages:

1. Delete Title Block Definition from Admin Module

To delete the Title Block definition from the Admin Module:

a. Select the Title Block in the Title Blocks dialogue box.

b. Highlight the required Title Block and select Edit. This will open the Title Block
dialogue box.
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c. Delete any viewports associated with the Title Block.

d. Close the Title Block dialogue box.

e. Delete the Title block from the Title Blocks dialogue box.

2. Delete Title Block from Fixture Studio

To mark the Title Block for deletion from Fixture Studio:

a. Highlight the Title Block in the Fixture Hierarchy.

b. Select Delete Block from the right click menu - the block name will change from
black text to grey.

c. Save the changes (Save Option) so that the 'delete' flag is set in the database.

Note: the Title Block has not been deleted at this stage - it
has merely been marked for deletion.

3. Purge Title Block in the Admin Module

To permanently delete the Title block from the MSM database:

 Select the Purge option from the Tools menu.

 Select the Fixtures checkbox and click OK.

Note: this will delete the information from the database.
However, the block will not be deleted from the directory it
is stored in. This is because the block might be referenced by
other software.

Placing Title Blocks in Planner
To place Title Blocks in Planner, select the Add Title Blocks option from the Insert menu.

This will bring up the Title Blocks dialogue box.
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The list of available Title Blocks is that specified in the Administration Module.

To place a Title Block, highlight it in the list then click OK.

Modifying Title Blocks in Planner
When designing a Title Block, it is sometimes necessary to place the Title Block in a
Planner drawing and subsequently modify it so correct minor flaws in the design. Once
the modified Title Block DWG file has been saved, actions are necessary in Planner to
ensure that the modified Title Block displays - and not the original version. The two
options are:

1. Removing Title Blocks, Purging and Reinserting Title Blocks

2. Restructuring the Drawing and Updating the Title Blocks
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Removing Title Blocks, Purging and Reinserting Title Blocks
Where there are only a few instances of a title block present in a drawing, it is possible to
manually delete them, purge instances from the drawing and reinsert the updated title
block.

Purging is necessary if a title block that has previously been used in a specific drawing in
the Planner Module. AutoCAD stores a copy of the block definition in the drawing when
the block definition is first used. All subsequent insertions of that block will be copies of
the stored block definition. In order for the modified Title block to take effect, the old
definition must first be removed from the drawing. This can be done by using the Purge
option from the File > Drawing Utilities menu. Alternatively, it can be invoked by typing
PURGE into the command line.

If all active instances of the Title Block have been removed from the drawing, it will be
possible to select the definition and purge it. The modified title block can then be added
as required using the Add Title Block option from the Insert menu in Planner.

Restructuring the Drawing and Updating the Title Blocks
Restructuring the Drawing updates blocks in the drawing with any later versions held in
the database. Restructure Drawing is invoked from the Restructure > Blocks menu in
Planner.
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Selecting Redefine blocks from Disc will result in the DWG file specifying the title block
being update (providing it has first been selected). Using the Select by Block option and
selecting the title block will ensure that only the title block is updated.

Once the Title block has been redefined, the attributes it contains should be updated by
the Update Title Block option on the Insert Menu in Planner.

Editing Attributes
Editing Attributes once the title block has been placed in a drawing can be achieved by
double clicking on the frame of the Title Block. This will bring up the Enhanced Attribute
Editor.
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This allows any of the Attribute values to be edited.

Zone Types & Definitions

Purposes of Zones
Zones are ways of dividing up a store into areas of specific purpose.

Note: Zones are sometimes called Departments. This should
not be confused with Zone Types of Type 'Department'
which have a specific purpose in MSM.
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Once placed, Zones can be used for measuring, reporting and filtering purposes.

Measuring Area
Once placed, the area of the zone can be calculated. This can be:

1. Gross Area - the area of the zone without taking into account any obstructions

2. Net Area -The area of the zone after obstructions (such as pillars and staircases) are
taken into account

These areas can subsequently be used for calculation purposes - for example determining
the profit per square foot or meter.

Reporting
Once fixtures and merchandise are placed in a store plan, Zones can be used to get
reports on the performance of specific parts of the store. For example, it is possible to find
the sales turnover, sales margins, profitability, etc, for any zone.

If there is a hierarchy of zones present in the store, it is possible to get reports of differing
levels of detail. For example, it would be possible to get reports on the Clothing
department or just one of its sub-departments - say Children's Clothing.

Filtering
Zones can be used for filtering purposes - primarily in the Object Grid. It is possible to
associate either products or planograms with specific zones - when a zone is selected in
the Object Browser these products or planograms will appear in the Object Grid. These
are called Zone - Product or Zone - Planogram links and are controlled by means of
Custom SQL.

Overview of Zone Types and Zone Definitions
Zones have both a Zone Type and a Zone Definition.

Zone Types
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Zone Types is used to set broad properties that can be assigned to a specific Zone
Description.

1. Description is the name given to the group of properties

2. Layer is the AutoCAD layer the zone will be drawn on
3. Auto Text Type describes the Text Style to use (Planning Menu in the Admin

Module)

4. Type describes the category the Zone Type will be assigned to - either Internal Area,
Department Zone or Other Zone

Zone Definitions

Zone Definitions is used to create the Zone Hierarchy. This zone hierarchy will also
appear in the Zone Tab of the Object Browser in the Planner and Merchandiser Modules.
1. Name is the Name of the Zone

2. Description expands on the Name of the Zone

3. Zone Type puts the Zone into one of the classes described in the Zone Type dialog
box

4. Hatch Style selects a hatch style from those defined in the Hatch Styles option on the
Planning menu in the Administration Module

5. Color is the color the boundary of the zone (and any hatching) will be in the Planner
and Merchandiser Modules
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6. Code is any code that a customer might assign to a Zone Definition

Object Browser
Details of the Zone Definition will appear in the Properties Window of the Object
Browser in the both the Planner and Merchandiser Modules.

Criteria for Arranging Zone Types and Descriptions
Some broad criteria have to be obeyed when designing a zone hierarchy

Internal Area Zone
There should be an Internal Area zone in a store plan. This determines the maximum
area used for retailing purposes and is used in Area Calculations and assigning specific
parts of the floor to specific fixtures.

Zones Types of Type Department
Zones Type of Type Department have particular properties.

1. Fixtures are allocated to Zones of Type Department for calculation and reporting
purposes when placed in a store plan.

2. Because products are associated with specific fixtures, products are indirectly
associated with Zones Types of Type Department for reporting purposes when
placed in a store plan

3. Synchronize automatically maps fixtures to Zones of Zone Type 'Type' Department
as part of the synchronization process

This imposes a restriction when designing a zone hierarchy: Zones of Zone Types 'Type'
cannot overlap each other as this would cause problems with the underlying business
logic of the software.
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'Department' Type Zone Types
The minimum requirement for laying out a store plan with zones is Zone Descriptions of
Zone Type 'Type' department.

1. This is necessary for reporting purposes, for example associating Fixtures with zones

2. In-Store Space Collaboration requires Zones of Zone Type 'Type' department to be
present before a store plan can be opened.

In the above example, the user might place 'Staff Area' and 'Stock Storage' Department
Zones for the 'Back of Store' areas and 'Checkouts', 'Clothing', 'Concession Areas',
'Electrical', 'Entrance Areas and Aisles' and Food and Drink' for the retail areas.

Zones at other levels in the hierarchy can be placed to increase reporting flexibility, but
are not essential. For example, 'Computing', 'Household' and 'TV and Audio' child zones
(which are not of Zone Type 'Type' Department) could be placed as children of the
'Electrical' zone.

Planner (AutoCAD) Layers
Zones are drawn onto specified AutoCAD Layers in the Planner module. Different levels
in the zone hierarchy can be drawn onto different AutoCAD layers. Zones that are on a
specific AutoCAD layer can be detected as overlapping (clashing), whereas zones on
different levels are not detected as clashing.
Zones must be assigned to AutoCAD layers in such a way that zones that should not
clash are on the same layer. Similarly, where zones have children, the must be drawn on
different layers so that the child zones do not clash with the parent. For example the
'Clothing' zone should be drawn on one AutoCAD layer and its children (Children's
Clothing, Men's Clothing and Women's Clothing) drawn on another. This allows the
'Child' zones to be superimposed on the parent.
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Strategies for Zone Types and Descriptions
There are two broad strategies for creating a zone hierarchy.

1. Have only one level in the hierarchy of Zone Types 'Type' department

2. Have multiple levels in the hierarchy of Zone Types 'Type' department and only
place a Zone Description from one level in the hierarchy

Have only one level in the hierarchy of Zone Types 'Type' department

Here, the 'Department' type zones are represented by the blue folders ('Staff Areas' and
'Food and Drink''). These, (together with the Internal Area zone) are placed as a
minimum in the hierarchy, with other Zone Descriptions (of Zone Types Type 'Other')
added to give more options for reporting purposes.

For example, 'Computing', 'Household' and 'TV and Audio' child zones (which are not of
Zone Type 'Type' Department) could be placed as children of the 'Electrical' zone (which
is of Zone Type 'Type' Department).

This allows reports to be produced for either the 'Electrical' zone as a whole or the
'Computing', 'Household' and 'TV and Audio' child zones if a finer level of granularity is
required in the reporting.

Note: it is important to ensure that all zones of Zone Type
'Type' Department share the same AutoCAD layer. Clash
Detection can then be used to detect if zones are clashing
(overlapping). (More Info)
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Have multiple levels in the hierarchy of Zone Types 'Type' department and only place a
Zone Description from one level in the hierarchy

In this form most of the hierarchy is of Zone Types 'Type' department and the user opts
to place from one level of every branch in the hierarchy. For example, the user would
either place an 'Electrical' zone or the 'Computing', 'Household' and 'TV and Audio' child
zones. They could not place both the ‘Electrical’ zone and the 'Computing', 'Household'
and 'TV and Audio' child zones.

Here, reporting is by aggregating zones. The 'Computing', 'Household' and 'TV and
Audio' child zones can be reported on as individual zones. To get a result for the
'Electrical', the results from the 'Computing', 'Household' and 'TV and Audio' zones are
consolidated into a single report.

Note: it is important to ensure that all zones of Zone Type
'Type' Department share the same AutoCAD layer. Clash
Detection can then be used to detect if zones are clashing
(overlapping). (More Info)

Overview of Clash Detection
Clash Detection is used to identify where zones sharing the same AutoCAD layer are
overlapping. It can be invoked in one of two ways:

1. From the Configuration Module

2. From the Object Browser Toolbar

If zones overlap (clash) this may affect MSM functionality - particularly if they are Zone
Descriptions of Zone Types 'Type' Department.



Zone Types & Definitions

224 Oracle Retail Macro Space Management

From the Configuration Module
If the Detect Clashes option is checked, warnings will automatically be given when a
zone being placed overlaps a zone sharing the same AutoCAD layer.

From the Object Browser Toolbar
If the Detect Clashes button is clicked, this will cause the currently active store plan to be
checked for any overlapping (clashing) zones sharing the same AutoCAD layer.

Why Clash Detection is Needed
Fixtures are assigned to zones when they are placed in the drawing. This Zone - Fixture
link is used for calculation purposes. If a fixture is placed in two Zone Definitions of the
same Zone Type, MSM's internal functionality may not work correctly. In additions,
there will be errors in reporting.
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In the above example, fixtures have been paced in two overlapping Department Type
Zones. This means the fixtures may be allocated to the wrong zone for reporting
purposes. For example, it may have been intended to put the fixtures in the Food and
Drink zone, but they may have been assigned to the clothing zone. If Clash Detection is
On, then a warning dialog will appear, enabling the user to correct the clashing
(overlapping) zones.

How Clash Detection Works
Clash detection works as follows
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Create Layers in Planner
Zone Descriptions are drawn on specific layers in the AutoCAD drawing in the Planner
Module. Where necessary, these layers have to be created using the Layer Aliases option
from the Format menu in Planner.

Assign Layers to Zone Types
When Zone Types are being defined in the Admin Module, each Zone Type is mapped to
a specific layer created in Planner. For example 'Department' Type zones are mapped to
the 'Department' Layer; 'Sub-Department' Type zones are mapped to the 'Sub-
Department' Layer, etc.

Assign Zone Types to Zone Definitions
When each Zone Definition is created, it must be assigned to a Zone Type. Each Zone
Definition will therefore be mapped (indirectly) to a specific layer in Planner.

Draw Zone Definitions in Planner
When the Zone Definitions are drawn in Planner, they will be drawn on specified layers.
The locations of the edges of the Zone Definition will be accurately known.

Clash Detection
After the Zone Definition is drawn, when Clash Detection is selected, the
software will examine all Zone Definitions drawn on the same Planner Layer. If
the boundaries of any Zone Definitions are shown to be overlapping (clashing) a
warning will be generated.
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Consequences of Clashing
Because Zone Descriptions that overlap (clash) can cause problems with the operation of
the software (and with reporting accuracy) any clashes should be corrected.

Zones and Hatch Styles
Zones Definitions can be assigned Hatch Styles. The Hatch Styles are specified in the
Hatch Styles option on the Planning Menu of the Administration Module.

These Hatch Styles are pre-loaded into AutoCAD, but have to be defined for the
Merchandiser Module.

Zone Technicalities

Building Up Zones

Internal Area Zone
The Internal Area zone is used to specify the maximum area available for retail purposes.
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In the example above, it is confined to the boundaries of the store. Equally, it could be
confined to the area accessible to customers, or include areas outside of the store - for
example those used to display and sell garden plants.

The Internal Area Zone is also used to set the boundary for Area Calculations.

Sales Area and Non Sales Area Zones
Sales Area and Non Sales Area Zones can be used to divide the store into areas used for
sales activities (i.e. accessible to the public) and areas used for support functions - offices,
stockrooms, etc.

In the example above the stockrooms and staff areas can be differentiated from the parts
of the store used for selling to customers.
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Departments
Departments are used to divide the store into areas of more closely defined purpose.

In the above example the store has now been divided into areas of specific use. For
example, the area to be used for sale of clothing is designated by the red rectangle.

Sub-Departments
It is possible to continue dividing the store into ever finer divisions, for example the
Clothing department could have Children's Clothing, Women's Clothing and Men's
Clothing Sub departments.

Note: if Zone Definitions are 'layered' on top of each other
like this, each 'layer' must be of a different Zone Type (and
hence drawn on a different AutoCAD Layer). (More Info)

Fixtures and Zone - Fixture Links
Fixtures can be linked to Zones using Zone - Fixture Links. Zone - Fixture links are
stored in two places within the database.

1. AVTTB_FIXTURE Table

2. AVTTB_ZONE_FIXTURE_LINK Table

Each of these tables is used for a different purpose.

AVTTB_FIXTURE Table
The AVTTB_FIXTURE table contains a ZON_ID (Zone ID) field. This holds the foreign
key for the Department level zone that the fixture has been placed in. Each fixture can
only be associated with a single Department level zone - which is why care must be taken
that Department level zones do not clash (overlap).
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It is important to note that the ZON_ID is read from the AVTTB_ZONE table.

Note: The Zone Description may vary from that held in the
AVTTB_ZONE_DEFINITION table as it is editable by the
user when placing the zone.

Where a Fixture straddles a Department zone boundary, it will be allocated to the zone in
which the majority of the fixture is.

In the above example, the insertion point of the fixture is in the left hand zone, but the
bulk of the fixture is in the right hand zone. It will be allocated to the right hand zone.
The information in the AVTTB_FIXTURE table is most accurate for reporting purposes as
each fixture should only be associated with a single 'Department' type zone. This ensures
that:

1. Equipment take-offs do not show fixtures in multiple zones, resulting in inaccurate
orders for equipment when building or refurbishing stores

2. Merchandise is not reported in multiple zones, avoiding inaccurate orders for
products when stocking stores

AVTTB_ZONE_FIXTURE_LINK Table
The AVTTB_ZONE_FIXTURE_LINK Table can associate fixtures with multiple zones. It
contains ZON_ID's (Zone ID) fields - there are also read from the AVTTB_ZONE Table.
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These are the foreign keys for each zone that the fixture has been placed in. An example
of this would be if the "Clothing" department level zone contained a sub-department
called "Children's Clothing". A fixture would then be associated with both the Clothing
and Children's Clothing zones.

It is important to note that the ZON_ID is read from the AVTTB_ZONE table.

Note: The Zone Description may vary from that held in the
AVTTB_ZONE_DEFINITION table as it is editable by the
user when placing the zone.

The ZFL_CROSSING field in the AVTTB_ZONE_FIXTURE_LINK table should be noted.
A value of -1 indicates that a fixture crosses zone boundaries.

This can mean that the same fixture (FIX_ID) is shown in multiple zones.

Care needs to be taken during reporting to ensure the fixture is not duplicated in reports.
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Zone - Fixture Links and Custom SQL
The exact nature of the reports generated from Zone - Fixture Links will depend on the
Custom SQL used to generate the reports. Macro Space Management comes with some
standard reports. Anyone with a good knowledge of SQL can produce their own
customized reports - often in conjunction with other Oracle software such as BI
Publisher.

Overview of Zone - Product and Zone - Planogram Links
Zone - Product Links and Zone - Planogram Links provide a way of filtering products
or planograms by the Zone they are associated with. For a given implementation of
Macro Space Management either zone - Product Links or Zone - Planogram Links can be
used: it is not possible to operate both.

Zone - Product Links
Zone - Product links operate by linking nodes in the Product Hierarchy to specific Zones.
Clicking on that zone in the Zones tab of the Object Browser will cause all products that
are children of the linked node in the Product Hierarchy to display in the Object Browser.

Products are arranged in a Product Hierarchy. (This can be viewed and modified in
Product Studio). It is possible to link specific zones to nodes in the product hierarchy.
This is done by inserting a foreign key (PRD_ID) into the AVTTB_ZONE_DEFINITION
table. This foreign key then links the Zone Definition (AVTTB_ZONE_DEFINITION) and
Product Definition (AVTTB_PRODUCT_DEF) tables. This link enables products to be
filtered by zone.
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In the above example, Department level zones have been linked to the equivalent nodes
in the products hierarchy and similarly Sub-department zones have been linked to nodes
at Department level.

This means that (for example) if the Children's Clothing zone is selected in the Object
Browser, the Zone - Product link will result in products displaying in the Object Grid that
are associated with (or children of) the Children's Clothing node in the product
hierarchy.

Zone - Planogram Links
All planograms are arranged in a Planogram Hierarchy. Planograms are also linked to a
specific node in the Product hierarchy. This node is the node in the product hierarchy
that is the lowest common link between all the products in the planogram. Specific nodes
in the Product Hierarchy are then linked to specific Zones. Clicking on that zone in the
Zones tab of the Object Browser will cause all Planograms that contain products that are
children of the node in the Product Hierarchy to display in the Object Browser.
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Planograms are linked to the product hierarchy by means of the Product ID's (PRD_ID's)
of the products in the planogram. The planogram will automatically be linked to the
node in the product hierarchy that is the lowest common link between all the products in
the planogram.

For example, Planogram 1 contains trousers, shorts and socks. The lowest common link
between these products is the node above them in the product hierarchy - "Men's
Clothing". Planogram 1 will therefore be assigned the Product ID of that node (PRD_ID =
11 in this example). Planogram 2 only contains trousers, so can be linked to a node
further down in the hierarchy: the "Trousers" node (PRD_ID = 22 in this example).

In the extract from the AVTTB_PLANO table below, each planogram has automatically
been assigned a Product _ID (PRD_ID) that corresponds to the node in the product
hierarchy that is the lowest common link between all the products in the planogram.

By using this Product _ID (PRD_ID) in the AVTTB_PLANO table, it is possible to find all
planograms containing products associated with a specific zone. This is done by inserting
a foreign key (PRD_ID) into the AVTTB_ZONE_DEFINITION table. This foreign key
then links the Zone Definition (AVTTB_ZONE_DEFINITION) and Product Definition
(AVTTB_PRODUCT_DEF) tables. This link enables planograms (containing specific
products) to be filtered by zone.
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The Internal Area Zone
The Internal Area Zone is used to define the maximum area used for retail purposes. It
may be confined to the bounds of the store walls (as in the example below), or it may
encompass areas outside - for example a space used for selling plants for the garden.

Once the Internal Area Zone has been placed, it is then used to set maximum limits for
area calculations.
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Individual retail organizations decide what to encompass in the Internal Area zone: some
include non sales areas (like stock rooms and staff canteens, some do not. The area
encompassed within the Internal Area will impact on reporting: an internal area that did
not include non-sales areas would show a different 'profit per square meter' value than
one that did.

Note: if a hole is cut in the internal area zone, the space
within the hole will not be included in area calculations, but
area calculations will resume the other side of the hole.

Cutting Holes in Zones
Cutting Holes in Zones is used to allow for the effects of obstructions, etc. In the simple
example below, a zone contains some gondola runs and a staircase. The staircase reduces
the area available in the zone for retailing purchases. The 'Cut Holes' option allows the
user to remove the area used for the staircase from the total area of the zone for
calculation purposes.
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The zone might therefore have a gross area of 3,600 square feet and a net area of 3,200
square feet. Using the net area of the zone (i.e. taking into account the area enclosed by
the hole) allows profit per square meter to be calculated more realistically.

Aliased Layers
Aliased Layers are a way for the functionality in the Planner Module of Macro Space
Management to communicate with that in AutoCAD.

AutoCAD Layers are information held within AutoCAD drawings. This cannot be
directly written to the database, so an Alias for the Layer is provided within the database.
This enables users to assign (Aliased) Layers to objects within MSM. For example a
Fixture might be assigned to the 'Fixtures' Layer within Fixture Studio.

When the time comes to insert a copy of that fixture into the drawing, the software
identifies which Aliased Layer the Fixture has been assigned to, identified which
AutoCAD Layer that has been mapped to and (via a connection in the code) causes the
object to be drawn on the correct AutoCAD layer. If the AutoCAD layers does not yet
exist in the drawing (for example, if it is the first time a fixture has been added to the
drawing) then the software will automatically create the required AutoCAD layer at the
same time as it inserts the Fixture into the drawing.

Mapping between Layers and Layer Aliases is done in the Planner Module using the
Layers and Aliases dialog box (called from the Format menu).
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The Alias Name is the name of the Layer held in the MSM database and the Layer is the
name of the layer in the AutoCAD (Planner) drawing.

Zone Types

Overview of Zone Types
Zone Types are a way of assigning broad properties to specific Zone Descriptions.

Zone Types is used to set broad properties that can be assigned to a specific Zone
Description.

1. Description is the name given to the group of properties

2. Layer is the AutoCAD layer the zone will be drawn on

3. Auto Text Type is not currently in use

4. Type describes the category the Zone Type will be assigned to - either Internal Area,
Department Zone or Other Zone

Description
The Description will appear in the Zone Type option for the Zone Definition.
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Layer
The Layer is the AutoCAD layer the Zone Type will be drawn on. These are configured
using the Layers and Aliases dialog box accessible from the Format menu in the Planner
Module.

Only Zone Descriptions drawn on the same layer will be detected as clashing. So, all
Zone Descriptions of Zone Type Department should be drawn on the Departments Layer
so any overlaps (clashes) for that Zone Type can be detected. Similarly, all Zone
Descriptions of Zone Type Sub-Department should be drawn on the Sub-Departments
Layer so any overlaps (clashes) for that Zone Type can be detected.

However, if a Zone Description of Type Sub-Department is drawn overlapping a Zone
Description of Type Department, it will be drawn on a different layer and will not be
shown as clashing.

This ability to detect clashes between Zone Descriptions of the same Zone Type but not
between Zone Descriptions of a different Zone Type is important when setting up a Zone
Hierarchy. For example, the Internal Area encompasses the entire area used for retail
purposes. The majority of other zones will probably be drawn within the Internal Area
Zone, so it is important that they are not shown as clashing - arranged by ensuring the
Internal Area Zone occupies it's own specific layer.
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Auto Text Type
The Auto Text Type option in the Zone Types dialog box currently has no effect.

However, the text that annotates a Zone will depend on the Custom SQL associated with
Zones in the Text Styles option on the Planning Menu in the Administration Module.

The Text Style invoked will depend on the setting in the Auto Field (Internal Area,
Department Zone or Other Zone), and any filters that might be present in the Custom
SQL statement associated with the Text Style.

Type
There are three categories the Zone Type can be assigned to - Internal Area, Department
Zone or Other Zone.

1. Internal Area is used to for the single zone that defines an area used for retail
purposes. The Internal Area zone is used for Area Calculation purposes

2. Department Zones can be used for reporting purposes - they give the most accurate
reports

3. Other zones are assigned to all Zones Types not 'Internal Area' or 'Department'

These types are hard coded into the software and cannot be changed

Changes made to Zone Types and Zone Definitions
Changes made to Zone Types in the Administration Module do not take immediate effect
as far as Zone Descriptions are concerned.
They are only read when the Admin Module is restarted - this must be allowed for when
configuring Zone Descriptions.

Planning Zone Types
Before creating a zone hierarchy, it is necessary to plan the Zone Types.

1. Decide on the Strategy for the Zone Hierarchy

2. Decide on the Number of Levels in the Zone Hierarchy

3. Decide on the Layer Aliases required

4. Decide on the Text Styles Required

5. Decide on the Zone Descriptions required and how they will map to Zone Type
'Types'
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Decide on the Strategy for the Zone Hierarchy
There are two broad strategies for creating a zone hierarchy (more info).

1. Have only one level in the hierarchy of Zone Types 'Type' Department

2. Have multiple levels in the hierarchy of Zone Types 'Type' Department and only
place a Zone Description from one level in the hierarchy

Which is to be used has to be decided at the outset as it will affect all other decisions on
setting up the Zone Hierarchy.

Decide on the Number of Levels in the Zone Hierarchy
The number of levels in the hierarchy must be determined. More levels will lead to more
flexibility in reporting, but may increase the difficulty in generating accurate reports. The
hierarchy could consist of just two levels - for example Internal Area and Departments.
Alternatively, it could consist of multiple levels - for example Internal Area, Areas,
Departments and Sub-Departments.

Not all these zones would necessarily be placed in a drawing: for example the 'Areas'
level in the hierarchy could simply be used to

Decide on the Layer Aliases Required
Macro Space Management provides functionality called Clash Detection to determine
whether Zones in a store plan are overlapping (clashing). Only Zones on the same
AutoCAD Layer can detected as clashing.

1. Zones that should not clash (overlap) should be placed on the same Layer

2. Zones that are intentionally superimposed on each other need to be placed on
different layers - for example the 'Clothing'' zone would need to go on one layer and
its children (Children's Clothing, Men's Clothing and Women's Clothing) on another
Layer

How many Layer Aliases are required will depend on the whether the user has chosen to
have only one level in the hierarchy of Zone Types 'Type' Department or to have multiple
levels in the hierarchy of Zone Types 'Type' Department and only place a Zone
Description from one level in the hierarchy.

The minimum number of Layer Aliases required is two: one for the Internal Area Zone
and one for Departments. A more complex hierarchy that places at several levels might
require multiple Aliased Layers: in the example below, Internal Area, Areas,
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Departments and Sub-Department Layers have been set up to allow a four level
hierarchy to be placed.

Decide on the Text Styles Required
Each Zone Type can have a Text Style associated with it. This Text Style determines the
form of the Annotation that will be drawn when the zone is placed.

Note: Text Styles are configured by selecting the Text Styles
option from the Planning menu in the Admin Module.

Adding, Editing and Deleting Zone Types
Zone Types can be accessed from the Edit Menu in the Administration Module.

This will bring up the Zone Types dialog box.

Options can be selected from the Edit pull down menu.
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Alternatively, they can be selected from the toolbar.

Exit

Add Zone
Type
Edit Zone
Type
Delete Zone
Type
Refresh from
Database

Adding Zone Types
When Add Zone is selected from the options on the pull down menu or toolbar, the Add
Zone Type dialogue box appears.

The Description can be typed in and should be appropriate to the Zone Type being
created.

The Auto Text Type can be selected from a drop down list and specifies the Text Style to
be used for annotation on the drawing.

The Layer Type is also selected from a drop down list.
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This determines which Layer the Zone will be placed on.

Note: Clashes can only be detected between Zones on the
same layer alias. (Layer Type in the above dialogue box).
The Type can also be selected from a drop down list.

The type refers to one of three possible classes the Zone Type can be assigned to.

Editing Zone Types
When Edit Zone is selected from the options on the pull down menu or toolbar, the Edit
Zone Type dialogue box appears.

The Description can be edited and should remain appropriate to the Zone Type being
created.

The AutoText Type can be edited from a drop down list and specifies the list of what is to
be annotated on the drawing.

The Layer Type is also edited from a drop down list.

This determines which Layer the Zone will be placed on.
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Note: Clashes can only be detected between Zones on the
same layer alias. (Layer Type in the above dialogue box).

The Type can also be edited from a drop down list.

Deleting Zone Types
Zone Types can be Deleted by highlighting them, then selecting the Delete Zone type
option from the drop down list on the menu bar, or using the appropriate icon on the
toolbar.

Delete Zone
Type

Note: Zone Types cannot be deleted if there is a Zone
Definition associated with it – the associated Zone
Definitions must be deleted or assigned to another category
first.

The Internal Zone and Department Zone Types cannot be
deleted – only other user defined Types within the Zone
Type definition can be deleted.

Zone Types cannot be deleted if there is a Zone Definition
associated with it – the associated Zone Definitions must be
deleted or assigned to another category first.

Zone Text
Zone Text is controlled by the Text Styles Option on the Planning Menu in the
Administration module.
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It provides three default text styles for Zones: Internal Area, Department Zone and Zone
- these correspond to the three Default Zone Types. The number of available Text Styles
may be increased by modifying the Custom SQL used to specify how the annotation is
carried out.

Zone Definition

Accessing Zone Definition Options
Zone Definitions can be accessed from the Edit Menu in the Administration Module.

Note: changes made to Zone Definitions in the
Configuration Module only take effect the next time the
Planner Module is restarted.

The Zone Definitions Window
The Zone Definitions Window allows Zone Definitions to be Added, Edited and
Deleted.
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Options can be selected from the Edit pull down menu.

Alternatively, they can be selected from the toolbar.

Exit

Add Zone Definition

Edit Zone Definition

Delete Zone
Definition

Refresh View

View Zone Types

View Hatch Types

Adding Zone Definitions
When Add Definition is selected from the options on the pull down menu or toolbar, the
Add Zone Type dialogue box appears.
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The Name and Description can be edited and should be appropriate to the Zone
Definition being created.

The Zone Type can be edited from a drop down list

As well as the predefined types shown in the example above, the list will also include
any user defined types.

The Hatch Style can also be edited from a drop down list.

This will determine how the Zones appear when colored on the drawing of the floor
plan.

The Zone Color can be edited from a pallet.
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It is suggested that Zone colors are selected using a logical scheme; for example clothing
in shades of red, electrical goods in shades of blue.

The Zone Description Icon can also be edited from a drop down list.

Finally an edited user defined Code can be typed into the Code window.

Editing Zone Definitions
When Edit Definition is selected from the options on the pull down menu or toolbar, the
Edit Zone Definition dialogue box appears.
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The Name and Description can be changed and should be appropriate to the Zone
Definition being edited.

The Zone Type can be selected from a drop down list

As well as the predefined types shown in the example above, the list will also include
any user defined types.

The Hatch Style can also be selected from a drop down list.

This will determine how the Zones appear when colored on the drawing of the floor
plan.

The Zone Color can be selected from a pallet.
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It is suggested that Zone colors are selected using a logical scheme; for example clothing
in shades of red, electrical goods in shades of blue.

The Zone Definition Icon can also be selected from a drop down list.

Finally a user defined Code can be typed into the Code window.

Deleting Zone Definitions
Zone Definitions can be Deleted by highlighting them, then selecting the Delete Zone
Definition option from the drop down list on the menu bar, or using the appropriate icon
on the toolbar.

Delete Zone
Definition
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A confirmation dialogue box will appear.

Click on Yes to confirm deletion.

View Zone Types and View Hatch Types
View Zone Type and View Hatch Types can be activated using the buttons in the Zone
Description toolbar.

View Zone Types

View Hatch Types

Clicking on either button will bring up the appropriate window

Note: If the Zone Description window is maximized, the
View Zone Type and View Hatch Types windows will tend
to appear behind the Zone Description window. It will have
to be minimized before the new windows can be seen.
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4
Admin Merchandising

Adjacency Rules

Overview of Adjacency Rules
Adjacency Rules can be used to set up a series of guidelines about which products
should be in proximity to one another, and which should not be. For example, it would
not be good placement to put bleach next to meat or vegetables. However, more pasta
sauce will be sold if is placed next to pasta.

Note: Rules are configured in the Severity Types Option
from the same menu.

These Adjacency Rules can then be used (in conjunction with other MSM database tables)
to produce reports on whether products are well or badly placed. These reports (often in
the form of Quick Reports or KPI's) can then be used to improve the layout of
merchandise in a store plan - and hence the profitability of the store.

Severity Types
The Severity Types (rules) for the Adjacency Rules are set up using the Severity Types
option from the Merchandising menu of the Admin Module.
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Note: User can only alter the text and color for the Severity
types via the dialog box. Altering the number of available
Severity Types can only be done in the
AVTTB_ADJACENCY_SEVERITY_TYPE table.

Setting Up Adjacency Rules
To Set Up an Adjacency Rule, click on the Add Button.

This will bring up the Product Adjacency Rule dialogue box.
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To add a Product Adjacency Rule:

1. Type in a Rule Description

2. Select Product 1 (clicking on the button will bring up the Select Products dialogue
box)

3. Select Product 2 (clicking on the button will bring up the Select Products dialogue
box)

4. Select the Severity Type

The Select Product dialogue box allows users to manually select the required products.
Alternatively, the find button can be used to locate successive instances of the search
string in the product hierarchy.

Users can select from products at Department, Class (Category) or Sub-Class (Sub-
Category) level in the Product Hierarchy. These levels in the hierarchy should not be
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subject to frequent change, so a set of Adjacency Rules should only require updating at
irregular intervals. (More Info).

Keeping Adjacency Rules Updated
Adjacency rules are set up at Department, Class (Category) or Sub-Class (Sub-Category)
level in the Product Hierarchy.

Products are generally subject to regular change at Style, Item and SKU levels in the
Product Hierarchy. Department, Class (Category) or Sub-Class (Sub-Category) levels do
not change very often, so once Adjacency Rules are set up, they should remain valid for
extended periods of time.

It would be possible to produce periodic reports that identify:
1. Deleted Department, Class (Category) or Sub-Class (Sub-Category) items in the

Product Hierarchy that are no longer needed in the Adjacency Rules.

2. Newly added Department, Class (Category) or Sub-Class (Sub-Category) items in the
Product Hierarchy that may need adding to the Adjacency Rules.

Editing and Deleting Adjacency Rules
Editing and Deleting Adjacency Rules can be carried out by using the appropriate
buttons from the toolbar.
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Editing Rules
Editing rules only allows the user to change the Severity Type.

In order to change the products in an existing rule, it is necessary to delete the rule and
create a new one.

Deleting Rules
To delete a rule, highlight it, and then click the Delete icon. The rule will be deleted
without further confirmation.

Using Adjacency Rules
After the Adjacency Rules have been set up, it is necessary to set up an output for them
so that users can see how products in a specific drawing match the specified Adjacency
Rules. The results can be based on either:

1. Product Adjacencies



Adjacency Rules

258 Oracle Retail Macro Space Management

2. Aisle Adjacencies

Note: it is also possible to base the results on distances (More
Info).

Product Adjacencies
Product Adjacencies (AVTTB_PRODUCT_ADJACENCY table) can be used to look at the
relationship of products on the same fixture and on the fixtures to the immediate left and
right.

Aisle Adjacencies
Aisle Adjacencies (AVTTB_AISLE_ADJACENCY table) can be used to look at the
relationship of products sharing an Aisle.

Note: An Aisle is a MSM object. It is a line drawn in a store
plan in the Planner module that is used to represent one (or
more) real life aisles. Fixtures within a specific distance of
that line are regarded as belonging to the MSM Aisle. As
products are linked to fixtures in the AVTTB_PRODUCT
table, it is then possible to determine what products belong
to that MSM Aisle.

SQL
Generally, in order to make use of the Adjacency Rules, it is necessary to use SQL
statements to link information from tables in the MSM database into an output that
shows the results of the Adjacency rules.

Tables
For information on which tables to reference when using SQL to generate an output from
the Adjacency Rules, please see the Macro Space Management data model. This is
available to registered MSM users on application to Oracle.

Quick Reports
Quick Reports are available in both the Planner and Merchandiser Modules. It would be
able to produce a Quick Report that shows all the products in a drawing and the results
of any Adjacency Rule calculations.

Note: The SQL that populates the Quick Reports is stored in
the AVTTB_CUSTOM_SQL table.
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KPIs (Key Performance Indicators)
KPIs (Key Performance Indicators) are available in both the Planner and Merchandiser
Modules. It would be able to produce KPI's that show all the products in a drawing and
the results of any Adjacency Rule calculations.

Reports
It is possible to use Oracle tools such as BI Publisher to produce tabulated reports on the
results of adjacency calculations within a drawing. Contact Oracle Technical Support for
further information on Oracle applications suitable for producing reports on Adjacency
Rules.

Distances in Adjacency Rule Output
It is possible to use distances in the results from Adjacency Rules

AVTTB_PRODUCT_ADJACENCY_RULE Table
The Adjacency Rule table (AVTTB_PRODUCT_ADJACENCY_RULE) has a
PAR_DISTANCE Field.
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This field cannot currently be accessed via the Adjacency Rule dialog box in the Admin
module, but can be used to set a distance for each Adjacency Rule.

AVTTB_AISLE_ADJACENCY Table
The Aisle Adjacency table (AVTTB_AISLE_ADJACENCY) has
AIL_DISTANCE_FROM_START and AIL_DISTANCE_FROM_AISLE fields

These fields could be used to calculate the relative distances of fixtures (and hence
products) along the Aisle

Note: An Aisle is a MSM object. It is a line drawn in a store
plan in the Planner module that is used to represent one (or
more) real life aisles. Fixtures within a specific distance of
that line are regarded as belonging to the MSM Aisle. As
products are linked to fixtures in the AVTTB_PRODUCT
table, it is then possible to determine what products belong
to that MSM Aisle.

AVTTB_PRODUCT ADJACENCY Table
The Product Adjacency table (AVTTB_PRODUCT_ADJACENCY) contains
PAJ_LENGTH_LEFT and PAJ_LENGTH_RIGHT fields that show the distance of
products to the left and right of the current field.
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AVTTB_FIXTURE Table
The fixture table (AVTTB_FIXTURE) contains information on the X and Y coordinates
(FIX_XPOS and FIX_YPOS) of a fixture within a store plan.
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Products are associated with their parent fixtures in the AVTTB_PRODUCT table. Using
the X and Y coordinates (FIX_XPOS and FIX_YPOS) of fixtures would enable Adjacency
Rules to work on distances between products. This provides an alternative to using the
AVTTB_AISLE_ADJACENCY and AVTTB_PRODUCT_ADJACENCY tables.

Severity Types

About Severity Types
Severity Types are used in conjunction with Adjacency Rules. They enable users to
describe the form of the relationship between two products in the Adjacency Rules.
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There are five default severity types: These range from badly placed to well placed.

For example, a Product Adjacency Rule might state that bleach cannot be displayed
within 5 meters of fresh meat. If this was infringed a warning might appear in the
Product Adjacency Report flagging up that this rule had been infringed: ERROR: Layout
groups far too close.

Similarly, a Product Adjacency Rule might state that pasta sauces have to be displayed
within 2 meters of pasta. If this was achieved during merchandising, then the Product
Adjacency Report might flag up: EXCELLENT: Layout groups well placed.

Editing Severity Types
To edit a Severity Type, click on it to highlight it. Next, select the Edit option in the Edit
pull down menu or click on the Edit icon.

This will bring up the Severity Types editing dialogue.
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The description and color can be customized to user requirements.

Click OK to confirm and return to the Severity Types window.

Modifying the Severity Type List
There are five default Severity Types supplied with Macro Space Management.

It is possible to increase or decrease the number of Severity Types, but this must be done
directly in the database. This is done by changing the entries in the
AVTTB_ADJACENCY_SEVERITY_TYPE table.

All three fields are mandatory, with the AST_ID field being the primary key. This table is
only referenced by SQL and not by the code, so changes to the table will not affect the
operation of the Planner and Merchandiser Modules.
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Category Rules

Overview of Category Roles
The Category Roles dialog box is accessed from the Merchandising menu of the
Administration module.

Category Roles are used to assign what the retailer believes is the reason customers
purchase specific products. In the above example, a retailer has six customer roles it can
assign to products:

 Destination - special offers designed to attract customers to the store.

 Routine - regular merchandise purchased as a matter of routine - for example
washing up liquid or other cleaning products

 Convenience - items like ready to microwave meals that a customer might buy to
save time.

 Seasonal - merchandise that is only on sale at specific times of the year - an example
might be Easter Eggs.

 Flagship - products that customers will buy because they are high status - an
example would be the latest electronic equipment.

 Cash Machine - generally low margin, high turnover products that generate high
cash flows.

Although Strategies can be assigned manually to products in Product Studio, it is more
likely that they will be imported. Accordingly, the Category Roles entered in the
Administration module should be similar to any that exist in the third party software
used to maintain product information at a retail chain.
Strategies can be assigned to products at SKU level in the Product hierarchy.
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Category Roles Menus and Toolbar
The File Menu allows users to add new Category Roles, save the changes and exit the
dialog box.

The Edit Menu allows users to cut copy and paste information, and to delete Category
Roles.

The Help Menu allows users to call this Help File.
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The following options are available on the toolbar:

Icon Option

Add a new Category Role

Save the contents of the
dialog box

Cut

Copy

Paste

Delete

Move up in List

Move Down in List

Help

Using the Category Roles Dialog Box
The Category Roles dialog box can be used to Add, Edit and Delete Category Roles from
the list of those available for use within at SKU level product hierarchy.

Adding a Category Role
Adding a Category Role can be done by clicking the Add button on the toolbar (or the
File menu) to create a new line in the list of Strategies.

Once the line has been created, data can be entered by typing it in, or by using the copy
and paste options on the toolbar.

Editing a Category Role
Category Roles can be edited by typing the required changes in, or by using the copy and
paste options on the toolbar (or the edit menu).
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Deleting a Category Role
Deleting one or more Category Roles can be achieved by highlighting the ones it is
desired to delete in the list of Category Roles and clicking the Delete option on the
toolbar (or the edit menu).

Promoting or Deleting Category Roles in the List of Category Roles
Category Roles can be promoted or deleted in the sequence Category roles are displayed
in by using the Up and down icons in the toolbar.

This will affect how the drop down lists display in the dialog box used to set Category
roles in Product Studio.

Saving Changes
Changes can be saved by clicking the Save icon on the toolbar (or the file menu).

If users attempt to exit the dialog box without saving changes, they will be prompted as
to whether they wish to do so.

Planogram Financial Weighting

Planogram Financial Weighting
The Financial Weighting Dialog Box is used to assign a ranking score to planograms. This
enables users to weigh the relative merits of alternative planograms when defining a
planogram substitution in the Planogram Substitution Assistant.
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The process works as follows:

1. When a planogram definition is imported, the imported information will include
financial data. (Imported into the AVTTB_PLANO_FINANCE table).

2. Financial Weightings are set in the Administration module using the Planogram
Financial Weighting dialog box.

3. When planogram substitutions are being defined, the ranking scores (calculated from
the imported financial data and the financial weightings) are displayed in the
Planogram Substitution Assistant.

The Financial Weighting Settings are universal - once set in the Administration module,
they apply to all planograms until the settings are changed. The new settings will then be
applied universally.

It is therefore important to develop a single, agreed set of financial weightings for
planogram substitution creators to use.

Importing Information for Planogram Financial Weighting
As part of the implementation process, arrangements have to be made to import
planogram design information into the database. There, financial data will be stored in
AVTTB_PLANO_FINANCE table. Financial information can be brought in for new
planogram designs and refreshed for existing ones.

This information can then be used in conjunction with the financial weighting
information to assign a ranking score to each planograms. This ranking score is displayed
in the New Planograms page of the Planogram Substitution Assistant as an aid to
planogram selection.

Planogram Financial Weighting Dialog Box
The Planogram Financial Weighting dialog box is accessed from the Merchandising
menu in the Administration Module.
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It holds five items of data that can be used to assign a ranking score:

1. Forecast Sales
2. Gross Margin

3. Movement

4. Profit

5. Sales

The precise nature of the data for each of these items may depend on the software
package used to produce the planogram design.

Menus and Toolbars
Menu Options

Menu Option Shortcut Key

File Save Ctrl + S

Exit Alt + F4

Edit Reset Multiplier

Clear Size Divider

The other menu options are:
 Save

 Weight by Length

 Weight by Area

 Weight by Volume

 Clear Size Weightings

 Increase Multiplier by 1
 Decrease Multiplier by 1

 Reset Multiplier by 0.

 Help

Financial Weighting Calculation
The following data can be used in the weighting calculations: Forecast Sales, Gross
Margin, Movement, Profit, Sales.
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This data is imported as part of the planogram definition. It will not be updated unless it
is done via a data import, or a new revision of the planogram is imported.

The Size Divider
The Size Divider allows users to take into account the physical size of the planogram
when calculating a ranking.

 If no Size Divider is set, the data will be the 'raw' data for the planogram.

 If the Length Size Divider is set, the data will be the raw data for the planogram,
divided by the length of the planogram.

 If the Area Size Divider is set, the data will be the raw data for the planogram,
divided by the floor area (length x depth) of the planogram.

 If the Volume Size Divider is set, the data will be the raw data for the planogram,
divided by the volume (length x depth x height) of the planogram

The Multiplier
The multiplier is a scaling factor to use to weight the 'raw' data in the calculation.

 Multipliers can only be zero or positive integer values.

 If set to 0, that particular factor will not be used in the calculation
 If set to 1, the 'raw' data for that particular factor will be used in the calculation.

 If set to values greater than 1, the raw data will be scaled accordingly.

The Calculation
The planogram weighting is based on the sum of the scaled factors.

Item Value Multiplier Size Divider Result

Forecast Sales 10,000 1 Ft 10,000

Gross Margin 3,000 0

Movement 3,000 0

Profit 5,000 3 15,000

Sales 7,000 0

Total: 25,000

The resulting ranking of 25,000 provides a basis to compare this planogram with other
planograms with ranking calculated using exactly the same formula.

Planogram Import Styles

Overview of Planogram Import Styles
Planogram Import Styles are used when planogram designs are imported.
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The purpose is to map the fixture and shelf styles used by a third party planograming
tool to the fixture and shelf styles used by Macro Space Management. This means MSM
can use the style relationships from the third party planograming tool to validate the
placement of the shelf objects when they are placed onto the parent fixtures.

The functionality also has the ability to specify a default block for each MSM style. When
fixture and shelf object information is imported from the third party planograming tool,
the import tool will try and match the imported fixture or shelf object with their
equivalent in the MSM database. If no match can be made, the specified default block
will be used (stretched to the dimensions required by the planogram design.
The dialog box allows users to specify the codes used by up to four third party
planograming tools. This enables a Macro Space Management user to import planogram
designs from up to four third party planograming tools.

Planogram Import style Menus and Toolbar
The File Menu allows users to configure a new import style, save the contents of the
dialog box and exit the dialog box.

The Edit Menu allows users to cut, copy and paste information. They can also delete
single or multiple planogram import style definitions.
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The Tools Menu allows users so select the names for the third party planogram design
software data is being imported from.

The Help Menu calls this help file.

The following options are available on the toolbar:

Icon Option
Add a new Import
Style
Save the contents of
the dialog box
Cut

Copy

Paste

Delete

Help

Configuring Sources of Planogram Imports
The sources of planogram imports can be configured using the Options dialog box
selected from the Tools menu.
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This will bring up the Options dialog box.

This enables users to select up to four sources of planogram imports from the drop down
lists.

Using the Planogram Import Style Dialog Box
The Strategies dialog box can be used to Add, Edit and Delete strategies from the list of
those available for use within the product hierarchy.

Adding a Planogram Import Style
Adding a Planogram Import Style can be done by clicking the Add button on the toolbar
(or the File menu) to create a new line in the list of Strategies.

Once the line has been created, data can be entered by typing it in, or by using the copy
and paste options on the toolbar.
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Editing a Planogram Import Style
Planogram Import Styles can be edited by typing the required changes in, or by using the
copy and paste options on the toolbar (or the edit menu).

Deleting a Planogram Import Style
Deleting one or more Planogram Import Styles can be achieved by highlighting
the Planogram Import Styles it is desired to delete in the list of Planogram Import Styles
and clicking the Delete option on the toolbar (or the edit menu).

Saving Changes
Changes can be saved by clicking the Save icon on the toolbar (or the file menu).

If users attempt to exit the dialog box without saving changes, they will be prompted as
to whether they wish to do so.

Planogram Substitution

Planogram Substitution

Introduction to Planogram
Substitution

Overview of the planogram substitution functionality

Planogram Substitution
Technicalities

Technical information concerning Planogram Substitutions

User Privileges and Logging in How to configure access and log in

Planogram Substitution dialog
box

About the opening dialog box for planogram substitution
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Index
to
Planog
ram
Substit
ution
Links
within
this
page
will take
users to

the selected part of the Help File.

Note: It is also possible to find information via the Index or
Search options provided.

Introduction to Planogram Substitution

Introduction to Planogram Substitution
This section of the Planogram Substitution User Guide provides an introduction to the
Planogram Substitution functionality.

Overview of Functionality

1. Logging in validates that a user has been assigned privileges to access the
functionality. These privileges can be one of three types:

 Admin User - giving full access to the functionality, including specifying who can
access it and who can't.

 Merchandise Manager - who can set up and run planogram substitutions, but who
does not control access to the functionality.

Planogram Substitution
Definition dialog box

Description of the Planogram Substitution Definition dialog box

Planogram Substitution
Assistant

About the Planogram Substitution Assistant - a tool to help with
setting up substitutions

Find Dialog Box Using the Find dialog box within the planogram substitution
functionality

Dry Run and Planogram
Substitution Logs

About the Dry Run and Planogram Substitution Logs

Batch Operations About how to use batch processes to run planogram substitutions

Business Flows About how to use planogram substitution within a retail
organization
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 Normal User - restricted to running predefined substitutions in the currently open
drawing in the Planner or Merchandiser modules.

Note: Normal Users only have limited access to Planogram
Substitution functionality - the majority can only be accessed
by users with Merchandise Manager or Admin Privileges.

2. The Planogram Substitution dialog box is the first dialog box that opens. It allows
users to select planogram substitutions for adding, editing or deleting via the
Planogram Substitution Definition dialog box. It also allows users to open the
Planogram Substitution Assistant dialog box - a tool that helps users to create
planogram substitutions. The Planogram Substitution dialog box also allows users
to manually run multiple substitutions.

3. The Planogram Substitution Definition dialog box enables users to manually set up
the details of a specific planogram substitution.

4. The Planogram Substitution Assistant aids users with the details of planning a
specific planogram substitution by allowing them to select information from pre-
populated lists. It can be used in conjunction with the Planogram Substitution
Definition dialog box.

5. Once Planogram substitutions have been defined, the Dry Run option allows users to
test whether the substitutions will execute as intended. The results can be seen in the
Dry Run Log.

6. Any defined planogram substitutions can either be run as a batch process or
manually. If run manually:

 Users with Admin privileges can run multiple substitutions from within the
Planogram Substitution module.

 Users with normal privileges can run predefined substitutions in the currently
open drawing in the Planner or Merchandiser modules

7. The results of any substitutions that have been carried out can be seen in the
Planogram Substitution Log

Note: As well as actual planogram substitution (swapping
planogram A for B), the functionality will also carry out
Revision Substitution - swapping an earlier version of a
planogram design for a later one.

Dialog Boxes
This section gives an overview of the primary dialog boxes in the functionality.

Log In Dialog Box
The Log in dialog box is used to control access to the functionality.

The exact privileges depend on settings within the Administration module:

Administrator Level
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Users with Administrator's access have access to all aspects of planogram studio
functionality:

1. They can configure the access to the planogram substitution functionality. This
involves setting up user groups and assigning users to the appropriate ones.

2. Administrators can also define and bulk run planogram substitutions.

3. Administrators can also set up and control batch processes.

Merchandise Manager Level
Users with Merchandise Manager privileges have access to the planogram substitution
module, but not to the Administration module. This enables them to define and
manually bulk run planogram substitutions but not to control access to planogram
substitution, or to control batch processes.

Normal Users
Users with normal privileges have the ability to run substitutions on individual active
store plans in the Planner and Merchandiser modules. They do not have the privileges to
define planogram substitutions or run them in bulk.

Planogram Substitution Dialog Box
The Planogram Substitution dialog box is the initial dialog box to appear. It allows users
to control different aspects of the planogram substitution process:

Users can:

1. Add new planogram substitution definitions via the Planogram Definition dialog
box or the Planogram Substitution Assistant.

2. Edit existing planogram substitution definitions via the Planogram Definition dialog
box.

3. Delete planogram substitution definitions.

4. Manually carry out Dry Runs to test that the substitutions will run without problems.

5. View the Dry Run Log to see the results of the test.

6. Manually carry out planogram substitutions.

7. View the process log to see the results of planogram substitutions.

Planogram Substitution Definition Dialog Box
This dialog box can be invoked from the Planogram Substitution dialog box. It allows
users to manually configure the details of a specific planogram substitution.
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This dialog box has six tabs:

Substitution Tab
The Substitution tab allows users to select the planograms to be substituted and the
planograms that are to be their replacements.

The Rules Tab
The Rules tab allows users to select the validation rules that will apply to the planogram
substitution.

The Properties Tab
The Properties tab allows users to define the criteria for when a planogram substitution
will be carried out.

Stores Tab
The Stores Tab allows users to specify if planogram substitutions should only be carried
out in specific stores.

Status Tab
The Status tab allows users to specify the file statuses of the floor plans that will be
subject to planogram substitution operations.

Bays Tab
The Bays tab allows users to limit planogram substitutions to specific numbered bays.
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Planogram Substitution Assistant
The Planogram Substitution Assistant is a tool to help users set up a planogram
substitution. It can be invoked from either the Planogram Substitution or the Planogram
Substitution Definition dialog boxes.

Initial Stage
The initial page allows the user to select the existing planogram it is intended to
substitute.

Second Stage
The second stage allows users to specify the floor plan statuses the planogram
substitution will apply to.

Third Stage
The third stage allows users to extend the selection of planograms for substitution by
selecting planograms that are adjacent to the originally selected planogram. These
additional planograms can be to the left, right or sharing the same fixture.

Fourth Stage
The fourth stage allows the user to specify any stores the planogram substitution is to be
excluded from.

Final Stage
The final stage allows the user to specify the planograms to be substituted for the
originally selected planograms.

On clicking the Finish button, users will be taken to the Planogram Substitution
Definition dialog box, which will have been populated with information from the
Planogram Substitution Assistant. Additional information can then be added to complete
the Planogram Substitution definition.

Dry Run Log
The Dry Run facility enables Administrators or users who have been assigned an 'Admin
role' to test any Planogram Substitutions they have created. Each substitution is
simulated using data in the database and the results logged. Dry Runs are invoked using
the Dry Run option on the toolbar (or from the Tools menu) in the Planogram
Substitution dialog box.
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Dry Runs can be carried out for single or multiple substitutions by highlighting the
required substitutions in the Planogram Substitution or Planogram Substitution
Definition dialog boxes, then carrying out a Dry Run. Once the Dry Run has been
completed, the Dry Run log will appear.

This contains the results of all the selected dry runs and enables an Administrator to
identify problems with substitutions before they are carried out.

Running Planogram Substitutions
There are three ways of running planogram substitutions:

As a Batch Process
Planogram Substitutions can be run as a batch process. This would normally be set up by
System Administrators and will not be discussed further in this section.

Manually from within the Planogram Substitution Module
Single or multiple planogram substitutions can be run by highlighting them in the
Planogram Substitution dialog box and then invoking the Run option from the toolbar
(or from the Tools menu). If no substitutions are highlighted, all valid substitutions will
be run.
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Manually from within the Planner and Merchandiser Modules
Planogram substitutions can be run from within the currently open drawing by invoking
the Run Planogram Substitution option from the Tools menu. This will run all currently
active substitutions for that drawing.

Planogram Substitution Log
The Planogram Substitution Log can be called from the toolbar (or Tools menu) in the
Planogram Substitution dialog box.

This will show results from any planogram substitutions that have been run. It enables
Administrators to identify planogram substitutions that have been successfully executed
and planogram substitutions that have failed.
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Planogram Substitution Technicalities

Definition of Terms

Planogram Design
A planogram design is an arrangement of equipment (shelves) and merchandise
(products).

When an instance of that planogram design is placed in the drawing, the shelves and
products can be represented in varying levels of detail. Only planograms at the lowest
level of detail (2D) can currently be substituted.

Planogram Substitution
A planogram substitution is the automated changing of one or more planogram designs
for other planogram designs. These substitutions can be run manually for a single
drawing, manually for multiple stores if the user has Administrators rights or
automatically as a batch process for multiple stores in the database.
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Revision Substitution
Revision Substitution occurs when an updated version of a planogram design is
available. It results in the older version of a planogram in one or more store plans being
changed for the more recent version.

For example, a planogram containing different brands of baked beans might be adjusted
so that curried beans take up fractionally more space than in the earlier version of the
planograms.

When Revision Substitution is carried out in a store plan, information in the database is
changed to show that the planogram design has been changed from the old to the new.

Examples of Planogram Substitution
Planogram Substitution can come in many forms. This allows users complete flexibility
in selecting planograms to be substituted and defining the planograms that are to be
inserted as their replacements.

Note: A number of examples are given below - in practice
the validity of each substitution will be determined by rules
selected on the rules tab of the Planogram Substitution
Definition dialog box. For example, if the 'Length' rule is off,
lengths will not be validated and planograms of unequal
lengths can be substituted.

One to One
The simplest form of planogram substitution is a 'one to one' substitution. One
planogram of a specified length is replaced by another planogram of equal length.

In the above example, the 12 foot planogram 'B' has been replaced with another 12 foot
planogram 'C'.

One to Many
Another form of planogram substitution is a 'one to many' substitution. One planogram
of a specified length is replaced by two or more planograms whose combined lengths are
the same as that of the planogram they are replacing.

In the above example the 12 foot planogram 'B' has been replaced by the 4 foot
planograms 'D', 'E' and 'F'.

Many to One
In Many to One planogram substitutions, several planograms are selected and replaced
by a single planogram equal in length to the sum of the lengths of the planograms it is
replacing.
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In the above example, the 8 foot planogram 'A' and the 12 foot planogram 'B' are to be
replaced by the single 20 foot planogram 'G'.

Many to Many
A 'Many to Many' planogram substitution occurs when multiple planograms are selected
for replacement and are substituted for by multiple planograms occupying the same
length as the planograms they are replacing.

In the above example, the 8 foot planogram 'A' and the 12 foot planogram 'B' are to be
replaced by the 4 foot planogram 'H' and the 16 foot planogram 'J'.

One to None
It is possible to carry out a One to None Substitution - the removal of a planogram
without specifying a replacement. This might be called for when a planogram has to be
removed for legal reasons, etc., but no replacement has been decided on.

In the above example the planogram 'X' on the end cap of the gondola is to be removed
without a replacement being specified.

Note: it is also possible to carry out 'Many to None'
substitutions.

One to None with Fixture Removal
As well as a One to None substitution, it is also possible to remove the parent fixture.
This might be because parts of a store are being assigned to a different purpose and the
fixturing is changing as well as the planograms.

In the above example the planogram 'X' on the end cap of the gondola is to be removed
along with its parent fixture.

Revision Substitution
If no existing planograms have been selected for substitution, it is still possible to carry
out Revision Substitution. Revision Substitution is when slight changes have been made
to a planogram design and it has been saved as a new version rather than a new design.
When planogram substitution is carried out, all other planograms in the store will be
automatically be updated to the latest revision providing the Effective Date of the
revision is less than the Active Date of the floor plan the Revision Substitution is being
carried out in.
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Forms of Planogram Representation
Planograms can be placed in both the Planner and Merchandiser modules and in In-Store
Space Collaboration. In the Planner module and in In-Store Space Collaboration
planograms are represented as placeholders - that is to say they are shown as occupying
the fixture without any additional detail. In the Merchandiser module, planograms can
be represented at three different levels of detail.

How planograms are represented in Merchandiser
Planograms can be displayed at different levels of detail in the Merchandiser module.
The default for how planograms are represented is set on a user by user basis using the
Details drop down list in the Merchandising tab of the Configuration module.

The user has three options:

1. 2D Planogram (Placeholder)

2. 3D planogram (called 2.5 D in the Merchandiser Module).

3. 3D with Product Items (Full Detail).

These appear in the Merchandiser module as follows:
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A 2D planogram is purely a placeholder. A 3D planogram (2.5 D in Merchandiser) shows
the shelves and a simple product block to show the shelves are occupied. A 3D
planogram with Product items shows the shelves, together with full details of the
products.

How the Planogram display form is changed in Merchandiser
If planograms are first placed in the Planner Module, or in In-Store Space Collaboration,
when initially viewed in Merchandiser, they will appear in 2D form (placeholders).

If planograms were first placed in the Merchandiser module, how they appear is
determined by the settings individual users chose in the Configuration module (see
above).

Once in merchandiser, users have the option of toggling planogram display from 2D to
3D with Product Items and back again. This is controlled by the Explode and Implode
options on the View Toolbar.

This version of planogram substitution is only designed to operate when the planograms
are in 2D format, with no entries in the AVTTB_SHELF table for the planograms, and
only a single entry in the AVTTB_PRODUCT table for the product block acting as a
placeholder. Because of this, each drawing it is desired to run planogram substitution on
will have to be manually set to 2D format before the planogram substitution can be
carried out.
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How Planograms are stored in the Database
Depending on whether planograms are in 2D, 2.5D or 3D form, different information is
stored in the database.

1. The AVTTB_FILE table specifies the file in use
2. The AVTTB_FIXTURE table holds a list of fixtures placed in the drawing

3. The AVTTB_SHELF table holds a list of shelves placed in the drawing

4. The AVTTB_PLANO table holds information on planogram designs

5. The AVTTB_POG table holds information on which planograms have been placed in
the drawing

6. The AVTTB_PRODUCT table holds information on which products have been placed
in the drawing; either directly or in planograms.

When planograms are in 2D format, the AVTTB_POG table will hold details of the
planograms placed. The AVTTB_SHELF table will not have any information on shelves
and the AVTTB_PRODUCT table will only have a single entry for the product block
acting as the placeholder for the planogram.

When planograms are placed in 2.5D and 3D format, the AVTTB_POG table will hold
details of the planograms placed. The AVTTB_SHELF table will have details of the
shelves and the AVTTB_PRODUCT table will have multiple entries for the products on
each shelf. These entries could be product blocks acting as placeholders for the products
on each shelf (2.5D format), or product blocks representing products at display style
level.

The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable is used to
determine how planograms are processed when the form of the planogram in the floor
plan does not match the form of the planogram that will be substituted for it. For
example, if the planogram in the floor plan is in 2D form and the planogram being
substituted for it is in 3D form, the setting for the
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable will determine
the form the replacement planogram is displayed in.
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When Planogram Substitutions will be Carried Out
Planogram Substitutions will only be carried out if the drawing is checked in and not in
use.

Cloned Drawings
It is possible to set up planogram substitutions for files of current status. As files of
current status are set to 'read only', the substitutions are carried out into 'cloned' files.

1. Planogram Substitutions can only be carried out if the
PLANOGRAM_SUBSTITUTION_COPY_FILE system variable is set to On (1). (If this
system variable is set to Off, Current cannot be selected as a file status for
substitutions).

2. A Status of Current must have been selected in the status tab of the Planogram
Substitution Definition dialog box. If Current status is not selected, cloning will not
take place.

3. Cloning will only be carried out for a specific store if a floor within that store has an
existing file of current status.

4. All revisions in the floor will be checked for Authorized files with an effective date
falling within the date range set in the Floor Plan Effective Date option in the
Properties tab of the Planogram Substitution Definition dialog box. If such a file
exists (even in a different revision), then the substitutions specified for the Current
file will be carried out in that file.

5. If an Authorized file with an effective date falling within the date range set in the
Floor Plan Effective Date option in the Properties tab of the Planogram Substitution
Definition dialog box does not exist, a new Authorized revision will be created in the
same revision as the Current file. The effective date for the Authorized file will be set
to the earliest date on the Floor Plan Effective Date range.
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6. When all possible substitutions have been run, the user will be able to change the
status of the Authorized file to Current at the required time - either manually, or via
Update Status.

Cloning with Different Floor Plan Effective Dates
It is possible to set up a range of planogram substitutions effective for files of current
status with differing Floor Plan Effective Dates.

In the above example a range of substitutions have been set up for files of current status;
some with Floor Plan Effective Dates of 1st May and some for 1st July. This has resulted
in the creation of two new Authorized files in the Revision containing the Current file.
These Authorized revisions are accordingly set to become current on 1st May and one on
1st July.

Synchronization
Planogram substitutions are carried out by making changes directly in the database. The
Merchandiser Module and In-Store Space Collaboration read data directly from the
database, so will show the changes directly the drawing is next opened.
The Planner Module also stores information in an AutoCAD DWG drawing. After
planogram substitutions have been made and the information in the database changed,
the information in the DWG drawing has to be brought into line.
This is done by means of the Synchronization dialog box.
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Synchronizing 'Match the Database' will update the DWG drawing with the changes
made in the database.

The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED System Variable
The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a
significant impact on the way planogram substitutions are carried out. It can be set to 0,
1, 2, 3 or 4.

Planogram Form
There are three forms planograms can be placed in the merchandiser module.

1. 2D Planogram (Placeholder)

2. 3D planogram (called 2.5 D in the Merchandiser Module).
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3. 3D with Product Items (Full Detail).

The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a
significant impact on the way planogram substitutions are carried out. It can be set to 0,
1, 2, 3 or 4.

Once placed in the Merchandiser module planograms can be manually toggled between
2D and 3D mode by means of the Implode or Explode options on the toolbar.
Merchandiser floor plans can therefore contain planograms in a variety of states. The
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable determines
how planogram substitution caters for the different cases.

System Variable Values

Business Processes and the PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED
System Variable
The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a
significant effect on the business processes used by a customer. The setting of this system
variable needs to be considered carefully during the implementation of the software. If a
decision is taken to change the system variable during the lifetime of the Macro Space
Planning application this needs be considered carefully as well.

Consistency of Form
The initial form of planogram placement for individual users is controlled by the
Planogram Rules setting in the Merchandising tab of the Configuration Module. The
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable should be set
as to achieve consistency with the setting users have been instructed to set in the
Configuration module.

Impact on Reporting Accuracy
Whether planograms are in 2D, 2.5D or 3D form affects the form of information held in
the database. For example, a planogram in 2D form will only contain 'header'

System
Variable

Description

0 Only planograms in 2D form will be substituted - with planograms in 3D form being
ignored. The substituted planograms will be placed in 2D form. No information on the
planograms that have been ignored for substitution will be written to the Planogram
Substitution Log.

1 Only planograms in 2D form will be substituted - with planograms in 3D form being
ignored. The substituted planograms will be placed in 2D form. Information on the
planograms in 3D form that have been ignored for substitution will be written to the
Planogram Substitution Log.

2 Planograms in 2D form will be substituted with planograms also in 2D form.
Planograms in 3D and 2.5D form will be placed in 2D form when substituted.

3 3D and 2.5D planograms will be substituted by 2D planograms. A warning will be
written to the Planogram Substitution Log identifying the 3D and 2.5 D planograms
that were placed in 2D form during the substitution.

4 Planograms in 3D form will be substituted with planograms also in 3D form.
Planograms in 2D form will be placed in 3D form when substituted. Planograms in
2.5D form will be replaced by a 2D form if that is the way the planogram design has
been defined. It will be replaced by a 3D form if the planogram design is in 3D format.
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information with no entries for individual products of shelf objects. This impacts on
reporting accuracy.

For example, if planograms are in 2D mode, this needs to be taken into account when
generating a bill of materials for the equipment in the floor plan as shelf information will
not be stored in the AVTTB_SHELF table. Once placed in the Merchandiser module
planograms can be manually toggled between 2D and 3D mode by means of the Implode
or Explode options on the toolbar. Merchandiser floor plans can therefore contain
planograms in a variety of states. The
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable determines
how planogram substitution caters for the different cases.
For maximum reporting accuracy, the system variable should be set to 4. The planograms
that are substituted will be placed in 3D form. If the other (existing) planograms in the
drawing are in 2d or 2.5D form, they will be replaced with planograms in 3D form.

Accessing the Functionality

Overview of how Privileges Work
There are three broad types of access to the Planogram Substitution functionality.

Administrator Level
Users with Administrator's access can control all aspects of planogram substitution
functionality:

1. They can configure the access to the planogram substitution functionality. This
involves setting up user groups and assigning users to the appropriate ones.

2. Administrators can also define and bulk run planogram substitutions.
3. Administrators can also set up and control batch processes.

Merchandise Manager Level
Users with Merchandise Manager privileges have access to the planogram substitution
module, but not to the Administration module. This enables them to define and bulk run
planogram substitutions but not to control access to planogram substitution, or to control
batch processes.

Normal Users
Users with normal privileges have the ability to run substitutions on individual active
store plans in the Planner and Merchandiser modules. They do not have the privileges to
define planogram substitutions or run them in bulk.

Setting up Access to Planogram Substitution Functionality
Access to the Planogram Substitution functionality is configured in the Administration
Module using the Functionality Security and Data Security options. Functional Security
controls the access to the Planogram Substitution functionality, and Data Security
controls which planograms can be selected to define substitutions. This is discussed in
more detail in the next section.

Configuring User Privileges
What privileges a user has depends on settings in Functional Security and Data Security
in the Administration Module. This configuration is carried out by Administrators with
access to the Administration Module.
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Functional Security
Within Functional Security, Users can be assigned to User Groups. The User Groups that
Users belong to determine the type of access to the Planogram Substitution functionality.

User Groups are set up using the Add (or Edit) User Group dialog box in Functional
Security.

The Role assigned to the User Group is important.
1. If the User Group has a Role set to Admin User, members of that User Group will be

able to run bulk planogram substitutions, either from by using the 'Run' control
in the Planogram Substitution dialog box or via batch processes.

2. If the User Group does not have the Role set to Admin User, members of that User
Group will be able to run substitutions within open store plans, but will not be
able to run bulk planogram substitutions.

Any User Group associated with the Planogram Substitution Command Group will have
access to the planogram substitution functionality. Depending on the Role assigned to
the User Group, members of that group may or may not be able to run bulk substitutions.

Giving access to the Functionality
Once a User Group has been created, it can be assigned to the Planogram Substitution
User Group on the Group Relationships tab of the Functional Security dialog box.

Data Security
Within the Data Security dialog box, the Planogram tab allows Administrators to specify
what parts of the planogram hierarchy can be accessed by specific users within
the Planogram Substitution functionality. The following rules apply:
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1. A User must belong to at least one User Group with 'Read' permissions to access
planograms within the Planogram Hierarchy.

2. 'Deny' permissions take precedence over 'Read' permissions.

3. If a User belongs to a User Group with 'Read' permissions for a branch of the
Planogram hierarchy they will be able to read all child branches of that part of the
planogram hierarchy unless a 'deny' permission is encountered.

In the above example for a single User Group:

 The 'Clothing' Planogram Group has been given no permissions, so no member of
the User Group can access any planograms related to clothing.

 The 'Electrical' Planogram Groups has been given no 'Read' permission, but two of its
child Planograms Groups have. Members of the User Group can access
planograms belonging to the 'Kitchen' and 'Phone' child Planogram Groups, but not
planograms belonging directly to the 'Electrical' Planogram Group, or planograms
belonging to the 'TV and Audio' child Planogram Group.

 The 'Food and Drink' Planogram Group has been given a 'Read' permission, with one
of its child Planogram Groups being given a 'Deny' permission. Members of
the User Group will be able to see planograms belonging directly to the 'Food and
Drink' Planogram Group and to its 'Bakery', Fruit and Vegetables' and 'Tinned
Goods' child Planogram Groups. They will not be able to see planograms belonging
to the 'Wines and Spirits' child Planogram Group.

Configuring Access to the Planogram Hierarchy
Configuring access to the planogram hierarchy is configured in two stages:

1. A User Group is assigned to a branch of the Planogram Hierarchy

2. 'Read' or 'Deny' permissions are assigned.
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Assigning a User Group
To assign a User Group to a Planogram Group:
1. Highlight the Planogram Group in the Planogram hierarchy.

2. Select the Add User Group option from the Toolbar or the Edit menu.

3. The Add User Group dialog box will appear.

4. Check the required User Groups and click OK.

5. It is now possible to assign 'Read' or Deny' permissions to those nodes in the
Planogram Hierarchy.

Setting 'Read' or Deny' Permissions
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To Set 'Read' or 'Deny' permissions:

1. Highlight the required Planogram Group in the Left Hand pane of the Planogram
Tab of the Data Security dialog box.

2. Highlight the associated User Group in the Right Hand pane of the Planogram Tab of
the Data Security dialog box

3. Right click to bring up the Permissions dialog box.

4. Select either 'Allow Read' or Deny Read' to specify whether members of the user
group can or cannot access the planograms in that Planogram Group and its
Children.

Controlling Access with Multiple User Groups
It is possible to use multiple user groups to control access to the Planogram Substitution
functionality. This would be done by MSM users with access to the Administration
Module and allows users to be given very specific access to the functionality.

User Group Types for access to the Planogram Substitution Functionality
There are two basic types of User Groups that determine the actions that a user can carry
out within the Admin Module: groups with Roles set to Admin User and Groups with
Roles that are not set to Admin User. The former can carry out bulk planogram
substitutions; the latter cannot. These are configured in Functional Security.

User Group Types for access to the Planogram Hierarchy

Other User Groups can be created to control access to different parts of the planogram
hierarchy. For example, User Groups could be created to control access to (a) Food and
Drink, (b) Electrical and (c) Clothing planograms. Putting Users into specific User
Groups controls their access to the hierarchy. This is configured in Data Security.

Controlling Access
Access is controlled by the cumulative privileges that the User inherits from the User
Groups they belong to. It would be possible to set up two types of user groups to control
access:

 User groups to control access to the software.

 User groups to control access to the planogram hierarchy.
As an example, an Administrator might go into the User Groups tab in Functional
Security and create the following two User groups:

 Merchandise Manager - of User Group Type 'Admin User'

 Merchandiser - of User Group Type 'Merchandiser User'

Members of the first User Group can carry out bulk planogram substitutions; members of
the second cannot. The administrator would then assign those two User Groups to
Planogram Substitution in the Group Relationships tab.
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Similarly, an Administrator might go into the User Groups tab in Functional Security and
create the following User groups:

 Merchandiser - Food and Drink

 Merchandiser - Electrical
 Merchandiser - Clothing

Membership of specific User Groups would confer access to planograms of that type.
Having configured the User Groups in Functional Security, the Administrator would go
to the Data Security module and assign 'read' permissions to the appropriate nodes in the
planogram hierarchy - for example the 'Electrical' User Group would be assigned 'read'
permissions to all nodes in the planogram hierarchy containing Planograms with
electrical products.

The Administrator can then put Users into the appropriate User Groups.

Jane Doe John Smith William Brown Susan Green

Merchandiser Manager X

Merchandiser X X X

Merchandiser - Food and
Drink

X X X

Merchandiser - Electrical X X X

Merchandiser - Clothing x X

The Users will then have different privileges:

 Jane Doe can define substitutions for all types of planograms and can run those
substitutions either individually or in bulk.

 John Smith can define substitutions for all types of planograms, but can only run
those substitutions in opened store plans (i.e. individually).

 William Brown can only define planogram substitutions for 'Food and Drink'
planograms and can only run those substitutions in opened store plans.

 Susan Green can only define planogram substitutions for 'Electrical' planograms and
can only run those substitutions in opened store plans.

Logging into Planogram Substitution
This section describes how Users Log In to Planogram Substitution.

Security Server
Security Server is a background executable file (.exe) that starts and runs in the
background when MSM is opened by a user. It holds details of the privileges that user
has been granted in the Administration module.

Note: Security Server can be seen in the Applications tab of
the Windows Task Manager dialog box when Macro Space
Management is running.

If the User has already accessed another MSM module, then tries to access Planogram
Substitution, the application will query Security Server to see if that specific User has
permission to access the Planogram Substitution module.
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Logging In
Planogram Substitution can be started from the Windows start menu, Windows desktop
and from the Tools menu in MSM Planner and Merchandiser modules.

1. If another MSM application is running, the application will query Security server to
see the User has the appropriate permissions to access Planogram Substitution.

2. If the User is opening Planogram Substitution as their initial MSM application, the
Log In dialog box will appear.

3. After the User has entered his User Name and Password and clicked OK, an instance
of Security Server will open in the background and the Users permissions will be
validated.

Planogram Substitution Dialog Box

Overview of Planogram Substitution Dialog Box
The Planogram Substitution dialog allows users to manually control the planogram
substitution process.

Users can:

1. Add new planogram substitution definitions via the Planogram Definition dialog
box or the Planogram Definition Assistant.

2. Edit existing planogram substitution definitions via the Planogram Definition dialog
box.

3. Delete planogram substitution definitions.
4. Manually carry out 'dry runs' to test that the substitutions will run without problems.

5. View the 'dry run' log to see the results of the test.

6. Manually carry out planogram substitutions.

7. View the process log to see the results of planogram substitutions.
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Note: In order to manually bulk run planogram
substitutions members must belong to a User Group with
the User Group Role set to Admin User.

The Planogram Substitution dialog box interacts with the Planogram Substitution
Definition and Planogram Substitution Assistant dialog boxes as per the diagram below:

8. The Planogram Substitution Definition dialog box can be opened from the
Planogram Substitution dialog box, either to add or to edit Planogram
Substitutions.

9. The Planogram Substitution Assistant dialog box can be opened from the Planogram
Substitution dialog box as an aid to creating a new planogram substitution. On
saving a Planogram Definition created in the Assistant, the data will be transferred to
the Planogram Substitution Definition dialog box.

10. The Planogram Substitution Assistant dialog box can also be opened from the
Planogram Substitution Definition dialog box. The tab the Planogram Substitution
Assistant opens in is dependent on where the user is within Planogram Substitution
Definition dialog box. On saving a Planogram Definition edited in the Assistant, the
data will be transferred to the Planogram Substitution Definition dialog box.

11. On saving a planogram substitution that has been defined in the Planogram
Substitution Definition dialog box, the summary information will be added or
updated in the Planogram Substitution dialog box.

Menus and Toolbars

Menu Options

Menu Option Icon Shortcut Key

File New Ctrl + N
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Open Ctrl + O

Exit Alt + F4

Edit Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Delete Del

Select All Ctrl + A

Find Next F3

View Dry Run Log...

Substitution Log...

Refresh Ctrl + F5

Tools Substitution Assistant...

Run

Dry Run

Help Contents F1

Toolbar Options

Option Icon Short Cut Key

New Ctrl + N

Open Ctrl + O

Assistant Alt + F4

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Delete Del

Run

Dry Run
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Substitution
Log...

Help F1

Adding, Editing and Deleting Planogram Substitution Definitions
Adding Planogram Substitution definitions can be done in one of two different ways:

 By using the Planogram Substitution Definition dialog box

 By using the Planogram Substitution Assistant
Editing existing planogram substitutions can be carried out by using the Open option.

Invoking the Planogram Substitution Definition dialog box

Clicking the Add New Planogram Substitution Icon will open a blank Planogram
Substitution Definition dialog box. Alternatively, users can select the New option from
the File menu.

Highlighting one or more planogram substitutions and clicking the Open Planogram
Substitution icon will open those substitutions. Alternatively (after highlighting the
required substitutions), users can select the Open option on the File menu.

Note: If multiple planogram are selected for editing all tabs
but the Substitution tab can be edited. The selected settings
become common to all the planograms being edited.

Calling the Planogram Substitution Assistant

Clicking the Planogram Substitution Assistant icon (or using the Assistant option on the
Tools menu) will open a blank Assistant. This can then be used to define many parts of a
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new planogram Substitution. On saving a Planogram Definition created in the Assistant,
the data will be transferred to the Planogram Substitution Definition dialog box.

Deleting Planogram Substitutions
Deleting Planogram Substitutions is carried out by highlighting them in the Planogram
Substitution dialog box and then clicking the Delete option. Alternatively, the delete
option can be used from the Edit menu.

Cut, Copy and Paste Options
The Cut, Copy and Paste options are used to delete planograms or to copy and paste a
copy of a planogram. The Cut, Copy and Paste icons are on the toolbar:

 Cut will delete any highlighted items while storing the information on the clipboard

 Copy will place a copy of the information on the clipboard.

 Paste places a copy of the information on the clipboard into the Planogram
Substitution dialog box.

The most common use of the copy and paste option is to create copies of existing
planogram substitutions. The copies can then be edited as a quick way of producing
alternative planogram substitutions.

In the above example, a copy has been created of the Berlin planogram substitution.

Other Options
There are several other options available to the user in the Planogram Substitution dialog
box.
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Dry Run Option
The Dry Run option can be invoked from the toolbar, or from the Tools menu.

Dry Runs (and the associated Dry Run Log) can be used to validate any planogram
substitutions that have been defined before they are run.

Note: for more information see the chapter on the
Planogram Substitution and the Dry Run Logs.

Run Option
The Run option allows Administrators to manually run single or multiple planogram
substitutions.

After a single or multiple planogram substitutions have been highlighted in the
Planogram Substitution dialog box, clicking the Run option will cause these substitutions
to be executed in the database.

This provides an alternative to running planograms via a batch process.

Note: In order to use the Run option, Users must belong to a
User Group that has been assigned to the Admin User role in
the Role drop down list.

Planogram Substitution Log
The Planogram Substitution Log gives the results of all planogram substitutions that
have been executed. It is opened by clicking the Planogram Substitution Log option on
the toolbar. Alternatively, it can be opened from the View menu.
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Note: for more information see the chapter on the
Planogram Substitution and the Dry Run Logs.

Find dialog box
The find dialog box enables users to search for Planogram Substitutions using different
filter criteria. It is opened by clicking the Find option on the toolbar.

Note: for more information see the chapter on the Find
dialog box.

Selecting columns to display
It is possible to select the columns to be displayed. To do this, right click in the list of
planograms to bring up the right click menu. The columns to display can then be selected
by checking or unchecking the required columns.
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Planogram Substitution Definition Dialog Box

Overview of Planogram Substitution Definition Dialog Box
This section gives a brief overview of the Planogram Substitution Definition dialog box.
The dialog box contains six tabs.

1. Substitution Tab
2. Rules Tab

3. Properties Tab

4. Stores Tab

5. Status Tab

6. Bays Tab

These tabs can be used in any sequence, the results being saved back to the database by
clicking the Save button.

Note: The Substitution, Stores and Statuses tabs can be
populated with the aid of the Planogram Substitution
Assistant.

Planogram Substitution Definition Dialog Box Pages
There are six tabs within the Planogram Substitution dialog box. The purpose of each is
briefly described in this section.

The Substitution Tab
The Substitution Tab holds details of the planograms that are to be removed (substituted)
and their replacements.
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Planograms to be substituted are specified in the top right hand pane, while the
replacement planograms are specified in the bottom right hand pane.

The Rules Tab
The rules tab specifies the validation rules that will apply when carrying out the
planogram substitution.
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As well as validation rules, the user can also specify some of the notifications to be
written to the Planogram Substitution error log when substitutions are being carried out.

The Properties Tab
The Properties tab has details of the dates the substitution is valid for.
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As well as enabling the user to set the dates, the user can also set the Status and State of
the planogram substitution. This tab also contains read only information on who created,
modified and last ran the substitution.

The Stores Tab

The Stores Tab enables users to restrict the list of stores that the planogram will be
carried out in.
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The Status Tab
The Status tab enables users to specify what statuses floor plans must be at for a
planogram substitution to take place.
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The Bays Tab
The Bays Tab enables users to restrict the planogram substitution to specific bay numbers
within floor plans.
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The Planogram Substitution Assistant
Some of the data in the Planogram Substitution Definition dialog box can be filled in with
the aid of the Planogram substitution assistant. The Planogram Substitution Assistant can
be used in one of two ways:

1. The Assistant can be invoked directly from the Planogram Substitution dialog box.
When the Planogram Substitution Assistant is closed, the defined data will be
transferred to the Planogram Substitution Definition dialog box.

2. The Assistant can also be invoked from the Planogram Substitution Definition dialog
box. Data can then be refined in the Assistant with the data transferred to the
Planogram Substitution Definition dialog box when the Assistant is closed.

The following tabs in the Planogram Substitution Definition dialog box can be populated
with data from the Planogram Substitution Assistant pages:

Planogram Substitution
Definition Tab

Planogram Substitution Assistant Page

Substitution tab Can be populated by the results of the Existing
Planogram page, the Adjacent Planograms tab on
the Adjacent Planograms page and the New
Planograms page.
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Status tab Can be populated by the results of the Status tab
on the Adjacent Planograms page.

Stores tab Can be populated by the results of the stores tab
on the Adjacent Planograms page.

Menus and Toolbar
The following Menu and Toolbar options are available:

Menu Options
The following options are available from the menus.

Menu Option Icon Shortcut Key

File New Ctrl + N

Save Ctrl + S

Save As

Exit Alt + F4

Edit Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Delete Del

Select All Ctrl + A

Find

Tools Substitution Assistant...

Add Existing

Add New

Reverse Substitution. Ctrl + R

Substitution Rule Test

Dry Run

Help Contents F1

Toolbar Options
The following options are available from the toolbar.
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Option Icon Short
Cut
Key

New Definition Ctrl +
N

Save Definition Ctrl + S

Planogram
Substitution
Assistant

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Find

Add Existing
Planogram

Add New
Planogram

Add Store

Delete

Move planogram
up in list

Move planogram
down in list

Reverse planogram

Validate
substitution rules

Dry Run

Help Contents

Substitution Tab
The Substitution Tab is used to specify the planograms to be substituted (removed) and
the planograms that will be used as their replacement.

Description of the Substitution Tab
The Substitution Tab has the following parts:
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1. The Menus contain a list of all actions available to the user.

2. The toolbar contains a more restricted list of actions available to the user.

3. The Definition Details gives the name and description of the current planogram
substitution.

4. The Planogram Hierarchy contains the list of planograms available to the user.

5. The Planogram Properties contain details of a specific planogram.

6. The planograms that will be substituted (removed) are specified in the top right
pane.

7. The planograms that will be their replacement are specified in the bottom right plane

Using the Substitution Tab
Planogram Hierarchy
Two factors need to be taken into account when using the Planogram Hierarchy:

 The Planogram Hierarchy will only contain the latest revision of a planogram for any
given planogram lineage.

 Which planograms are visible to a specific User will be governed by which User
Groups they have been assigned to and what branches of the planogram hierarchy
those User Groups have access to.
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Note: if the user has not been assigned access to any
Planogram Groups in the Data Security dialog box (Security
menu), then they will not be able to access any planograms
when defining substitutions.

Adding and Deleting Planograms
Planograms can be added or removed from the pane specifying the planograms to be
substituted (removed) and the planograms that are to be their replacement. Whether
planograms are to be substituted or added as replacements will depend on which pane
they are added to.

There are several ways planograms can be added or deleted:

 Planograms can be selected by dragging a planogram or a planogram group from the
hierarchy and dropping it to the appropriate pane.

 Planograms can be added to the appropriate pane by highlighting an item in the
hierarchy and selecting the Add Existing Planogram option from the toolbar or Tools
menu.

 Planograms can be added to the appropriate pane by using the Find… option on the
toolbar or Edit menu.

 Planograms can be added to the appropriate pane by using the paste option to paste
in a planogram name or planogram code. The rest of the row of data will populate
automatically.

If a planogram group is selected from the hierarchy then all of the planograms that are
direct descendants of the group will be added to the selection set.

Reordering Planograms
The list of planograms can be reordered by means of the up or down arrows on the
toolbar.

 The up and down toolbar options will be enabled when one or more consecutive
rows are selected in the existing planograms list. They will be grayed out if the
selected rows are not consecutive or no rows are selected.

 Using the up or down arrows will promote or demote the selected rows in the
sequence that planograms are substituted. The planogram at the top of the list will
be substituted first, the next in the list second, etc....

Cut Copy and Paste Functionality
The cut, copy and paste functionality has two main functions:

1. To edit the list of Existing Planogram Substitutions.

2. To transfer data to and from external applications.

The list of existing planograms can be edited as follows:

 Planograms can be added to the appropriate plane by using the paste option to paste
in a planogram name or planogram code. The rest of the row of data will
populate automatically.

 Planograms can be removed from the list of planograms by highlighting rows and
using the Cut option.

Data can be transferred to and from external programs (for example a spreadsheet) by:

 Highlighting data in the Planogram Hierarchy, Properties Window or list of selected
Planograms. Data can then be transferred to the Clipboard by means of
the Copy command. Once the external program (for example a spreadsheet) is open,
the Paste command can be used within that program to enter the data.
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 Highlighting data in an external program (for example a report) and using the Copy
command to transfer it to the Clipboard. Once in the Planogram Substitution
Assistant, the Paste command can be used to add Planogram Names or Planogram
Codes to the list of selected planograms.

Revision Substitution
If it is desired to just carry out Revision Changes (update planogram designs, not change
them) then it is possible to define a substitution without any planograms, but with the
Revision Change check box checked.

Note: If a planogram substitution has been defined, then
Revision Substitution will automatically be carried out for all
planograms in the selected stores. This is in addition to any
substitutions that have been defined.

Deleting Fixtures
If a planogram is being removed because no replacement planogram is being substituted
in, it is possible to delete the parent fixture(s) as well as the planogram. This is done by
checking the Delete Fixtures check box.
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Rules Tab
The Rules tab is used to set criteria used to validate the substitution. The rules are used
twice for this purpose:

1. On exiting the Planogram Substitution Definition dialog box, the rules will be used to
validate the substitution is valid.

2. On running the Planogram Substitution, the rules will be used to validate each
successive substitution within a store plan.

Description of the Rules Tab
The Rules tab has the following parts:
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1. The menus contain all options available to the User.

2. The toolbars contain a more restricted list of options available to the User.

3. The Definition Details give the Name and Description of the Planogram Substitution
Definition.

4. The Existing Planogram Validation specified whether adjacent planograms to those
being substituted should be verified.

5. The Validation Rules enable the user to set how the planogram substitution is to be
tested when it is saved and when it is carried out.

6. The Notifications give the options for writing messages to the error log.

Description of Rules and Notifications
This section describes the purpose of each rule or notification

Each rule functions as follows:

Planogram Adjacency (Existing Planograms)
The existing planogram adjacency rule validates if all the existing planograms in the floor
plan are calculated to be adjacent to the left or right.

Length Rule (New Planograms)
The length rule validates if the merchandisable length of the fixtures containing each
successive profile (bay) in the existing planograms in the floor plan matches the
individual lengths for each successive profile of the new planograms as defined in the
MSM planogram library.
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The length rule may be assigned a plus and minus tolerance by means of the spin
controls. If a tolerance has been assigned, the planogram will place if the length defined
for each successive bay of the planogram falls within the length range defined by the
tolerances.

Note: The default length tolerance is set by the
PLANOGRAM_SUBSTITUTION_LENGTH_TOLERANCE
system variable in the System Variable dialog box accessed
from the General Menu in the Admin Module.

Depth Rule (New Planograms)
The depth rule validates if the merchandisable depth of the fixtures containing each
successive profile (bay) in the existing planograms in the floor plan matches the
individual depth for each successive profile of the new planograms as defined in the
MSM planogram library.

The depth rule may be assigned a plus and minus tolerance by means of the spin
controls. If a tolerance has been assigned, the planogram will place if the depth defined
for each successive bay of the planogram falls within the length range defined by the
tolerances.

Note: The default length tolerance is set by the
PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE
system variable in the System Variable dialog box accessed
from the General Menu in the Admin Module.

Height Rule (New Planograms)
The height rule validates if the merchandisable depth of the fixtures containing each
successive profile (bay) in the existing planograms in the floor plan matches the
individual height for each successive profile of the new planograms as defined in the
MSM planogram library.

The height rule may be assigned a plus and minus tolerance by means of the spin
controls. If a tolerance has been assigned, the planogram will place if the height defined
for each successive bay of the planogram falls within the length range defined by the
tolerances.

Note: The default height tolerance is set by the
PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE
system variable in the System Variable dialog box accessed
from the General Menu in the Admin Module.

Note: The Height rule does not currently take into account
the effect of the ADDITIONAL_FIXTURE_HEIGHT system
variable.

If no offsets have been set for the merchandisable area for the fixture (Merchandisable
Areas tab of the block Details dialog box) in Fixture Studio, the length, depth and height
of the merchandisable area will match those of the fixture. If offsets have been used, the
length, depth and height of the merchandisable area will differ from the fixture
dimensions.

Fixture Style (New Planograms)
The fixture style rule validates if the styles assigned to the fixtures containing each
successive profile (bay) in the existing planograms in the floor plan match the fixture
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styles for each successive profile of the new planograms as defined in the MSM
planogram library.

Splittable Rule (New Planograms)
The splittable rule deals with two cases:
1. If a planogram that is being substituted into the drawing is not defined as splittable,

the software will validate that all the fixtures containing the existing planogram(s) in
the store plan that are to be substituted by the new planogram are adjacent to the left
or right of each other and are co-linear.

2. If a planogram that is being substituted into the drawing is defined as splittable, the
software will allow it to be placed on non-adjacent fixtures.

Note: For the splittable rule to be validated correctly, the
Fixture Adjacency Calculations must be up to date for the
store plan that the planogram substitution is to be carried
out in. There are two ways of achieving this: By running the
Fixture Adjacency Calculation manually within a specific
store plan or by running the Fixture Adjacency Calculation
throughout the entire database via a batch process.

Temperature Range (New Planograms)
The temperature range rule validates if each temperature ranges of the fixtures
containing the existing planograms in the floor plan that are to contain a whole new
planograms overlap the temperature range of the new planogram as defined in the MSM
planogram library.

The validation options are used when the planogram substitution is run. They specify the
warning messages that will be written to the error log. They will only be used if the 'All
Stores' check box has been unchecked on the Stores tab.

Existing Planogram not found in Floor Plan
The existing planogram rule will log a warning if all the existing planograms are not in
the floor plan and the 'All Stores' check box has been unchecked on the Stores tab.

Floor Plan not found in Store
The floor plan rule will log a warning if at least one floor plan was not found for each
store and the 'All Stores' check box has been unchecked on the Stores tab.

Note: If the All Stores check box is checked on the Stores
Tab, no warnings will be generated.

Settings in the rules tab determine how detailed a validation the planogram substitution
will be subjected to.

The 'All Rules' Check Box
The All Rules check box has three states:

1. Checked

Checking the All Rules tick box will check all the rules tick boxes and so enable all the
rules. The All Rules tick box will also automatically change to checked when all the
individual rules tick boxes have been checked.

2. Unchecked

Un-checking the All Rules tick box will un-check all the rules tick boxes and so disable all
the rules. The All Rules tick box will also automatically change to un-checked when all
the individual rules tick boxes have been un-checked.
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3. Indeterminate

The All Rules tick box will be set to indeterminate when some of the individual rules tick
boxes are checked and some are un-checked.

Individual rules can be set or deselected by ticking the individual check boxes. The state
of the All Rules check box will be changed automatically depending on whether all, no or
some rules are selected.

Copy and Paste Options
The copy and paste options provide an easy way to transfer a set of rules from one
Planogram Substitution Definition to another.

 Selecting the copy option on the toolbar, Edit menu or using the Ctrl+C shortcut key
will copy the details of the checked rules to the Windows clipboard.

 Selecting the paste option on the toolbar, Edit menu or using the Ctrl+V shortcut key
will copy the rules currently copied to the windows clipboard and check the settings
in the Rules tab accordingly.

Exiting the Rules Tab

On leaving the Rules tab, the software will test if any rules have been selected. If no rules
are selected, two warnings will be given:
 A Warning Icon will be displayed on the Rules tab itself.

 The message "No rules selected" will be displayed on the status bar.

Properties Tab
The Properties tab holds information on the dates the planogram substitution definition
is valid for, together with its Status and State.

Description of the Properties Tab
The Properties tab has the following parts:
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1. The menus contain all options available to the User.

2. The toolbars contain a more restricted list of options available to the User.

3. The Definition Details give the Name and Description of the Planogram Substitution
Definition.

4. The Substitution details enable the user to set dates the planogram substitution is
valid between.

Using the Properties Tab
Settings in the Properties tab determine when and how the planogram substitution will
run.

Execution Date
The Execution Dates can be set using the date time picker to any date equal to the current
date or to a date in the future. The definition will be able to be run during the inclusive
period set by the execution dates, i.e. when the current date is equal to or less than the
first execution date and the current date is equal to or less than the execution date.

Floor Plan Effective Date
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The Floor Plan Effective dates can be set using the date time picker to any date equal to
the current date or to a date in the future. They are used in two circumstances:

1. When planogram substitutions are being made into files of Authorized status.

2. When planogram substitutions are being made into files of Current status and files
are being cloned.

When planogram substitutions are made into files of Authorized status, the Effective
Date of the file must fall within the range of dates specified in the Floor Plan Effective
Date or no substitutions will be made.

For planogram substitutions to be carried out on files of Current status, the
PLANOGRAN_SUBSTITUTION_COPY_FILE system variable must be set to On (1). The
substitutions will then be carried out in an existing file of Authorized status if the
Effective Date of the file falls within the range of dates specified in the Floor Plan
Effective Date. If no such Authorized file exists, then one will be created in the same
revision as the Current file with an Effective date matching the earliest date in the Floor
Plan Effective Date.

Status

The Planogram Substitution Status drop down list enables users to show where the
Planogram Substitution Definition is in the business work flow.

Note: Statuses are configurable in the Administration
module. This section of the help file describes the default
statuses supplied with the application.

The default statuses set up with the application are:

Status Comment

WIP (Work in
Progress)

Planogram Substitution Definition
being developed

Proposed Planogram Substitution Definition
ready for approval

Authorized Approved Planogram Substitution
Definition - when this status is
reached the Planogram Substitution
Definition will be set to 'Read Only'
and no further changes will be
possible.

Rejected Rejected Planogram Substitution
Definition

Statuses can be changed in one of two ways:
 Manually, by changing the status using the drop down list in the Status Tab. In this

case, only the statuses before and after the currently set status will be available for
selection.

 Via a dialog box that appears when exiting the tab.

If a User manually changes the status before exiting the tab, they will be allowed to exit
the tab without the Submit or Approval dialog boxes appearing. If the User has not
manually changed the status, the Submit or Approval dialog box will appear depending
on the currently set status for the Planogram Substitution.
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Priority
The priority spin control can be used to set priorities for executing Planogram
Substitutions when being run as a batch process. The priority will determine which
definition is run first if more than one definition is to be executed on the same date.
Priority 1 will run first, followed by Priority 2, etc. Each priority must be unique. If the
execution priority is set to the same value as another definition then the existing
priorities will be incremented by one to ensure they remain unique.
For example if the Priority is set to 3 and there is an existing Priority 3, the existing
priority will be changed to 4.

Run Once

The Run Once flag enables user to specify whether the planogram substitution will run
once only, or will run all the time the Execution Date is valid. Checking the tick box
ensures the substitution will only be executed once.
The information below is displayed 'Read only' depending on the current information in
the database.

State
The State List shows the current condition of the planogram substitution.

State Comment

Ready The Planogram Substitution is ready
to execute.
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Running The Planogram Substitution is
currently executing

Stopping The Planogram Substitution is
currently running but a manual or
batch command has been issued to
stop/terminate the substitutions.

Stopped The Planogram Substitution was
running but was stopped by means of
a manual or batch command.

Pausing The Planogram Substitution is
currently running but a manual or
batch command has been issued to
pause the substitutions.

Paused The Planogram Substitution was
running but was paused by means of
a manual or batch command.

Finished The Planogram Substitution has been
run to completion.

The state can only be changed by users with Admin privileges and indicates whether the
substitution definition has been run or is in the process of being run.

Created By
This field shows the name of the MSM User that first saved the planogram substitution
definition.

Created Date
This field shows the date and time when the planogram substitution definition was first
saved.

Last Modified By
This field shows the name of the MSM User that last saved the planogram substitution
definition.

Last Modified Date
This field shows the date and time when the planogram substitution definition was last
saved.

Last Run By
This field shows the name of the MSM User that last ran the planogram substitution
definition. This could be a User running a substitution from within a store plan, an
Administrator manually running an entire batch of substitutions, or an Administrator
running substitutions via a batch process.

Last Run Date
This field shows the date and time when the planogram substitution definition was last
run.

Status Tab
The Status tab is used to select File Statuses that floor plans must be at in order for
planograms to be substituted.
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Description of the Status Tab
The Status tab is used to select the statuses of the floor plans that will have planogram
substitutions carried out on them.

1. The menus contain all options available to the User.

2. The toolbars contain a more restricted list of options available to the User.

3. The Definition Details give the Name and Description of the Planogram Substitution
Definition.

4. The Status check boxes enable the user to specify the statuses for floor plans the
planogram substitution is to be carried out in.

Using the Status Tab
The Status tab contains a list of statuses for files. These are read from the database and
may be different for specific implementations of Macro Space Management.
 Historical Status is not shown as this represents store plans that have been taken out

of service.
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 Authorized Status will be checked by default.

 Current status will only be visible if the
PLANOGRAM_SUBSTITUTION_COPY_FILE System Variable is set to on. If this
system variable is set to On, files will be cloned as required.

Statuses can be selected by means of the check boxes. A minimum of one status must be
selected.

Stores Tab
The Stores Tab can be used to refine the list of stores that the substitution will be carried
out in.

Description of the Stores Tab
The Stores tab contains two panes. On the left is the store hierarchy showing all possible
stores that the substitution can take place in. On the right are the stores that have been
excluded from the substitution.

1. The menus contain all options available to the User.
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2. The toolbars contain a more restricted list of options available to the User.

3. The Definition Details give the Name and Description of the Planogram

4. The Validation Rules enable the user to set how the planogram substitution is to be
tested when it is saved and when it is carried out.

5. The Notifications give the options for writing messages to the error log.

Using the Stores Tab
The Stores tab initially populates with a list of all stores that the planogram substitutions
are to be carried out in. This list is determined by the settings in the Status Tab. It may be
necessary to make the Planogram Substitution store specific. This is because not all stores
have the same arrangement of planograms. When the tab is opened, the 'All stores' check
box can be checked to ensure that the planogram substitution is carried out in all selected
stores.

Alternatively, the checkbox can be unchecked, allowing users to make the planogram
substitution store specific. Initially all stores are selected and are in the hierarchy on the
left. Moving stores to the pane on the right deselects them from the list of stores the
substitution will be carried out in. There are several ways of achieving this:

 Stores can be deselected by dragging a store or a cluster from the hierarchy and
dropping it to the list view on the right-hand side of the store specific group. When a
cluster is selected from the hierarchy then all of the stores that are descendants of the
cluster will be deselected.

 Stores can be deselected by highlighting an item in the hierarchy and pressing the
store toolbar button. When a cluster is selected from the hierarchy then all of the
stores that are descendants of the cluster will be deselected.

 Using the Find option to deselect stores.

Bays Tab
The Bay Numbers tab allows Users to specify bay numbers as a further filter for
planogram substitutions.

Note: Bay Numbers can be assigned to fixtures in the
Planner Module.

Description of the Bays Tab
The Bays Tab consists of the tab itself, and the Bays dialog box that can be called from it.
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1. The menus contain all options available to the User.
2. The toolbars contain a more restricted list of options available to the User.

3. The Definition Details give the Name and Description of the Planogram Substitution
Definition.

4. The Bays dialog box enables users to call the Bays dialog box.

5. The selected Bay Numbers is a list of bay numbers that the planogram must occupy.

Bays Dialog Box
The Bays dialog box enables users to select from the list of available bays.
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Note: Users should be aware that bay numbers may differ
from drawing to drawing. Depending on how Bay
Numbering has been implemented, Bay A1 in one drawing
may not be in the same location in another drawing.

Using the Bays Tab
How the Bays tab operates will depend on the setting of the All/Bay Numbers/Fixture
Identifier radio button. Only one method can be used within a specific planogram
definition.
1. If the Radio Button is set to All, planograms will be substituted irrelevant of which

bay they are placed on in a floor plan.

2. If the Bay Numbers radio button has been selected then existing planograms will
only be substituted if they are placed on an appropriately bay numbered fixture in a
floor plan.

3. If the Fixture Identifier radio button has been selected then existing planograms will
only be substituted if they are placed on an appropriately numbered fixture in a floor
plan.

Note: Fixture Numbers can be seen in the Merchandiser
module, or in In-Store Space collaboration. Alternatively
they could be identified from a report.
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All Bays
If the All Bays radio button is selected, the Bay Numbers and Fixture Identifier options
will be grayed out and unavailable.

Bay Numbering
If the Bay Numbers radio button is selected, the Fixture Identifier option will be grayed
out and unavailable, while the Bay Numbers option will be available. There are two ways
to add Bay Numbers to the list of bay numbers:

1. By typing in the required Group Name and Numbers into the Group Name and
Number text boxes and clicking the Add icon. (Numbers can be entered as a range
separated by a hyphen: for example 5-23).

2. By clicking on the button with ellipses to open the Bays dialog box, highlighting a
row and clicking the OK button.

Fixture Identifiers
If the Fixture Identifier radio button is selected, the Bay Numbers option will be grayed
out and unavailable, while the Fixture Identifiers option will be available. Fixture
identifiers must be added manually - the identifiers text box will accept a list of comma
separated numbers and number ranges where number ranges are connected by a
hyphen, e.g. 5012-5211.

Planogram Substitution Assistant

Overview of Planogram Substitution Assistant
The Planogram Substitution Assistant aids users to set up Planogram Substitution
Definitions. It can be accessed from:

1. The Substitution Assistant option on the tools menu or the toolbar of the Planogram
Substitution dialog box. If selected in this manner, the Assistant will be blank and all
information will have to be entered.

2. The Substitution Assistant option on the tools menu or the toolbar of the Planogram
Substitution Definition dialog box. If selected in this manner, the Assistant may be
partially populated with data.

The Planogram Substitution Assistant works in three broad stages.
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The initial stage is to select a planogram (or planogram) as the basis for the substitution.
This is done using the Existing Planograms page of the Assistant.

In the above example, the 8 foot planogram 'A' has been selected.

The second stage is to select any adjacent planograms it is desired to include in the
substitution. This is done using the Adjacent Planograms page of the Assistant. In the
above example, the 12 foot planogram 'B' and the 4 foot planogram C have been selected
as suitable for replacement and adjacent to planogram 'A'. The purpose of this is to allow
the user to expand the area available to substitute planograms in. If adjacent planograms
have a low Planogram Financial Weighting score, it may be sensible to include those in
the list of planograms to be substituted.
The final stage is to select the replacement planograms. This is done using the New
Planograms page of the Assistant.

In the above example the 8 foot planogram 'D', the 4 foot planogram 'E' and the 12 foot
planogram 'F' have been selected to replace the original planograms 'A', 'B' and 'C'.

Note: The Assistant also enables users to select the floor plan
statuses and stores the substitutions will be valid for.

On completion of the steps within the Planogram Substitution Assistant the user will be
taken to the Planogram Substitution Definition dialog box, which will have been
populated with information from the Planogram Substitution Assistant.

Planogram Substitution Assistant Pages
The Planogram Substitution assistant consists of three pages. Users can move through
these pages using the next or back buttons in the lower right corner. Each successive page
assists users with one or more aspects of defining a planogram substitution.

First Page - Existing Planograms
The Existing Planogram page allows users to manually select the planograms that will
substituted.
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Users can select or deselect planograms for substitution and change the order in which
they will be substituted.

Clicking the Next button takes users onto the next page where the Assistant will open in
the Status tab.

Second Page - Status Tab
The Status Tab enables the user to select the file statuses that the planogram substitution
will operate on. Current status will only be visible if the
PLANOGRAM_ SUBSTITUTION_COPY_FILE System Variable is set to On.

Clicking the Next button will take the user onto the Adjacent Planograms tab.

Second Page - Adjacent Planogram Tab
The Adjacent Planogram page enables users to select planograms that are to the left, right
or sharing the same fixture as the planograms selected in the Existing Planogram page.



Planogram Substitution

Admin Merchandising 335

Clicking the next button will take the user onto the New Planogram page - to so to the
stores tab, click manually on it.

Second Page - Stores Tab
The stores tab enables users to select the stores that the planogram substitutions will be
carried out in.

Note: This dialog box works in the reverse sense from the
Planogram Substitution Definition dialog box. The stores the
planogram substitution will be carried out are in the left
hand pane.

Click manually on the Adjacent Planograms tab, and then click the Next button to go to
the New Planograms page.

New Planogram Page
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The New Planogram page enables the user to select the planograms that will replace the
planograms to be substituted.

After the required new planograms have been selected, clicking the Finish button will
take the user to the Planogram Substitution Definition dialog box.

Opening Status of Planogram Substitution Assistant
The Planogram Substitution Assistant can be opened from either the Planogram
Substitution dialog box or the Planogram Substitution Definition dialog box. Which page
the Assistant opens in will be determined by the information already defined in the
Planogram Substitution.
1. If no existing planograms have been selected then the Existing Planograms window

will be displayed.

2. If existing planograms have been set but no new planograms have been defined then
the adjacent planograms window will be displayed.

3. If both existing planograms and new planograms have been set then the new
planograms window will be displayed.

Adjacency Calculations
Prior to using the Planogram Substitution Assistant, two forms of Adjacency calculation
should have been run:
1. Fixture Adjacencies

2. Product Adjacencies

If planogram substitutions are only to be carried out in a few drawings, Fixture and
Product Adjacencies can be run manually using the options from the Calculation menu
or toolbar.
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If a large number of drawings are to have planogram substitutions made, then running
the Fixture and Product Adjacencies as a batch process may be the most effective may of
preparing to use the Planogram Substitution Assistant.

Note: If Fixture and Product Adjacencies are not run, the
results displayed in the Adjacent Planograms tab of the
Planogram Substitution Assistant may not be accurate.

Existing Planogram Page
The Existing Planogram enables users to add or remove planograms from the list of those
to be substituted.

Description of the Existing Planogram Page
The New Planogram Page consists of a number of parts.

1. The Toolbar contains the options available to the User

2. The Planogram Hierarchy contains the list of planograms available for selection for
substitution

3. The Planogram Properties window shows properties for the planogram currently
highlighted in the Planogram Hierarchy.

4. The Planograms for Substitution contains the list of planograms that will be
substituted for by fresh planograms when a planogram substitution is run.

The toolbar contains the following options:

Icon Option

Cut

Copy

Paste
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Icon Option

Find

Add Planogram to List

Delete Planogram from
List

Promote Planogram in
List

Demote Planogram in
List

Help

Using the Existing Planogram Page
Opening status of the Existing Planogram Page
The Planogram Substitution Assistant will open in the Existing Planogram page if no
planograms have been defined as suitable for substitution.

Planogram Hierarchy
Two factors need to be taken into account when using the Planogram Hierarchy:

 The Planogram Hierarchy will only contain the latest revision of a planogram for any
given planogram lineage.

 Which planograms are visible to a specific User will be governed by which User
Groups they have been assigned to and what branches of the planogram hierarchy
those User Groups have access to. (This is configured in the Administration module).

Adding and Deleting Planograms
There are several ways planograms can be added or deleted:

 Planograms can be selected by dragging a planogram or a planogram group from the
hierarchy and dropping it to the existing planograms list on the right-hand side of
the existing planograms window.

 Planograms can be added to the existing planograms list by highlighting an item in
the hierarchy and selecting the Add Existing Planogram option from the toolbar.

 Planograms can be added to the existing planograms by using the Find… option on
the toolbar.

 Planograms can be added to the existing planograms by using the paste option to
paste in a planogram name or planogram code. The rest of the row of data will
populate automatically.

If a planogram group is selected from the hierarchy then all of the planograms that are
direct descendants of the group will be added to the selection set.

Reordering Planograms
The list of planograms can be reordered by means of the up or down arrows on the
toolbar.

 The up and down toolbar options will be enabled when one or more consecutive
rows are selected in the existing planograms list. They will be grayed out if the
selected rows are not consecutive or no rows are selected.
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 Using the up or down arrows will promote or demote the selected rows in the
sequence that planograms are substituted. The planogram at the top of the list will
be substituted first, the next in the list second, etc....

Cut Copy and Paste Functionality
The cut, copy and paste functionality has two main functions:

1. To edit the list of Existing Planogram Substitutions.

2. To transfer data to and from external applications.

Editing the list of Existing Planograms
The list of existing planograms can be edited as follows:

 Planograms can be added to the existing planograms by using the paste option to
paste in a planogram name or planogram code. The rest of the row of data will
populate automatically.

 Planograms can be removed from the list of existing planograms by highlighting
rows and using the Cut option.

Transferring Data to and from External Programs
Data can be transferred to and from external programs (for example a spreadsheet) by:

 Highlighting data in the Planogram Hierarchy, Properties Window or list of existing
Planograms. Data can then be transferred to the Clipboard by means of the Copy
command. Once the external program (for example a spreadsheet) is open, the Paste
command can be used within that program to enter the data.

 Highlighting data in an external program (for example a report) and using the Copy
command to transfer it to the Clipboard. Once in the Planogram Substitution
Assistant, the Paste command can be used to add Planogram Names or Planogram
Codes to the list of existing planograms.

The Next Button
The Next button will not be enabled until there is at least one planogram in the existing
planograms list.
Once the Next button is enabled, clicking it will take the User to the Adjacent Planograms
Page - the next stage in the Planogram Substitution Assistant.

Adjacent Planogram Page
The adjacent Planogram page is used to expand the selection of planograms. Examples of
why the selection might need to be extended are:

 A specific planogram is performing well and it has been decided to expand the
amount of fixturing allocated to that type of merchandise.

 A specific planogram is performing poorly and it has been decided to replace that
planogram and any adjacent planograms with alternative merchandise that will
generate more profit.

 The store is being reorganized and it has been decided to replace one form of
merchandise with another.

Description of the Adjacent Planogram Page
The Adjacent Planograms page has three tabs. These are intended to be used in
sequence:

1. Statuses - select the store plan statuses that adjacencies will be found in

2. Adjacent Planograms - list adjacent planograms and allow the user to select them

3. Stores - select the store plans that adjacencies may exist in.
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The Statuses Tab
The Status tab is used as a filter to determine which statuses floor plans will be checked
for planograms that are adjacent to the existing planograms selected for substitution.

The Status tab contains a list of statuses for files. These are read from the database and
may be different for specific implementations of Macro Space Management.

 Historical Status is not shown as this represent store plans that have been taken out
of service.

 Authorized Status will be checked by default.

For example, if the user has selected Authorized status, only planogram adjacencies in
store plans of that status will be reported.

Note: Current status will only be visible if the
PLANOGRAM_SUBSTITUTION_COPY_FILE system
variable is set to On (1).

Statuses can be selected by means of the check boxes. A minimum of one status must be
selected before the Next button is enabled and the User can move on to the Adjacent
Planograms page. When the Next button is pressed, the list of Adjacent Planograms will
be populated in the Adjacent Planograms page using the selected statuses as a filter for
which store plans are to be checked.

The Adjacent Planograms Tab
The Adjacent Planograms tab allows users to select additional planograms bordering the
original planogram(s) selected for substitution. Adjacencies will be established for all
store plans with file statuses selected in the Status tab.
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Planograms are selected for substitution by means of the check boxes.

 The Main planogram is the original planogram selected for substitution.

 A planogram with an adjacency of Left is to the left of the main planogram.

 A planogram with an adjacency of Right is to the right of the main planogram.

 A planogram with an adjacency of Same shares the same fixture as the main
planogram.

Selecting Adjacent planograms for substitution allows users to expand the area that
planograms will be substituted into. A good way of determining whether it is
appropriate to expand the selection is the Score (Planogram Substitution financial
weighting). A low score indicates the products on the adjacent planograms are not selling
well, a high score the converse.

Care needs to be taken in understanding how adjacent planograms are generated.

In the above example, the existing planogram is A. In store 1, planograms B and C are
adjacent to it. In store 2, planograms D and E are adjacent to it. The Adjacent Planograms
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tab will show Planogram A (the main planogram) as having Planograms B, C, D and E
adjacent to it.

Two separate Planogram Substitution definitions will be required to substitute these
planograms:
 Planogram A, with its adjacent Planograms B and C will require one definition

 Planogram A, with its adjacent Planograms B and C will require another.

Determining which adjacent planograms are valid to add for a substitution may require
inspection of the data.

 If only a single 'Existing Planogram' is selected, if all planograms are the same in all
selected store plans, there will only be one planogram adjacent to the left and one to
the right. (With possibly another planogram with 'Same' adjacency). More than this
number of adjacent planograms suggests that the planograms adjacent to the
'Existing Planogram' may vary from store plan to store plan.

 If multiple 'Adjacent Planograms' exist, inspection of the number of stores plans that
a planogram is in will give information on how frequently that adjacency occurs.

There are two ways further information can be obtained:
1. On completing the Planogram Substitution Assistant, the User will be taken to the

Planogram Substitution Definition dialog box. Clicking the Dry Run option will
produce a report showing which substitutions are successful and which were not.
This will allow specific store plans in which this Planogram Substitution is valid to
be identified.

2. Alternatively, the User can complete the Planogram Substitution Assistant, save the
resulting Planogram Substitution Definition, and then go to the Planogram
Substitution dialog box. Clicking the Dry Run option will produce a global report
showing which substitutions are successful and which were not. This will allow
Planogram Substitutions to be refined by being made more store specific.

Once the required adjacent planograms have been selected, the User has two options:

1. If the User clicks the Stores tab they will be taken to the stores tab to restrict the
Planogram Substitutions to specific stores.

2. If the User clicks the Next button they will be taken to the New Planograms page.

The Stores Tab
The Stores tab is used to further restrict which stores planograms will be substituted in.
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Stores can be deselected by dragging and dropping them from the Store hierarchy to the
right hand pane. After the list of stores that substitutions will be carried out in has been
modified, Users should return to the Adjacent Planograms tab to see that the selected
planograms are still available for substitution.

Note: This dialog box works in the reverse sense from the
Planogram Substitution Definition dialog box. The stores the
planogram substitution will be carried out in are in the left
hand pane.

The Stores tab initially populates with a list of all stores that the planogram substitutions
are to be carried out in. This list is determined by the settings in the Status Tab. After any
required adjacent planograms have been defined in the Adjacent Planogram tab, it may
be necessary to make the Planogram Substitution store specific. This is because not all
stores have the same arrangement of planograms.

The Adjacent Planogram Page
When the tab is opened, the 'All stores where planogram adjacency found' check box can
be checked to ensure that the planogram substitution is carried out in all selected stores.
Alternatively, the checkbox can be unchecked, allowing users to make the planogram
substitution store specific. Initially all stores are selected and are in the hierarchy on the
left. Moving stores to the pane on the right deselects them from the list of stores the
substitution will be carried out in. There are several ways of achieving this:

 Stores can be deselected by dragging a store or a cluster from the hierarchy and
dropping it to the list view on the right-hand side of the store specific group. When a
cluster is selected from the hierarchy then all of the stores that are descendants of the
cluster will be deselected.

 Stores can be deselected by highlighting an item in the hierarchy and pressing the
store toolbar button. When a cluster is selected from the hierarchy then all of the
stores that are descendants of the cluster will be deselected.

 Using the Find option to deselect stores.
Stores that have been added to the selection set will be grayed out in the hierarchy. If the
stores that have been deselected contain all examples of a particular type of adjacent
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planogram, that planogram will no longer show as adjacent when the user reverts to the
Adjacent Planogram tab.

When the store hierarchy has been modified as required, the user must return to the
Planogram Adjacencies tab, where clicking the Next button will take them to the New
Planograms tab.

New Planograms Page
The New Planograms Page allows Users to select the planograms that will be the
replacement for the planograms that have been selected for substitution.

Description of the New Planograms Page
The New Planograms page is used to specify the planograms that will replace those
selected for substitution.

1. The Toolbar contains the options available to the User

2. The Planogram Hierarchy contains the list of planograms available for selection for
substitution

3. The Planogram Properties window shows properties for the planogram currently
highlighted in the Planogram Hierarchy.

4. The Planograms for Substitution contains the list of planograms that will be
substituted for by fresh planograms when a planogram substitution is run.

5. The Planograms to Be Added contains a list of the planograms that will
replace the substituted planograms.

The toolbar contains the following options:
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Icon Option

Cut

Copy

Paste

Find

Add Planogram to List

Delete Planogram from
List

Promote Planogram in
List

Demote Planogram in
List

Help

Using the New Planogram Page
Opening status of the New Planogram Page
The Planogram Substitution Assistant will show in the New Planogram page existing
planograms that have been designated for substitution and any associated adjacent
planograms.

Planogram Hierarchy
Two factors need to be taken into account when using the Planogram Hierarchy:

 The Planogram Hierarchy will only contain the latest revision of a planogram for any
given planogram lineage.

 Which planograms are visible to a specific User will be governed by which User
Groups they have been assigned to and what branches of the planogram hierarchy
those User Groups have access to.

Adding and Deleting New Planograms

Note: Only New Planograms can be added or deleted in this
page. To change the list of Existing Planograms, Users must
go back to the Existing Planograms tab.

There are several ways planograms can be added or deleted:
 Planograms can be selected by dragging a planogram or a planogram group from the

hierarchy and dropping it to the new planograms list on the right-hand side of the
existing planograms window.

 Planograms can be added to the new planograms list by highlighting an item in the
hierarchy and selecting the Add Existing Planogram option from the toolbar or Tools
menu.

 Planograms can be added to the new planograms by using the Find… option on the
toolbar or Edit menu.
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 Planograms can be added to the new planograms by using the paste option to paste
in a planogram name or planogram code. The rest of the row of data will populate
automatically.

If a planogram group is selected from the hierarchy then all of the planograms that are
direct descendants of the group will be added to the selection set.

Reordering New Planograms
The list of new planograms can be reordered by means of the up or down arrows on the
toolbar.

 The up and down toolbar options will be enabled when one or more consecutive
rows are selected in the existing planograms list. They will be grayed out if the
selected rows are not consecutive or no rows are selected.

 Using the up or down arrows will promote or demote the selected rows in the
sequence that planograms are substituted. The planogram at the top of the list will be
substituted first, the next in the list second, etc....

Cut, Copy and Paste Functionality
The cut, copy and paste functionality has two main functions:

1. To edit the list of New Planograms.

2. To transfer data to and from external applications.

Editing the list of Existing Planograms
The list of existing planograms can be edited as follows:

 Planograms can be added to the new planograms by using the paste option to paste
in a planogram name or planogram code. The rest of the row of data will populate
automatically.

 Planograms can be removed from the list of new planograms by highlighting rows
and using the Cut option.

Transferring Data to and from External Programs
Data can be transferred to and from external programs (for example a spreadsheet) by:

 Highlighting data in the Planogram Hierarchy, Properties Window or list of new
Planograms. Data can then be transferred to the Clipboard by means of the Copy
command. Once the external program (for example a spreadsheet) is open, the Paste
command can be used within that program to enter the data.

 Highlighting data in an external program (for example a report) and using the Copy
command to transfer it to the Clipboard. Once in the Planogram Substitution
Assistant, the Paste command can be used to add Planogram Names or Planogram
Codes to the list of new planograms.

The Finish Button
The Finish button will not be enabled until there is at least one planogram in the new
planograms list.

Once the Finish button is enabled, clicking it will take the User to the Adjacent
Planograms Page - the next stage in the Planogram Substitution Assistant.

Find Dialog Box

Introduction to Find Dialog Box
This section of the User Guide describes the Find dialog box. There are two variants:
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1. Find dialog box in the Planogram Substitution dialog box allowing users to identify
specific planogram substitutions.

2. Find dialog box on the Planogram Substitution Definition and Planogram
Substitution Wizard dialog boxes enabling users to identify stores and planograms.

In addition Administrators have the option of using a Custom SQL statement to set up a
customized search.

Note: These dialog boxes are essentially the same. When
called in the Planogram Substitution dialog box, there is no
results tab because results are highlighted in the list of
available planogram substitutions. When called in the
Planogram Substitution Definition and Planogram
Substitution Wizard dialog boxes, a results tab allows users
to manually select from within a result set.

Custom Queries
All Find dialog boxes have the option to use a Custom SQL statement. This can be used
to develop a client specific search option. The Custom SQL statement is invoked by
checking the Use Custom Search Query in the Find dialog boxes.

Custom queries are set up in the Administration module by invoking the Custom Query
from the General menu. This dialog box allows Administrators to set up a client specific
query using Custom SQL. At present three forms of search can be customized:

1. Stores

2. Planograms
3. Planogram Substitution Events
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Custom SQL is specific to Space Planning and is an extension of standard SQL. The code
is able to insert items of data into the curly brackets {Braces} to modify the SQL statement
every time a user enters a text string into the text box of the Find dialog box.

In the above example, the query will use the text entered into the Search String Text box
in the Find dialog box and substitute the values in the 'Where ' clause in the Custom SQL
statement.

For example, if the user entered a Store Code of ABC-123 into the Search String Text box
the 'Where' clause would be converted to WHERE STR_NAME LIKE '%ABC-123%'. The
results tab of the Find dialog box would then populate with all Store Name s matching
the text in the Search String Text box in the Find dialog box.

Note: The information within the curly brackets {Text}
assumes implied wild cards.

In order to save a new or modified piece of Custom SQL it must first be tested. This is
done by clicking the Search Query Test icon on the toolbar. If the Custom SQL
satisfactorily passes test, the Save icon will be enabled and the new or modified piece of
Custom SQL can be saved.

Find Dialog Box - Planogram Substitution Dialog Box
The Find functionality in the Planogram Substitution dialog box consists of a text box for
the search text, a Find icon to initiate the search and a Find Options drop down option to
set the filters for the find operation.
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The sequence of operations is:

1. Set the Filters in the Find dialog box (Find Options)

2. Enter the text string in the Search text box

3. Click the find icon
4. The first matching result in the list of planogram substitutions will be highlighted.

5. Successive clicks of the Find icon will step through the other matching results.

Find Options (Filters)
The Find Options allow the user to set filters by which to filter results obtained. There are
two tabs:

1. Search tab - where the fields to search in and the columns to display are specified.

2. Filters tab - where the filters for the results can be set

3. The check boxes in the Search frame specify whether the search should be carried
out on the Name, Created by (User Name) or Modified by (User Name).

4. The check boxes in the display frame specify the columns that will be displayed in
the results.
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Find Options - Filters Tab

This tab allows the user to set filters for:

 Planogram Substitution Name

 Planogram Substitution Status
 Effective and Execution Dates

 Created by (User Name)

 Creation Date

 Priority

Find dialog box - Planogram Substitution Definitions and Assistant
The Find dialog box that is called from the Planogram Substitution Definition and
Planogram Substitution Assistant dialog boxes operates in a similar manner to that called
from the Planogram Substitution dialog box. The primary difference is that these dialog
boxes have a Results tab that is used instead of populating the results into the main
dialog boxes.
Depending on the tab in the Planogram Substitution Definition and Planogram
Substitution Assistant dialog boxes, the Find dialog box will automatically be set to
search for either Stores or Planograms.

It has four main parts:

1. The Text Box - for entering a search string.
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2. The Search Type drop down list - this is automatically set to the appropriate type of
object to search for.

3. A check box allows the user to use a custom search

4. Tabs allow users to look at the Results, or set the required Fields or Filters. The fields
and filters will vary depending on whether the search is for Stores or Planograms.

To use the results tab:

1. Enter text into the text box and press [Return].
2. Highlight the required result in the list of results and click Ok.

3. The check boxes in the Search frame specify whether the search should be carried out
on the Planogram Name, Description, etc.

4. The check boxes in the display frame specify the columns that will be displayed in
the results.

Using the Find Dialog Box
The find dialog box has three tabs: Results, Fields and Filters. The Fields and Filters tabs
will vary according to the type of object being searched for.

Searching for Stores
Users can search for stores when in a tab in the Planogram Substitution definition or
Planogram Substitution Assistant dialog boxes that requires the selection of stores. In this
case 'Stores' is pre-selected in the Look For' drop down list. The Find dialog has three
tabs.

Results Tab
The Results tab will contain the results from the text string in the 'Find What' text box
modified by the settings in the Fields and Filters tab. To search:

1. Enter text into the text box and press {Return].
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2. Highlight the required results in the Results pane and click OK. The highlighted
results will be added to the list of stores the substitution will be carried out in.

Fields Tab
The Fields tab allows users to select the fields that the text string in the Find What text
box will be checked against.
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3. The check boxes in the Search frame specify whether the search should be carried
out on the Store Name, Store Code or Parent Cluster.

4. The check boxes in the display frame specify the columns that will be displayed in
the results.

The Filters Tab
The Fields tab allows users to filter the fields that the text string in the Find What text
box will be checked against.
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 If the Cluster type check box is checked Users, can filter the results to restrict them to
stores belonging to specific types of clusters in the Store Manager module.

 If the Store Status check box is checked, Users can filter the results to restrict them to
stores belonging to specific store statuses (assigned in the store manager
module).

Searching for Planograms
Users can search for planograms when in a tab in the Planogram Substitution definition
or Planogram Substitution Assistant dialog boxes that requires the selection of
planograms. In this case 'Planograms' is pre-selected in the Look For' drop down list. The
Find dialog has three tabs.

Results Tab
The Results tab will contain the results from the text string in the 'Find What' text box
modified by the settings in the Fields and Filters tab. To search:

1. Enter text into the text box and press {Return].

2. Highlight the required results in the Results pane and click OK. The highlighted
results will be added to the list of stores the substitution will be carried out in.
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Fields Tab
The Fields tab allows users to select the fields that the text string in the Find What text
box will be checked against.
Any checked option will be tested against the text string and any matching results
populated into the Results tab.
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The check boxes in the Search frame specify whether the search should be carried out on
the Planogram Name, Planogram Description, etc.

The check boxes in the display frame specify the columns that will be displayed in the
results.

Note: Some of the fields that can be searched depend on the
information being brought in during imports of planograms.
Depending on how this import is configured, it is possible
for one or more of these fields to contain null values.

The Filters Tab
The Filters tab allows users to filter the fields that the text string in the Find What text
box will be checked against.



Planogram Substitution

Admin Merchandising 357

 If the Effective date check box is checked Users can filter the results to restrict them
to planograms with effective dates between the specific dates.

 If the Expiry date check box is checked Users can filter the results to restrict them to
planograms with expiry dates between the specific dates.

 If the revision check box is checked, users can enter revision numbers. Multiple
revision numbers can be entered if separated by a comma.

 If the planogram status check box is checked, users can filter the results to
planograms of those selected statuses.

Searching Using Custom Queries
It is also possible to set up Custom Queries. These allow Implementers or Administrators
to set up a search specific to a client's requirements.

Setting up Custom Queries
Custom Queries are set up using the Custom Query dialog box available from the
General menu in the Admin module.
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Implementers or Administrators can write custom search queries for:

 Planograms

 Planogram Substitution Definitions

 Stores

The query takes the form of a SQL Statement modified to allow for additional
functionality added in Macro Space Management. This functionality is the {text} field in
the 'Where' clause. The code will select the text entered into the Search String Text box in
the Find dialog box and substitute the values into the {text} fields in the 'Where ' clause in
the Custom SQL statement.

For example, if the user entered a Store Code of ABC-123 into the Search String Text box
the 'Where' clause would be converted to WHERE STN_NAME = 'ABC-123' OR
STR_CODE = 'ABC-123'. The results tab of the Find dialog box would then populate with
all results matching Store Code Search String Text box ABC-123.

Using the Find Dialog Box with Custom SQL.
The Find dialog box behaves slightly differently if the Custom Search Query check box is
selected.
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The selection made in the Search type drop down list will determine the type of Custom
SQL statement used. The data entered into the Text Box will then be substituted into the
'Where' clause of the custom SQL statement. Any matches will be displayed in the results
tab.

Only the Results tab will be active with the Fields and Filters tabs disabled. The columns
in the Results tab will be determined by the fields specified in the 'Select' statement of the
Custom SQL statement.

Dry Run and Planogram Substitution Logs

Dry Run Log
Dry Runs test defined planogram substitutions by reading the data from the database,
then determining if the defined substitutions would be successful. The results enable
administrators to determine which substitutions will error when run. Any substitutions
that errors during a dry run can be corrected prior to being run for real.
The Dry Run functionality can be invoked from the toolbar in the Planogram Substitution
dialog box.

Alternatively, it can be called from the tools menu.

If specific planogram substitutions have been highlighted in the Planogram Substitution
dialog box, the dry run will be restricted to those planogram substitutions. If no
substitutions have been highlighted.
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The results appear in the Dry Run Log. This will appear automatically at the end of a Dry
Run. Alternatively, it can be called from the View menu. Within the log Users can filter
by:

1. Log Start Date and Time
2. Planogram Substitution Event (Name)

3. User Name of person carrying out dry run

4. Status of warnings

Two levels of detail can be obtained in the Dry Run Log:

Summary View
This option gives a summary of the planogram substitutions specified in the filters,
reporting on the total number of files and stores processed normally, with warnings and
with errors.

Detailed View
This option gives a detailed view of the individual planogram substitutions that meet the
criteria specified in the filters. Information includes:

 Stores processed successfully, or with warnings or errors.

 Floor plans processed successfully or with warnings or errors.

 Number of planograms that would be substituted.

Planogram Substitution Log
The Planogram Substitution Log gives the results of planogram substitutions. The Log
can be called from the Toolbar or the View menu.
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This will bring up the Planogram Substitution Log:

Within the log Users can filter by:

1. Log Start Date and Time

2. Planogram Substitution Event (Name)

3. User Name of person carrying out dry run

4. Status of warnings
Two levels of detail can be obtained in the Planogram Substitution Log:

Summary View
This option gives a summary of the planogram substitutions specified in the filters,
reporting on the total number of files and stores processed normally, with warnings and
with errors.

Detailed View
This option gives a detailed view of the individual planogram substitutions that meet the
criteria specified in the filters. Information includes:

 Number of planograms substituted.
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 Whether revision (version) change has been carried out.

 Results of substitutions and revision change.

Batch Operations

Batch Operations

Capabilities of Batch Scheduling Tool
The full capability of some of the command line switches (for example /t and /p) can
only be used by a sophisticated batch scheduling tool. A simpler batch scheduling tool
may have fewer capabilities.

Syntax for Batch Operations
The Syntax for Batch Operations will be of the format:

BatchRunner /substitution user name/password [/t] [/p] [/e definition_name_1,
definition_name_2, …, definition_name_n] [/c code_1,code_2, …,code_n] [/s id_1, id_2,
…, id_n]

Switches are not case sensitive: /t and /T will have the same effect.
1. Batch Runner will identify the batch scheduling too used to run the batch processes.

2. The /Substitution switch is a compulsory switch to identify the process to be run as
planogram substitution.

3. The username/password is mandatory. They will be validated against user
information defined in the Functional Security option in the Administration module.

4. The /t switch is an optional switch and allows the external program invoking
planogram substitution to terminate execution of any running planogram
substitution definitions rather than waiting for the full list of substitutions to
complete.

5. The /p switch will be an optional switch and allows the external program invoking
planogram substitution to pause execution of any running planogram substitution
definitions.

6. The /e switch will be an optional switch and will identify the planogram substitution
definitions that are to be run.

7. The /c switch will be an optional switch and will identify the stores filter that is to be
applied to the planogram substitution process.

8. The /s switch will be an optional switch and will identify the status filter that is to be
applied to the planogram substitution process.

Details of Syntax
This section details the specific Syntax required for each option in the batch files used to
call the planogram substitution functionality.....

User Name/Password
The user name/password is mandatory. They must meet the following criteria:

1. The User must be a member of a User Group with a User Group Type of 'Admin
User'.

2. The User must be a member of a User Group with permissions to use planogram
substitution.

3. The user name and password must be included within double quotes if they contain
a space or forward slash character.
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If validation fails, then planogram substitution will terminate with the following entries
written to the error log:

1. "Date and time when invalid username or password was supplied.

2. "The machine name used to send the invalid username or password.

The /t Switch
The /t switch allows the external program invoking planogram substitution to terminate
execution of any running planogram substitution definitions. This might be
because there in only a three hour period available to run planogram substitutions in and
the process has to be terminated at a specific time.
The time period planogram substitution will run for has to be set in the external program
running planogram substitution as part of a batch process; the /t switch
merely allows the possibility of stopping the planogram substitutions before they have
all executed.

If the external program terminates planogram substitution, the following entries will be
written to the process log:

1. Date and time when definition stopped.

2. Name of definition stopped
3. User name used to send terminate message.

The /p Switch
The /p switch allows the external program invoking planogram substitution to pause
execution of any running planogram substitution definitions. This might allow
planogram substitution to be paused while another batch process is executed.

The time period planogram substitution will be paused at has to be set in the external
program running planogram substitution as part of a batch process; the /p switch merely
allows the possibility of stopping the planogram substitutions. If planogram substitution
is paused, the application will ensure that the store plans are
in a valid state. If necessary, they will be checked in. The process will remain active and
wait until the process is resumed again.

If a planogram substitution is paused the following entries will be written to the process
log:
1. "Date and time when definition paused.

2. Name of definition paused.

3. User name used to send pause message.

If a planogram substitution is resumed the following entries will be written to the
process log:

1. Date and time when definition was resumed.
2. Name of the resumed definition.

3. User name used to resume the definition.

Pause Command while Planogram Substitutions are being manually run
The /p switch will pause all planogram substitutions currently running. As it is possible
for as user to be manually running planogram substitutions in a store plan,
while others are being run automatically via a batch process, the application will allow
users to manually resume their substitutions. This will be via a confirmation dialog
saying "Pause received from user name via the command line. Pause processing?"

1. If the User selects OK on the confirmation dialog, the dialog will close and the
planogram substitution process will pause. The pause button on the planogram
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substitution progress dialog will be grayed out and the play and stop buttons will be
enabled.

2. Pressing Cancel on the confirmation dialog will close the dialog and leave the
manually initiated process processing the planogram substitution definitions

The /e Switch
The /e switch is optional. It can be used to specify a list of planogram substitutions to
run. It is of the format:

/e definition_name_1, definition_name_2, …, definition_name_n

The definitions will be identified by a comma separated list of definition names. The
definition names must be included within double quotes if they contain a space or
forward slash character.
The /c Switch

The /c switch is optional. It can be used to specify a list of store codes identifying the
stores against which planogram substitutions should be run. It is of the format:

/c code_1,code_2, …,code_n

Store Codes can be found in the Store Code text box of the Edit Store dialog box in Store
Manager. Alternatively, they can be identified from a report containing the STR_ CODE
field in the AVTTB_STORE table.

The /s Switch
The /s switch is optional. It can be used to specify the list of file statuses against which
planogram substitutions should be run. It is of the format:

/s id_1, id_2, …, id_n

The statuses will be identified by a comma separated list of status codes. A range of
status codes will be identified by two strings separated by a hyphen character. Status
codes will be assumed to be in numeric and then alphabetical order allowing for possible
leading zeros.

Status codes can be found in the Status dialog box accessed from the General Menu of the
Administration module. Alternatively, they can be identified from a report containing
the STA_CODE field from the AVTTB_STATUS table.

Business Flows

Overview of Business Flows
Planogram Substitution needs to be integrated with the wider activities within Macro
Space Management. The flowchart below summarizes those activities.
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Setting up within the Admin Module
The first stage for preparing for planogram substitutions is carried out within the Admin
module. Three actions are required:

1. Setting up System Variables

2. Setting up Custom Queries for the Find dialog box in Planogram Substitution

3. Setting up the Planogram Financial Weighting settings

Setting Up System Variables
The first stage for setting up Planogram Substitution operations is to set the system
variables that affect the functioning of planogram substitution. These have a global effect
and it is recommended that once the settings have been made, they are not changed
unless strictly necessary.

Three system variables have a significant impact on the way the functionality operates.
Each can be set using the System Variables option on the General menu in the Admin
Module.

PLANOGRAM_SUBSTITUTION_COPY_FILE
1. Current status will be available for selection in the Status tabs of the Planogram

Substitution Definition dialog box and the Planogram Substitution Assistant.

2. Files of Current status are Read Only. If planogram substitutions are carried out in
them the functionality will first attempt to make the planogram substitutions in an
Authorized file on the same floor if one exists with a matching Effective Date. If a
suitable Authorized file does not exist, the functionality will create one in the same
Revision as the Current file - a process called Cloning.

This system variable determines whether files of Current status can be used as the basis
for planogram substitutions. If set to 1 (On) then:
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If set to 0 (Off) then it will not be possible to select floor plans of current status for
planogram substitution - and hence no cloning of files will take place.

PLANOGRAM_SUBSTITUTION_RUN_CALCS
This system variable (0 = Off, 1 = On) determines whether the Product Adjacency
calculation will be run prior to carrying out planogram substitutions. This enables the
functionality to ensure that planograms required to be adjacent in the Planogram
Substitution definition are still adjacent in the drawing. Running the product adjacency
calculation increases the accuracy of planogram substitution, but will increase the overall
time required.

Note: This situation could occur if the planogram
substitution was defined some time before it was run, and
planograms have been manually moved in a floor plan since
that date.

Whether this system variable should be set to On or Off also depends on the batch
processes in use. If Automated Calculations are being run immediately before planogram
substitution, then there will not be a need for the
PLANOGRAM_SUBSTITUTION_RUN_CALCS system variable to be set to On.

PLANOGRAM_SUBSTITUTION_LOG_EXPLODED
This system variable is not currently in use.

PLANOGRAM_SUBSTITUTION_LENGTH_TOLERANCE
This system variable sets the default length tolerance that appears in the Rules tab of the
Planogram Substitution Definition dialog box.

PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE
This system variable sets the default depth tolerance that appears in the Rules tab of the
Planogram Substitution Definition dialog box.

PLANOGRAM_SUBSTITUTION_HEIGHT_TOLERANCE
This system variable sets the default height tolerance that appears in the Rules tab of the
Planogram Substitution Definition dialog box.

PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED
This system variable determined how planograms in a different form (2D, 2.5D or 3D) to
the planogram being brought in as a replacement are processed during the substitution
process.

Note: this system variable will have a significant impact on a
number of important aspects of functionality. The setting of
this system variable should be considered carefully.

Setting up Custom SQL for the Find Dialog Box
The find dialog box used in the Planogram Substitution, Planogram Substitution
Definition and Planogram Substitution Assistant dialog boxes has the facility to carry out
client specified searches based on Custom SQL. This Custom SQL can be configured in
the Admin module using the Custom Query option on the General Menu in the Admin
Module.
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Note: For more information on using Custom Queries, see
the chapter on the Find dialog box.

Setting up Planogram Financial Weightings

The Planogram Financial Weighting dialog box is available from the Merchandising
module in the Admin Module.

Settings in this dialog box can be used in conjunction with financial data imported with
the planogram designs to give a score that can be used to decide between alternative
planograms in the Planogram Substitution Assistant (New Planograms page).

The financial weighting settings should be set up prior to beginning to set up planogram
substitution definitions. The weightings should not be changed unless there is a clear
case to do so, as repeatedly changing the weightings will not give a clear strategy for
choosing one planogram over another.

Batch Processes
Three potential batch processes impact on the operation of planogram substitutions.
These are:

1. Automated Calculations

2. Planogram Definition Imports
3. Planogram Substitution Schedule
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Automated Calculations
Automated Calculations can be run as a batch process using the
AVT5AutomatedCalcs.exe file installed in the C:\Program Files\Oracle
Retail\MSM\Apps directory.

One of the options for Automated Calculations is Product Adjacency. If this is run
immediately prior to running Planogram Substitutions as a batch process, then the
PLANOGRAM_SUBSTITUTION_RUN_CALCS system variable can be set to Off (0).

Planogram Design Imports
Planogram Designs are often imported as part of a batch process. The import can be used
for several purposes:

1. To import new planogram designs

2. To import updated versions of existing planograms (revisions)
3. To import updated financial information for planograms

This import schedule should be borne in mind when designing planogram substitutions
and deciding on the schedule to run the substitutions on.

Planogram Substitution Schedule
Planogram Substitutions can be run as a batch process. The timing of this needs to take
into account a retail organizations merchandising strategy - and hence how often
planogram substitutions will be run as a batch process.

Planogram Substitutions

Substitution Date Planning
Planogram substitution is used as part of an overall business process in order to update
the merchandise offered for sales within a retail organization. As such planogram
substitutions should be carried out to an agreed schedule - thus resulting in a fully
updated set of floor plans suitable for publishing to the pertinent stores for
implementation.

Preparing for Planogram Substitutions
Before planogram substitutions are defined, two actions ensure that the substitutions will
be based on the latest information:

Planogram Design Imports
The latest planogram information should have been imported. This information includes
both new planogram designs and revisions of existing designs. Planogram design
Imports will also include the latest financial information, enabling the financial
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weightings used to chose between alternative planograms in the Planogram Substitution
Assistant are fully up to date.

Planogram Financial Weightings
Planogram financial weightings are used to choose between alternative planograms in
the Planogram Substitution Assistant. Frequent imports of Planogram data ensure they
are fully up to date.

Planogram Substitutions
The planogram substitutions can then be set up. This can be accomplished by means of
the Planogram Substitution Definition dialog box or the Planogram Substitution
Assistant. The dates these planogram substitutions are scheduled to come into effect
should be dovetailed with the retails organizations merchandising objectives.

Dry Runs
Dry runs are used to confirm that the designated planogram substitutions will run
without problems when executed. They can be used in two different circumstances:

On completing defining a planogram substitution
Dry runs would be used to confirm that the recently completed planogram substitution
will work effectively. They provide a way of confirming that the planogram substitution
has been correctly specified by its designer.

Prior to running planogram substitutions in a batch process
It is possible that many planogram substitutions will have been defined some days or
weeks before they are run as a batch process. It is possible to carry out a dry run a day
prior to the batch process. This allows administrators to identify checked out drawings,
drawing with exploded planograms, etc., and correct them before the batch process
executes.

Running Planogram Substitutions
Planogram substitutions can be run if they match the following criteria:

1. The planogram substitution has a status set to approved

2. Floor plans must have a status assigned that matches the status set in the Status tab.
Floor plans of Proposed and Published status (and any custom statuses that have
been created) will be updated irrespective of any dates assigned to them.

Note: If planogram substitutions are run against floor plans
of Published status, it may be necessary to republish the
floor plan to the store.

3. For floor plans with a status of Authorized, the Effective date must fall within the
range of dates set in the Floor Plan Effective date in the Properties tab of the
Planogram Substitution Definition dialog box.

4. For floor plans of current status, they will only be cloned if the
PLANOGRAM_ SUBSTITUTION_COPY_FILE system variable is set to On (1).

Note: Current Files opened Read Only in the Planner or
Merchandiser Modules will also be cloned if substitutions
are manually run and valid substitutions exist.

5. For open files, the Active date (if set) must fall within the range of dates set in the
Floor Plan Effective date in the Properties tab of the Planogram Substitution
Definition dialog box.
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Planogram substitutions can be run in one of three ways.

1. Manually from within the Planner and Merchandiser modules on the current open
store plan.

2. Manually from within the Planogram Substitution module for single or multiple
planogram substitutions.

3. As a batch process.

Planogram Substitution Log
The Planogram Substitution Log (accessed from the Planogram Substitution dialog box)
enables Administrators to determine the success of each planogram
substitution. Unsuccessful substitutions can also be identified, corrected and re-run.

Post Substitution Operations

Synchronization in the Planner Module
Planogram substitutions are carried out by making changes directly in the database. For
example if the database tables show Fixture 1 as containing Planogram A before the
substitution, they will show it as containing planogram B after the substitution. The
Merchandiser Module and In-Store Space Collaboration read data directly from the
database, so will show the changes directly the drawing is next opened. The Planner
Module stores information in an AutoCAD DWG drawing. After planogram
substitutions have been made and the information in the database changed, the
information in the DWG drawing has to be brought into line.

This is done by means of the Synchronization dialog box.

Synchronizing 'Match the Database' will update the DWG drawing with the changes
made in the database.

Annotation in the Planner Module
After the drawing has been synchronized in the Planner Module, the drawing needs to
be re-annotated so that each planogram has the correct text associated with it. This is
done by selecting the Annotation option from the Retail toolbar in the Planner module.
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This will bring up the Annotation dialog box.

This dialog box can be used to re-annotate the appropriate text for planograms. Typically
this will be:

1. Planogram text - identifying the planograms themselves

2. Profile text - showing information on individual bays within planograms

Managing Floor Plans
Once the substitutions have been carried out and the floor plans synchronized and
annotated, they need to be managed. There are three stages to this:

Renaming Cloned Drawings
If drawings of current status are cloned (PLANOGRAM_SUBSTITUTION_COPY_ FILE
system variable set to On) then their names will be an auto generated version of the
original file name.

In the above example the London 3 file has been cloned - with the clone being called
London 3~133. It may be necessary to rename the cloned file to a more logical name - for
example London 4.

Running Update Status
Update Status (installed in the C:\Program Files\Oracle Retail\MSM\Apps folder) can
be used to change the status of files. When Publish or effective dates are exceeded,
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Authorized files will be set to either Published or Current status as appropriate. As an
example, cloned files (at authorized status) will have their Effective Dates set to the
earliest date in the Floor Plan Effective Date in the Properties tab of the Planogram
substitution definition dialog box. When Update Status is run, if the current date matches
of exceeds the Effective Date set for the floor plan, the file status will be set to Current -
showing the cloned file is now in service.

Publishing the Drawings
After the drawings have reached a suitable status, they need to be published so that
merchandise can be ordered and stores begin planning for the changes.

Publishing can be done by sending an electronic or hard copy version of the floor plan
together with electronic or hard copy forms of the requisite planogram designs to the
stores that will be implementing the changes.

Product Code Types

Product Code Types
Product Codes are numerical codes that enable products to be identified at SKU levels.
They are often present in Bar code form on the actual products.

Product Codes come in a number of formats

UPC Codes
UPC (Universal Product Codes) were developed for the North American Market. They
are normally 12 digits long (although variations exist). The most common versions are
the UPC-A and UPC-E formats, although other variants exist.

UPC codes are slowly being superseded by EAN (European Article Number).

EAN Codes
EAN (European Article Number) are internationally accepted codes. They have been
renamed 'International Article Numbers', although the EAN abbreviation is retained.
Unlike UPC's (which are specific to North America), EAN's allow the country of the
manufacturers of the product to be identified.

The most common form of European Article Numbers is the EAN-13 form, which are 13
digits long. A less commonly used form is EAN-8 (8 digits long) which is sometimes used
for smaller items, where fitting a longer bar code might be impractical.

JAN Codes
JAN (Japanese Article Numbers) are the same as EAN codes.
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GTIN Codes
GTIN (Global Trade Item Numbers) are a family of codes that consolidate codes in the
UPC, EAN and JAN systems. GTINs may be 8, 12, 13 or 14 digits long. They can be
constructed using any of four numbering structures, depending upon the exact
application.
 GTIN-8s will be encoded in an EAN-8 bar code.

 GTIN-12s will be encoded in UPC-A, ITF-14, or GS1-128 bar codes.

 GTIN-13s may be encoded in EAN-13, ITF-14, GS1-128 bar codes

 GTIN-14s may be encoded in GS1-128 bar codes

Product Code Types can be used to set up masks for the Product Codes to be entered
manually within Product Studio. They have no influence on Product Code information
imported via the Data Import module.

Product Code Types are used in the SKU dialogue box in Product Studio. The type is
selected from the UPC type drop down list. Any data entered for the UPC must then
conform to the masks set in the Admin module.
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Adding and Editing Product Code Types
Product Code Types can be added, edited or deleted using the Product Code Type
dialogue box. The add, edit or delete options can be accessed from either the menu bar or
toolbar.

The following wild card characters can be used:
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Character Meaning

? Any letter

# Any number

* Any number of characters of any type

In addition, the following characters can be added as permanent parts of the mask.

Option Available

Numbers 0 1 2 3 4 5 6 7 8 9

Separators ! " £ $ % % ( ) - + { } : ; @ ' ~ , . < > | \

For example, a mask could have the form 12345###-###. Any Product Code manually
added to a Product SKU in Product Studio will have to conform to that format. Examples
of valid inputs are:

12345678-123
12345123-456

Ranges

About Ranges and Range Groups
Ranges and Range Groups are used to set up limits for values for specific types of data.

These Ranges can then be used as filters to ensure that products are placed on compatible
items of equipment in the Merchandiser Module. For example, if the Frozen Goods
Range is assigned to both a shelf and a product, then the use of the Range will prevent
(say) Ice Cream being placed into fixtures or shelves where it could melt.

Note: Ranges have no effect in the Planner Module.

Range Groups
Range Groups are used to collect together Ranges sharing a common attribute - in the
above example; the Temperature Range Group has been used to hold all the Ranges
involving temperature.
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Ranges
Ranges are the maximum and minimum values that can be assigned to a particular
property of the equipment and products. In the above example, the Frozen Goods Range
has been defined as temperatures between -1 and -5 degrees centigrade.

Note: Ranges are used in parallel with Styles.

Currently only temperature ranges can be used. They can be assigned to Fixtures, Shelf
Object and Products.

Where Ranges are Assigned
Ranges can be assigned to fixtures, shelves and products.

Fixtures and Shelves
Fixtures and Shelf Objects are assigned ranges in the Styles/Ranges tab of the Block
Details dialog box in Fixture Studio.

Products
Products are assigned Ranges at SKU level using the Physical tab.
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Where Ranges are Used
Ranges are used as follows:

Products and Equipment
If both the product and the equipment (fixture or shelf) on which it is being placed have
been assigned a Temperature Range, a warning will be generated if an attempt is made to
place a product on a fixture or shelf object that does not have a matching temperature
range.

Planograms and Equipment
There is currently an option in the Configuration Module to warn if the Range assigned
to a planogram is not compatible with the parent fixture.
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This option is currently not active.

About Ranges and Styles
Ranges and Styles can be used interchangeably as filters to determine if products can be
placed on Fixtures or Shelf Objects.

Styles
If styles have been assigned to:
1. Fixtures and Products

2. Shelf Objects and Products

and the requisite Style Relationships exist, and then styles can be used to determine
whether a product can be placed on either a fixture or a shelf object.

Ranges
If Ranges have been assigned to:

3. Fixtures and Products

4. Shelf Objects and Products
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and the ranges are compatible, and then they can be used to determine whether a
product can be placed on either a fixture or a shelf object.

Example
5. It would be possible to create Chilled Fixture, Chilled Shelf and Chilled Product

styles and assign them appropriately to Fixtures, Shelf Objects and Products. The
appropriate style relationships could then be set up, and would serve to determine
whether products could or could not be placed.

6. It would also be possible to create Basic Fixture, Basic Shelf and Basic Product styles
that could be assigned to all Fixtures, Shelf Objects and Products. The pertinent
Fixtures, Shelf Objects and Products could then be assigned the 'Frozen' temperature

range. In this example, the Range would serve to determine whether products could
or could not be placed.

Seasons

About Seasons
The Seasons Option is used to set up the list of retailing Seasons. These seasons can then
associated with Revisions (Store Manager), Products (via the database) and Planograms
(Planogram design - Merchandiser). Once Revisions, Products and planograms have
been associated with Seasons, the information can be used for filtering and reporting
purposes.

Seasons are arranged in a hierarchy and must have a start and a finish date. Unlike
Calendars, seasons can have overlapping date ranges.
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In the above example, the year has been divided into four quarters. Seasons can nest
within or overlap other seasons. For example the Summer Sale Phase is entirely within
Quarter 3, while the Christmas Phase overlaps the year end.

Configuring Seasons
Seasons can be added, edited or deleted by use of the options on the menu bar or tool
bar.

Description
The description is user configurable - any text can be used.

Start Date and End Date
The Start Date and End Date can be configured using the calendars. These are available
as drop down controls. The Start Date and End Date can overlap other seasons.

Type
Type is selected from the drop down list. These are two options: Season and Phase. These
are purely for user convenience and do not have any effect within the software. One way
of using then option is to use 'Seasons' to designate regular time intervals (for example
Months or Quarters). 'Phases' can then be used to designate irregular time intervals - for
example the Christmas Phase might run between 1st November to 4th January.
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Assigning Seasons
Seasons are specific time periods used to define when Revisions, Products and
Planograms are valid for store planning purposes. If revisions, Products and Planograms
are assigned a season, the information can then be used in the Custom SQL for filtering
or sorting purposes. There information can also be used in Key Performance Indicators
(KPI's).

Revisions
Revisions can be assigned a season in the Add or Edit Revision dialog box in Store
Manager

Information on which season a revision has been assigned to is held in the
AVTTB_REVISION table in the SSN_ID field. Only a single value can be held, so a
revision can only be assigned to a single season.

Products
Products can only be assigned a season directly in the database, using during data
import. Values are added to the AVTTB_PRODUCT_SEASON_LINK table. This links
product data in the AVTTB_PRODUCT_DEF table with the information in seasons in the
AVTTB_SEASON table.



Seasons

382 Oracle Retail Macro Space Management

Products can have multiple seasons assigned.

Planograms
Planograms can be assigned a season in the Planogram Design dialog box in the
Merchandiser module.

Note: Planogram definitions will typically be imported via
data importer. The seasons a planogram is valid for can be
assigned during this import definition.

Information on which seasons a planogram has been assigned to is held in the
AVTTB_PLANO_STORE_SEASON_LINK table. Planograms can have multiple seasons
assigned.
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Strategies

Overview of Strategies
The Strategies dialog box is accessed from the Merchandising menu of the
Administration module.

Strategies are used to assign the retailers' objectives products. In the above example, a
retailer has five strategies it can assign to products:

 Standard Product - a product with no special purpose.

 Turf Defender - a basic product required to bring customers into their stores. Basic
commodities like bread and milk would be good examples for a supermarket.

 Cash Flow Generator - a basic product sold in high volumes at low margins to
generate cash. Baked beans would be a good example.

 Image Enhancer - a 'high status' product required to give the retailer the right image
in the market. An example would be the latest electronic devices.

 Profit Generator - a high margin product that sells in quantity and generates
significant profit. An example would be cosmetics.

Although Strategies can be assigned manually to products in Product Studio, it is more
likely that they will be imported. Accordingly, the Strategies entered in the
Administration module should be similar to any that exist in the third party software
used to maintain product information at a retail chain.

Strategies can be assigned to products at all levels from Sub-class to SKU level in the
Product hierarchy. From Sub-Class to Item level it is assigned in the following dialog
box:



Strategies

384 Oracle Retail Macro Space Management

At SKU level it is assigned in the Details Tab of the SKU dialog box.

Once Strategies have been assigned to a product, they can be used as filters for products
being displayed in the Object Grid.



Strategies

Admin Merchandising 385

Note: what appears in the Data Tab of the Object Grid is
controlled by the Custom SQL in the
AVTTB_CUSTOM_SQL table.

Strategy Menus and Toolbar
The File Menu allows users to add new strategies, save the changes and exit the dialog
box.

The Edit Menu allows users to cut copy and paste information, and to delete strategies.

The Help Menu allows users to call this Help File.

The following options are available on the toolbar:

Icon Option

Add a new Import Style

Save the contents of the
dialog box

Cut

Copy

Paste

Delete

Move up in List

Move Down in List

Help
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Using the Strategies Dialog Box
The Strategies dialog box can be used to Add, Edit and Delete strategies from the list of
those available for use within the product hierarchy.

Adding a Strategy
Adding a strategy can be done by clicking the Add button on the toolbar (or the File
menu) to create a new line in the list of Strategies.

Once the line has been created, data can be entered by typing it in, or by using the copy
and paste options on the toolbar.

Editing a Strategy
Strategies can be edited by typing the required changes in, or by using the copy and
paste options on the toolbar (or the edit menu).

Deleting a Strategy
Deleting one or more strategies can be achieved by highlighting the strategies it is
desired to delete in the list of strategies and clicking the Delete option on the toolbar (or
the edit menu).

Promoting or Deleting Strategies in the List of Strategies
Strategies can be promoted or deleted in the sequence strategies are displayed in by
using the Up and down icons in the toolbar.

This will affect how the drop down lists display in the dialog boxes used to set strategies
in Product Studio.

Saving Changes

Changes can be saved by clicking the Save icon on the toolbar (or the file menu).
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If users attempt to exit the dialog box without saving changes, they will be prompted as to whether they wish
to do so.

Styles

Overview of Styles

Overview of Styles
Styles are used in the Merchandiser Module as filters, primarily to ensure that products
are placed on the correct fixture or shelf. There are a variety of styles and style
relationships.
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Fixtures and Shelf Objects
Fixtures have to be assigned a Fixture style in Fixture Studio. Similarly Shelf Objects
(shelves, pegs, etc) have to be assigned both a Fixture and a Shelf style in Fixture Studio.
When shelving is placed in a fixture in Merchandiser, the Fixture Style assigned to the
Fixture must match the Fixture Style assigned to the shelf to allow the shelf to be placed.

Shelf Objects and Products
Shelves have to be assigned a Shelf style in Fixture Studio. Products (at Display Style
level only) are assigned a Product Style in Product Studio. If a relationship between the
Shelf and Product Style has been defined in the Administration Module, the Product can
be placed on the shelf. If a relationship has not been defined, the product cannot be
placed in the Merchandiser Module. (Display styles cannot be placed in the Planner
Module).

Fixtures and Products
Fixtures have to be assigned a Fixture style in Fixture Studio. Products (at Display Style
level only) are assigned a Product Style in Product Studio. If a relationship between the
Fixture and Product Style has been defined in the Administration Module, the Product
can be placed directly onto the fixture. If a relationship has not been defined, the product
cannot be placed in the Merchandiser Module. (Display styles cannot be placed in the
Planner Module).

Joints
Some products cannot be placed directly onto fixtures, but must be placed into shelf
objects such as pegs. There are two ways of achieving this:
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1. Place the shelf object (i.e. peg) first, then place the product

2. Place the product and shelf object simultaneously - joints

Planograms
Fixtures have to be assigned a Fixture style in Fixture Studio. Planograms are assigned a
Fixture Style in the Planogram Design dialog box in the Merchandiser Module. If the
Fixture Style of the Planogram being placed does not match the Fixture Style of the first
of the selected fixtures, a warning will be given. The user can then accept the warning, or
override it and place the planogram.

Where Styles are Assigned
Styles can be assigned to Fixtures, Shelf Objects, Products and Planograms.

Fixtures
Fixture Styles are assigned in the Fixture Studio Module in the Styles tab of the Block
Details dialog box.

A Fixture is required to have a Fixture style assigned. Only Fixture Styles will be
available for selection in the Styles/Ranges Tab.
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Note: Whether an object is designated as a fixture is set in
the Categories tab.

Shelf Objects
Both Fixture and Shelf Styles are assigned in the Fixture Studio Module in the Styles tab
of the Block Details dialog box.

A Shelf Object is required to have both Fixture and Shelf styles assigned. Both Fixture
and Shelf Styles will be available for selection in the Styles/Ranges Tab.

Note: Whether an object is designated as a Shelf Object is set
in the Categories tab.

Products
Only Products at Display Style Level can be assigned Styles. This is done in the Styles
Tab of the Display Style dialog box in Product Studio
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Only Product Styles will be available for Selection.

Planograms
Planograms are assigned Fixture Styles in the Planogram Design dialog box in the
Merchandiser Module.
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Only Fixture Styles will be displayed.

Styles and Style Relationships
Style Relationships are set up within the Styles option in the Administration module.
They control:

1. What products can be placed on what fixture

2. What products can be placed on what shelf

3. What products can be placed on what fixture using a specified shelf object (joints)
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Style relationships must be set up before products are placed in Merchandiser.

Preferred Styles
Preferred Styles are used on Shelf Objects. They enable automatic switching of display
styles for a SKU so that the preferred Display Style is placed on a shelf object.

An example would be if electric kettles were available in two display styles: Boxed and
Presentation. The Presentation Display Style would typically be for an electric kettle that
has been taken out of its box and was being displayed on a shelf above the boxed electric
kettles. The 'presentation' electric kettle would be used to show customers what the
electric kettle looked like, the boxed' electric kettles would be purchased by customers

An example of this would be a fixture with five shelves on it. The top shelf might contain
examples of 'presentation' goods such as electric kettles, electric toasters, bread makers
and toasters. The four shelves below would contain respectively boxed electric kettles,
electric toasters, bread makers and toasters for purchase.

By setting the preferred style of the top shelf to accept 'Presentation' Display Styles and
the preferred styles of the shelves below to accept 'Boxed' Display Styles, the user can
ensure that the correct form of the merchandise goes onto the shelves. If an attempt is
made to put ‘Presentation’ Display Styles onto a shelf that prefers 'Boxed' Display Styles,
then the Display Style will automatically be switched to the correct one.
The full process for using preferred styles is

1. Add Appropriate Styles in Admin

2. Set up Style Relationships in Admin

3. Assign Styles to Shelf Objects in Fixture Studio

4. Assign Styles to Display Style level products in Product Studio

5. Set up Preferences for Shelves
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6. Drag and drop Display Style products onto shelf - preferred style should be chosen if
not correct

Add Appropriate Styles in Admin
The appropriate styles have to exist in the Style tab of the Styles dialog box in the
Administration module

Set up Style Relationships in Admin
The appropriate style relationships have to exist in the Style Relationship tab of the Styles
dialog box in the Administration module
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Assign Styles to Shelf Objects in Fixture Studio
Shelf styles have to be assigned to the shelf object in Fixture Studio. A minimum of two
shelf styles are required for Preferred Styles to work.
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Assign Styles to Display Style level products in Product Studio
Product Styles are assigned in Styles Tab of the Product Display Style dialog box in
Product Studio.
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Set up Preferences for Shelves
The preferences for shelves are set in the Merchandiser module. There are two ways of
doing this: on adding the shelves to a fixture, or by editing a specific shelf.

When adding shelves to a fixture, the preferred style can be set using the drop down list
in the Add Shelves dialog box.
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Once shelves have been added, the Preferred Style can be edited using the Preferred Style
drop down list in the Edit Shelf dialog box.
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Drag and Drop Display Style products onto shelf - preferred style should be chosen if
not correct
Once preferred styles have been set for a shelf, they can be used to determine what
display style for a specific SKU is placed. If there are several alternatives, dragging and
dropping any display style onto a shelf from that SKU will result in the type of display
style being checked, and if necessary changed to the preferred style.

About Joints
Joints are a special type of Style Relationship. They allow a product to be placed directly
onto a compatible fixture at the same time as the associated shelf object that the product
will be placed on is added.
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In the example above products have been directly placed into a slatwall using pegs.
Without a joint, the pegs would have to have been placed first, and then merchandised
with product in a second operation.

Prior to products being added via joints, the following must be true:
1. The Fixture that will support the shelf objects the products are being added to must

have a Fixture Style assigned in Fixture Studio

2. The Shelf Object the product will be added to must have a Shelf Style assigned in
Fixture Studio

3. The Product must have a Product Style assigned in Product Studio

4. The appropriate Joint (Style Relationship) must be set up in the Styles option within
the Admin Module

To add a product using joints requires the following steps:

1. Drag the product from the Object Browser or Object Grid and drop onto the required
Fixture.

2. The Add Shelves dialog box will appear allowing users to specify details of the shelf
objects to be added.
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Note: this dialogue box will not appear if the Add Products
Silently option is on in the Edit Menu in Merchandiser.

3. After the Shelf Object details have been specified and the OK button clicked, the Add
Products dialog box will appear.

4. After specifying the quantity, alignment, etc, and clicking the OK button, the
products and shelf objects will simultaneously place on the selected fixture.
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About Styles and Ranges
Styles and Ranges can be used interchangeably as filters to determine if products can be
placed on Fixtures or Shelf Objects.

Styles
If styles have been assigned to:

1. Fixtures and Products

2. Shelf Objects and Products

and the requisite Style Relationships exist, then styles can be used to determine whether
a product can be placed on either a fixture or a shelf object.

Ranges
If Ranges have been assigned to:
1. Fixtures and Products

2. Shelf Objects and Products

and the ranges are compatible, then they can be used to determine whether a product can
be placed on either a fixture or a shelf object.

Example
1. It would be possible to create Chilled Fixture, Chilled Shelf and Chilled Product

styles and assign them appropriately to Fixtures, Shelf Objects and Products. The
appropriate style relationships could then be set up, and would serve to determine
whether products could or could not be placed.

2. It would also be possible to create Basic Fixture, Basic Shelf and Basic Product styles
that could be assigned to all Fixtures, Shelf Objects and Products. The pertinent
Fixtures, Shelf Objects and Products could then be assigned the 'Frozen' temperature

range. In this example, the Range would serve to determine whether products could
or could not be placed.

Using Styles

Adding and Deleting Styles
Adding and Deleting Styles is done by using the Style tab in the Styles dialogue box.
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Add style

Delete style

Adding a Style
To add a style, click on the Add Style icon. A new line will be added in the styles table.

The Style ID is a fixed, sequential number allocated when the style is created.

The Name and Description will initially read Style11 and Description11, where the
number is that of the style being created. These can be edited to the style name and
description required.

The Style type can be selected from a drop down list.

Currently only Fixture, shelf and Product styles are active.
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Deleting a Style
Styles can be deleted by highlighting a style and clicking on the Delete Style icon. If not
in use, the style will be deleted. If in use, a warning will appear. This indicates that the
style has been assigned to either a fixture, shelf, product or planogram.

The style must then first be changed in the respective fixture, shelf, product or
planogram before it can be deleted.

Example of Adding a Style
To Add a Style to the available list, open the Style option in the Admin Module. Use the
Style Tab and click on the Add Style Icon (circled).

This will add another line to the information grid (circled).
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Edit this line until it has the desired information.

Finally, exit to save the styles.

Note: There is a known issue with the Styles option at
present. Information is temporarily lost if a second style is
added immediately after the first. To overcome this close the
Styles dialogue box after each style is added, then re-open it
to add the next.

Adding and Deleting Style Relationships
Style Relationships can be added and deleted by using the Style Relationships tab in the
Styles dialogue box.
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Add style relationship

Delete style
relationship

Adding a Style Relationship
To add a style relationship, first select the style types which it is desired to set up a
relationship with. This can be done from the drop down lists – for example it might be
required to associate a Shelf style with a Product style.

Next, select the specific types of styles from the lists provided – for example it might be
required to associate the Pallet Shelf Style with the Multipack product style.

Finally, click on the Add Style Relationship icon to add the relationship. It will then
appear in the list of current relationships.

Valid Style relationships that can be set up are:

Style
Relationship

Comment

Fixture - Product Determines which products can be placed on which fixtures

Shelf Product Determines which products can be placed on which shelves

Joints Joints allow products to be placed on fixtures while simultaneously placing any
required shelf objects (i.e. pegs, etc). Joints set up the relationship between fixtures,
certain types of shelf objects and products.
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Deleting a Style Relationship
Styles relationships can be deleted by highlighting a style and clicking on the Delete Style
Relationship icon.

Note: Style relationships in use can be deleted without any
warning being given. This will not affect any objects placed
before the relationship was deleted, but if further objects are
to be placed using this relationship, it must be reinstated
before they are.

Example of Adding a Style Relationship
To Add Style Relationships to the available list, open the Styles option in the Admin
Module. Click on the Style Relationship Tab.

Set the options as required. First select the required style types from the drop down list.
Next highlight the styles it is desired to have a relationship with.
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Finally, click on the Add Style Relationship icon. This will cause the Style to be added to
the list of available Style relationships.
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Note: If we need place products directly onto a fixture, a
Style Relationship would be required between the Fixtures
Style and the Product Style. An example of this would be
putting products of Boxed Style onto fixtures of Pallet Style.

Adding and Deleting Joints
Adding and Deleting Joints is done by using the Style Relationships tab in the Styles
dialogue box.
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Add joint relationship

Delete joint relationship

Adding a Joint
To add a joint, first select the style types which it is desired to set up a relationship with.

First select Fixture Style in the left hand drop down list. Next select Product Style in the
central drop down list. Finally select Shelf Style in the right hand drop down list.

Next highlight the required styles in each of the three lists. (For example Metal as a
Fixture Style, Hung as a Display Style and Peg as a Shelf Style.

Finally, click on the Add Joint Relationship icon to add the relationship. It will then
appear in the list of current relationships.

Deleting a Joint
Joints can be deleted by highlighting a style and clicking on the Delete Style Relationship
icon.
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Note: Joints in use can be deleted without any warning
being given. This will not affect any objects placed before the
relationship was deleted, but if further objects are to be
placed using this relationship, it must be reinstated before
they are.

Example of Adding a Joint
To Add a Joint to the available list, open the Styles option in the Admin Module. Click on
the Style Relationship Tab.

First select Fixture Style in the left hand drop down list. Next select Product Style in the
central drop down list. Shelf Style will automatically appear in the right hand drop down
list.
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Next highlight the required styles in each of the three lists.
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Finally, click on the Add Joint Relationship icon to add the relationship.

It will then appear in the list of current relationships.
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Testing Style Relationships
Testing Style Relationships is done by using the Test tab in the Styles dialogue box.

Equipment
To see which product styles are associated with an item of equipment, click on that item
of equipment in the list of available equipment.

The list of associated product styles will then display.
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Note: The list of equipment can be sorted in ascending or
descending order by clicking on the column headers.

Products
To see which equipment styles are associated with a product, click on that product in the
list of available products. The list of associated equipment styles will then display.

Product can be found by entering the product name or code and clicking on the search
icon.
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Note: The list of products can be also sorted in ascending or
descending order by clicking on the column headers.

Joints
Joints can only be tested by trial placements on equipment.
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Tools

Next ID

Overview of Update ID Tables Option
The Update ID Table Option is called from the Tools Pull down Menu.

Its function is to reset the AVTTB_NEXTID table in the central Macro Space Management
database in the event of a serious system failure.

This option would normally be used by Administrators.

The Update ID Tables Option
The central Macro Space Management database contains an AVTTB_NEXTID table.

This contains the next primary key for a number of key pieces of information in the
database.

These values are used to assign primary keys when new items (for example stores or
planograms) are added to the database.

If there is a serious failure and the software crashes, these primary keys may not be fully
updated, leading to problems when the software is restarted.
Similarly, if the database is updated by a major import of data, some of the information
in the Next ID table can become outdated.

Running the Update ID Tables option takes the latest values of the specified Next ID's
(primary keys) from the referenced tables in the database and ensures the Next ID values
are updated.
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Unlock Tables

Overview of Unlock Tables Option
The Unlock Tables option allows administrators to unlock tables that have been locked
by (for example) a system failure or by people leaving objects such as products checked
out.

The Unlock Tables Option
After the Unlock Tables option has been selected from the Menu Bar, the Unlock Tables
dialogue box will appear.

If there are objects to be checked in, this can be done by highlighting them, right clicking
to bring up the pop-up menu and choosing the appropriate option.

Purge

Overview of Purge Options
Purge Options are available using the Purge option on the Tools pull down menu.

This will bring up the Purge dialogue box.
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Clicking on OK will purge the selected items.

Purge Fixtures Option

Deleting Fixtures
Fixtures are deleted in Fixture Studio.

This is done by highlighting the selected fixture and using <Ctrl> + right click to bring
up the pop-up menu.

The highlighted fixture can then be marked for deletion by clicking on the Delete Block
Option. Fixtures marked for deletion will appear grey rather than black in the Fixtures
Hierarchy.

Purging Fixtures
The fixture will not be permanently deleted from the database until the Fixtures option is
checked on the Purge dialogue and the OK button clicked.
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Results will be reported in the Purge Results dialogue box.

Purge Products Option

Deleting Products
Products are deleted in Product Studio. This is done by highlighting the selected product
and using <Ctrl> + right click to bring up the pop-up menu.
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The highlighted product can then be deleted by clicking on the Delete Block Option.

Purging Products
The product will not be permanently deleted from the database until the Product option
is checked on the Purge dialogue and the OK button clicked.

Results will be reported in the Purge Results dialogue box.
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Purge Images Option

Deleting Images
Images are deleted in Product Studio. This is done by highlighting the selected image
and using <Ctrl> + right click to bring up the pop-up menu.
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The highlighted image can then be deleted by clicking on the Delete Option.

Purging Images
The image will not be permanently deleted from the database until the Image option is
checked on the Purge dialogue and the OK button clicked.
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Images will then be deleted without further confirmation.

Purge Planograms Option

Deleting Planograms
Planograms are deleted in Merchandiser. This is done by highlighting the selected
planogram and using <Ctrl> + right click to bring up the pop-up menu.

The highlighted fixture can then be marked for deletion by clicking on the Delete Block
Option.

Purging Planograms
The planograms will not be permanently deleted from the database until the Planograms
option is checked on the Purge dialogue and the OK button clicked.
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Results will be reported in the Purge Results dialogue box.

Purge Logs Option

Deleting Logs
Logs are deleted in Store Manager.

This is done by selecting the Purge > Logs option from the Admin pull down menu.

Note: The Admin pull down menu is only available to users
with Administrator's privileges. It is toggled on and off by
means of <Ctrl + A>.
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This will bring up the Log File Purge dialogue box.

Log files can then be selected and marked for purging.

Purging Logs
The logs will not be permanently deleted from the database until the Logs option is
checked on the Purge dialogue and the OK button clicked.

Results will be reported in the Purge Results dialogue box.
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Purge Targets Option
The Purge Targets Option is not enabled in this release of Macro Space Management.

Purge EPOS Data Option
The Purge EPOS Data Option is not enabled in this release of Macro Space Management.
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6
Logs

Overview of Logs
Logs are in two forms: Text Logs and Database Logs.

Text Logs
Text logs include .log, AVT5 Store Manager.log, AVT5CAD.log, AVT5Controls.log,
AVT5Legacy.log, dbTreeControl.log, Macro Space Management.log, Store Manager.log.
These are used mainly for debugging purposes and are not generally used in normal
operations.

Database Logs

Log Description

AVTTB_FILE_PROCESS_LOG Identifies all files that have been
subjected to batch processes

AVTTB_FILELOG Identifies all files that have been
checked in or out

AVTTB_IMPORT_ERROR_LOG Identifies all errors during data
import

AVTTB_IMPORT_LOG Identifies all data imports

AVTTB_POG_IMPORT_LOG Identifies all planogram imports

AVTTB_POG_SUBST_LOG Identifies all planogram
substitutions

AVTTB_PROCESS_LOG Identifies all processes that have
been invoked [not in use]

AVTTTB_USER_LOG Identifies the times users have
logged into MSM

AVTTB_ERROR Holds errors reported by In-Store
Space Collaboration

Note: The AVTTB_FILE_PROCESS_LOG_TYPE table gives
information on which processes are being recorded in the
AVTTB_FILE_PROCESS_LOG

Logs can be viewed from the Logs option on the menu bar.
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Logs can be purged using the Purge option on the tools menu.

AVTTB_COMMAND_LOG
The AVTTB_COMMAND_LOG table is not presently in use.

AVTTB_FILELOG
The AVTTB_FILELOG Table identifies the files that have been logged out and by which
user.

The AVTTB_IMPORT_ERROR_LOG table can be purged via the Purge option in the
Administration module, or via the Purge option on the Tools menu in the Store Manager
module.

Purging in the Admin Module will remove all entries from the table. Purging in Store
Manager allows users to remove entries for specific users or between specific dates.

AVTTB_FILE_PROCESS_LOG
The AVTTB_FILE_PROCESS_LOG table stores the results of automated processes.
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The Type of Process is specified by the FPT_ID (File Process Type ID). This is a foreign
key to the AVTTB_FILE_PROCESS_LOG_TYPE table.

File Process
Type
(FPT_ID)

Description Comment

0 Result of Synchronization process from
Drawing Automation

Not presently active

1 Result of Save process from Drawing
Automation

Not presently active

2 Result of Publish process from Drawing
Automation

Not presently active

3 Store Section No longer active

4 Bulk Planogram No longer active

5 Update Store - Open Result of running UpdateStatus.exe

6 Update Store - Close Result of running UpdateStatus.exe

7 Update File - Publish Result of running UpdateStatus.exe

8 Update File - Current Result of running UpdateStatus.exe

9 Planograms Substitution Clone Result of Planogram Substitution

11 Adjacency Calculation Result of running Automated
Calculations

Note: Update Status and Automated Calculations are in the
C:\Program Files\Oracle Retail\MSM\APPS directory.
Planogram Substitution is run using a Stored Procedure.

AVTTB_IMPORT_LOG
The AVTTB_IMPORT_LOG identifies the results of imports generated by the Data
Importer Module - including the number of records imported, updated, deleted, expired,
skipped and failed.
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The contents of the table are visible in the Import Log dialog box in the Data Importer
module.

The AVTTB_IMPORT_LOG table can be purged via the Purge option in the
Administration module, or via the Purge option on the Edit menu in the Import Log
dialog box.

AVTTB_IMPORT_ERROR_LOG
The AVTTB_IMPORT_ERROR_ LOG identifies the errors that occur during imports
generated by the Data Importer Module.
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The contents of the table are visible in the Import Error Log dialog box in the Data
Importer module.

The AVTTB_IMPORT_ERROR_LOG table can be purged via the Purge option in the
Administration module, or via the Purge option on the Edit menu in the Import Error
Log dialog box.

AVTTB_PLANO_LOG
The AVTTB_PLANO_LOG table records details of all planograms that have been Added,
Edited or deleted in the Merchandiser Module.

The table can only be purged directly in the database.
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AVTTB_POG_IMPORT_LOG
The AVTTB_POG_IMPORT_LOG table holds information on all planograms imported
into Macro space Management via the Planogram Import Module.

The table can only be purged directly in the database.

AVTTB_POG_SUBST_LOG
The AVTTB_POG_SUBST_LOG table holds the reports of all planogram substitutions.

The table can only be purged directly in the database.

AVTTB_PROCESS_LOG
The AVTTB_PROCESS_LOG table contains details of when files (store plans) were made
Authorized or Current in Store Manager.

The table can only be purged directly in the database.
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AVTTB_USER_LOG Table
The AVTTB_USER_LOG Table records the times users log into Macro Space
Management

It also records when a user has failed to log in.

Note: if the Log In ID does not match any user in the
database, this indicates a possible unauthorized attempt to
access the software.

AVTTB_ERROR
The AVTTB_ERROR Table mainly holds errors generated during there operation of In-
Store Space Collaboration.

The table can only be purged directly in the database.
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7
Security

Overview of MSM Security
MSM Security is based on three options.

1. Security Options control the form that access to the software takes: password
format, number of log in attempts allowed, etc.

2. Functional Security controls the access to specific modules in Macro Space
Management.

3. Data Security controls access to specific parts of the functionality

a. What stores and file statuses are visible in In-Store Space Collaboration.

b. What planograms are available to users for Planogram Substitution

Security Options

About Security Options
Security Options allows Administrators to configure the log in parameters.
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These include the number of incorrect log-ins allowed, maximum and minimum
password length, password format, the password change period and Excluded
Passwords.

Maximum Logins
The Maximum Number of Log In attempts can be set by means of the spin controls.
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Any user exceeding the maximum number of log in attempts will have their account
deactivated.

This is a security measure to prevent unauthorized users attempting to guess passwords.

Note: Accounts can be reactivated by editing the user's
account in the Functional Security option.

Minimum and Maximum Password Length
The Maximum and Minimum Password Lengths can be set by means of the spin
controls.
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This enables users to set the minimum and maximum number of characters allowed in
the password.

The minimum value can be set in the range 1 - 10 characters. The maximum value can be
set to a maximum of 15 characters. It cannot be set below the value defined in the
minimum value.

Password Format
The Password Format determines what characters are allowed in the password.
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It is possible to enter three characters in this field. They are:

a Alphabetical character

n Numerical character

? Alphanumeric
character

It is thus possible to determine the precise form of the password, or leave it in a more
general alphanumeric form, as in the example above).

Change Password Period
The Change Password Period option allows the Administrator to set the time required
between enforced password changes.



Security Options

442 Oracle Retail Macro Space Management

This is set by means of the drop down list. It can be set to any interval between 1 day and
yearly. It can also be set to 'never' in which case users will never be asked to change their
password.

Excluded Passwords
The Excluded Passwords option allows Administrators to exclude obvious and easy to
guess passwords from those allowed to users.
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For example, it might be desired to exclude Password, Admin and SysOp as obvious
passwords.

It is also possible to exclude obscenities, first names, surnames, etc - anything that might
assist an anatomized user to guess a password.

Entering Passwords
To enter a password, type it into the text box and press <Return>. The excluded
password will now be stored in the database.

Note: If you do not press <Return>, the Excluded Password
will not be stored.

Editing Passwords
To edit a password, click on it in the list, make the required changes and press <Return>.
The edited excluded password will now be stored in the database.

Note: If you do not press <Return>, the changes will not be stored.

Deleting Passwords
To delete a password, highlight it in the list then press the <Delete> key,

Exiting Security Options
To Exit Security Options either click on OK or Cancel
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Clicking on OK will save all settings to the database and exit.

Clicking on Cancel will result in all changes (except to Excluded Passwords) being lost.

Functional Security

About Functional Security
Functional Security is used to control access to the software, and also which parts of the
software can be accessed.

Users
Users can be added - and their User Names and Passwords assigned. This can be used to
control logging in to both Macro Space Management and In-Store Space Collaboration.
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User Groups
Users are put into User Groups. Membership of a User Group confers the privileges of
that User Group on the User. For example the Admin User Group will typically allow the
User to access all parts of the software, while membership of other User Groups will give
more restricted access.
User Groups are also used in Data Security, which is currently used to control what
stores and file (store plan) statuses are visible in In-Store space collaboration.

The Functional Security Dialog Box
The Functional Security dialog box has two tabs: User Groups and Group Relationships.

User Groups Tab

The User Groups tab allows Administrators to create Users and User Groups.

Note: in the default Database supplied, only users belonging
to the Admin User Group can access the functionality within
In-Store Space Collaboration. To give other User Groups
access to the functionality in ISSC, changes need to made
directly in the database. (More Info)

Group Relationships Tab
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The Group Relationships Tab allows Administrators to determine which User Groups
can access which modules.

The Functional Security Window
The Functional Security Window has a series of components.
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The Menu Bar allows Administrators to access a limited number of options.

The Toolbar allows Administrators to access a series of options affecting User Groups
and Group Relationships.
The Tabs allow operations to be switched between User Groups and Group
Relationships.

The Hierarchy shows the current list of User Groups or Group Relationships.

Functional Security Menus and Toolbar
The File pull down menu allows users to exit this option.
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The View pull down menu allows users to refresh the hierarchical tree and to call the
Find dialogue
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The Help pull down menu allows users to check the version of this software.

The Toolbar allows users to access various Functional Security options.



Functional Security

450 Oracle Retail Macro Space Management

Icon User Groups Group Relationships

Exit Exit

Add User Group Add Command Group

Edit User Group Edit Command Group

Delete User Group Delete Command Group

Add User Not Available

Edit User Not Available

Delete User Not Available

Cut Cut

Copy Copy
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Icon User Groups Group Relationships

Paste Paste

Search Search

Refresh Refresh

Users and User Groups

User Groups

Overview of User Groups
User Groups are groups of users. User Groups can be any logical grouping of users.
Examples include:

1. Functional Groupings: Store Planners, Merchandisers, etc

2. Responsibilities: Planners, Managers, etc

3. Geographical Groupings: North America, Europe, etc

Each User Group can be assigned specific privileges within the software. When Users as
assigned to User Groups, the Users inherit the privileges of the User Group, thus
enabling Administrators to control access the program without configuring it for each
individual user.



Functional Security

452 Oracle Retail Macro Space Management

Example of 'Functional' User Groups

Example of 'Responsibility' User Groups

Example of 'Geographic' User Groups

Note: at present Geographic User Groups only find an
application in In-Store Space Collaboration. They can be
used in Data Security to specify which Stores users can see.

Users can be assigned to multiple User Groups.
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User 1 can only work in functionality assigned to the Asia User Group

User 2 can work in functionality assigned to both the Asia and Europe User Groups
User 3 can only work in functionality assigned to the Europe User Group

User 4 can only work in functionality assigned to the both the Europe and America User
Groups

User 5 can only work in functionality assigned to the America User Group

The User Group Hierarchy
The User Group Hierarchy shows the relationship of User Groups and their associated
users.
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User
Group

User

Users Groups can be planned in a hierarchy - for example the Store Planner User Group
has Fixture Planner as a child. The Store Planner User Group might allow (Group
Relationships Tab) Users to access both the Planner and Fixture Studio Modules, while
the Store Layout User Group might only allow access to the Planner Module.

Users can be allocated to Single or Multiple User Groups.

Note: If users are allocated to multiple User Groups in a
hierarchy the most restrictive permissions will apply. If a
function is allowed in one User Group and denied in
another, the deny permission will take precedence.

Before Adding, Editing or Deleting User Groups, Administrators should consider how
access to both Macro Space Management and In-Store Space Collaboration will be
controlled. User Groups can then be configured as required.

Adding a User Group
To Add a User Group select the node in the hierarchical tree that the new User Group is
to emanate from and click on the Add User Group Icon.
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This will bring up the User Groups dialogue box.

1. Enter the Name of the User Group and the Description.
2. If the mandatory check box is ticked, all new users will automatically be added to

this group when they are created.

3. Click on OK and the User Group will be added to the hierarchy.

Note: A User Group cannot be added unless a valid node
has been selected in the hierarchical tree.

Editing a User Group
To Edit a User Group select the User Group in the hierarchical tree and click on the Edit
User Group Icon.
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This will bring up the User Groups dialogue box.

1. Change the Name of the User Group and the Description.
2. (If the mandatory check box is ticked, all new users will automatically be added to

this group when they are created).

3. Click on OK and the edited User Group will appear in the hierarchy.

Deleting a User Group
To Delete a User Group select the User Group in the hierarchical tree and click on the
Delete User Group Icon.
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This will bring up the Delete Confirmation.

Click on Yes and the User Group will be removed.

User Groups and Functionality in ISSC
Privileges in Macro Space Management can be set using the Functional Security option
in the Admin Module. However, privileges in In-Store Space Collaboration have to be
assigned by a combination of actions in the Administration module and the database.

This is because the buttons that are active in In-Store Space Collaboration are controlled
by the AVTTB_MESSAGE_USER_GROUP_LINK table.
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1. The USG_ID is the ID of the User Group it is desired to activate buttons for. It is
determined from the AVTTB_USER_GROUP table.

2. The MSC_ID is the identity of the button or form it is desired to give a User Group
permissions for.

3. THE MUG Permission Mask determines whether the button is active or grayed out.
(1 = active, 0 = disabled).

When a User Group is created in Functional Security, any users associated with that User
group will be able to get into In-Store Space Collaboration, but will then find all the
buttons on the toolbar grayed out and unavailable. In order for the buttons in In-Store
Space Collaboration to become available, all the entries for USG_ID = 1 (Admin Users)
have to be duplicated for the additional User Groups it is desired to make In-Store Space
Collaboration available to.

This can be done with a simple SQL Insert statement of the form

where the value of the User Group ID in the AVTTB_USER_GROUP table (for example 9)
is substituted for [User Group ID]. If it is necessary to disable specific functionality, the
MUG_PERMISSION_MASK can be set to 0 (Disabled).

Note: for more information on what is controlled by
MSC_ID, please contact Oracle Technical Support.

Users

Adding a User
Users are added to User Groups. The users then inherit the privileges of those User
Groups. To Add a User select a User Group in the hierarchy then click on the Add a User
Icon.
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This will bring up the User dialogue.

First Name is the first name of the User.

Last Name is the last name of the User.

Initials are the User's initials.
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Login ID is what will appear in Macro Space Managements Log In dialogue box.

Password and Password Confirmation allow the administrator to set the initial
password. These will be required when logging in to Macro Space Management.

Expiry Date sets the initial date at which the password will expire and require changing.
(The interval at which the password will require further resets is determined by the
Change Password Interval option in the Security Options option).

Note: the expiry date can be set to a date in the past for new
users. This will force a password change when they first log
on.

Language sets the default language for Macro Space Management.

Note: For any other language than English the
AVTTB_MESSAGE table must first be populated with the
appropriate information.

Activate is grayed out and unavailable when adding a new user. It becomes available
when the user is edited.

Note: A User cannot be added unless a valid node has been
selected in the hierarchical tree.

User Configuration and Logging In
When Users are added (or User properties are Edited), Administrators can set the User
Name and Password that will be required in the User Log in dialogue box that appears
the first time Macro Space Management is opened.

Note: the Expiry Date can be set to a date in the past. This
will force a password change when the user first logs on.

Thus, the 'Mark Twain' user has a user name of MT and a password set for their log in.
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Editing a User
To Edit a User highlight the user in the hierarchy then click on the edit user icon.

This will bring up the User dialogue.
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Edit the details as required and press OK.

Deleting a User
To Delete a User highlight the user in the hierarchy and click on the delete icon.

Note: Deleting a user will remove the user from all user
groups. Use an alternative method if it is desired to remove
the User from a single User Group. Removing Users from
User Groups
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This will bring up the Delete Confirmation.

Click on Yes and the User will be removed from all User Groups.

Adding Users to Multiple User Groups
Adding Users to Multiple User Groups is carried out by using the Copy and Paste
options.
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1. Open up the hierarchical tree and highlight an instance of the user you wish to copy.

2. Click on the Copy icon.

3. Highlight the User group it is desired to copy the User to.
4. Click on the Paste icon.

The user will now be copied to the required User Group.

Moving Users from one User Group to Another
Moving Users to from one User Group to Another is carried out by using the Cut and
Paste options.
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1. Open up the hierarchical tree to find and instance of the user you wish to move.

2. Click on the Cut icon.

3. Highlight the User Group it is desired to move the user to.
4. Click on the Paste icon.

The User will now be removed from the first User Group and copied to the second User
Group.

Removing Users from Multiple User Groups
Removing 'Multiple User Group' Users from some of those User Groups is not directly
possible with the current functionality, but it can be achieved indirectly.

Note: Do not use the Delete option to remove a User from a
single User Group - this will result in the User being deleted
from all User Groups.
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1. Click on the Add Group Icon to create a Temporary Group.

2. Name the Group Temporary or some other similar name.
3. Open the hierarchy and select the User Group and the User it is desired to remove

from the Group.

4. Click on the Cut icon.

5. Highlight the Temporary User Group.

6. Click on the Paste icon.

The User will be removed from the selected User Group and copied to the Temporary
User Group.

7. Delete the Temporary User Group.

Purge Users Option
Purge options are available using the Purge option on the Tools pull down menu.
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The user will not be permanently deleted from the database until the Users option is
checked in the Purge dialogue box and the OK button clicked.

Note: Until the user is purged from the database, they will
still be able to use their User Name and Password. Deleting
a user in Functional Security alone is not enough to prevent
then from accessing Macro Space Management.

Group Relationships

Overview of Group Relationships

Group Relationships
Group Relationships are used to define areas of functionality for which security can be
set. These control access to the main modules of Macro Space Management - for example
Fixture Studio. User Groups can then be assigned to these areas of functionality -
allowing access to be controlled to the different modules.

Adding, Editing and Deleting Command Groups
At present Adding Command Groups has no effect as there is no way of tying the newly
added Command Group into any functionality. The names of Command Groups can be
edited, but this is not recommended as it may make it difficult to establish which
functionality is having its access controlled. Command Groups can be deleted. This is not
recommended as deleting a command group removes all control over access to the
module it references.
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Using Group Relationships
User Groups can be created in the User Groups Tab. Permissions to access specific parts
of the Macro Space Management and In-Store Space Collaboration can then be granted
by associating User Groups to the top level command groups.

In the above example, Fixture Studio has been made available to users belonging to the
Administrator and Store Planner User Groups.

Adding a User Group to a Command Group
To Add a User Group to a Command Group highlight the required Command Group
and right click to bring up the pop-up menu.
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Select Add User Group to bring up a list of available User Groups.
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Check the boxes for the required User Groups and click on OK.

Removing a User Group from a Command Group
To Remove a User Group from a Command Group highlight the required User Group
and right click on it to bring up the pop-up menu.
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Select the Delete Links option. This will bring up a confirmatory dialogue.

Click on OK to confirm.

Setting Permissions
The Edit Permissions option is not active in this release of Macro Space Management
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Data Security - Edit - Planograms

About Data Security
Data Security is an extension of Functional Security. It allows Administrators to further
restrict the permissions a user may have for a particular Macro Space Management
function to specific data within that function. For example a merchandiser may have
permissions to add, change and delete merchandise, but it may be desired to restrict
those permissions to specific stores.

Data Security allows Administrators to further define permissions for User Groups for
Stores, Products, Planograms and Statuses.

Note: at present Data Security is only operational in In-Store
Space Collaboration and for Planogram Substitution.

The Data Security Window
The Data Security Window allows users to set varying options concerning Data Security.
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The Menus allow users to access various Data Security options.

The Toolbar gives access to a limited number of Data Security options.

The Tabs allow the users to switch between setting Data security options for Stores,
Products and Status.
The Hierarchy allows users to see a list of Stores, Products or Statuses.

The Permissions List enables users to see the list of permissions allocated to that aspect
of Macro Space Management.

Data Security Menus and Toolbar
The File pull down menu allows users to exit this section of the Admin Module.

The Edit pull down menu allows users to configure the permissions for the data.

The View pull down menu allows users to access the find dialogues and to refresh the
information in the Data Security window with the latest information in the database.
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The Toolbar has four options:

Edit Permissions

Delete Link

Find

Refresh

Edit Permissions enables the user to modify the Add, Edit and Delete permissions for a
specific item within Data Security.

Delete Link can be used to remove access for a User Group to a specific item within Data
Security.

Find brings up the search dialogue.

Refresh loads the latest version of the information in the database to the Data Security
window.

Using Data Security

Overview of Data Security for Stores
Data Security for Stores is intended to allow Administrators to assign permission for
User Groups accessing In-Store Space Collaboration to see specific stores.
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In the above example the Berlin store has been made visible to members of the Europe
and Merchandise Manager User Groups. (Other stores can also be made visible if
required).

Stores then become visible to In-Store Space Collaboration Users - note how stores in the
Europe cluster in MSM's Store Manager that have not been given permissions to be
accessible in In-Store Space Collaboration do not become visible in ISSC.
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Any store plans it is desired to edit for the store must also have been given the
appropriate permissions in the Statuses Tab of the Data Security dialog box and then
must be set for the specified statuses.

Note: controlling access to Stores is presently only active in
In-Store Space Collaboration.

Adding and Removing Permissions for Stores

Adding Permissions for Stores
Adding Permissions for Statuses is done in three stages.

1. Highlight the required store and select the Add User Group option from the right
click menu

2. This will bring up the Add User Group dialog box. The User Groups it is desired to
add can be selected from the list.
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3. On clicking OK, the selected User Group will be added to the list of those that can
view that store in In-Store Space Collaboration.

All Users belonging to the selected User Groups will be able to access that store In-Store
Space Collaboration. (The store will also have to contain store plans at a status that can
be viewed in In-store Space Collaboration).

Deleting Permissions for Stores
Deleting Permissions for Stores is done by highlighting the User Group it is desired to
remove and selecting 'Delete User Group' from the right click menu.
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Alternatively, the Delete Links option can be used from the toolbar.

Overview of Data Security for Products
Data Security for Products is intended to allow Administrators to assign permission for
User Groups to change specifically identified products.

Note: This functionality is not fully implemented in this
release of Macro Space Management.

Overview of Data Security for Planograms
Data Security for Planograms is intended to allow Administrators to assign permission
for User Groups using the Planogram Substitution functionality to see specific
planograms for selection.
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If no user groups are assigned to planograms, then they will be available to all user
groups with permissions to access Planogram substitution. Once permissions have been
assigned to one or more planogram groups, then users will only be able to see
planograms assigned to a group they have permissions for.
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This will take effect in the Planogram Substitution Definition dialog box (above) and the
Planogram Substitution Assistant.

Adding and Removing Permissions for Planograms

Adding Permissions for Planograms

Note: permissions for planograms are allocated to their
parent groups.

Adding Permissions for planograms is done in three stages.

1. Highlight the required planogram group and select the Add User Group option from
the toolbar
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2. This will bring up the Add User Group dialog box. The User Groups it is desired to
add can be selected from the list.

3. On clicking OK, the selected User Groups will be added to the list of those that can
access planograms in that Planogram Group in the Planogram Substitution
functionality.
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All Users belonging to the selected User Groups will be able to access planograms
belonging to that planogram group in the planogram substitution functionality.

Deleting Permissions for Planograms
Deleting Permissions for planograms is done by highlighting the User Group it is desired
to remove and selecting 'Delete User Group' from the toolbar.
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Overview of Data Security for Statuses
Data Security for Statuses is intended to allow Administrators to assign permission for
User Groups accessing In-Store Space Collaboration to see store plans at specific statuses.

Note: at present Data Security is only operational for File
Statuses.

In the above example the ISSC status has been made visible to ISSC users. (Other statuses
can also be made visible if required).

When a store plan is ready for use in In-Store Space Collaboration, it is set to ISSC Status
in Store Manager.
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Store plans of ISSC status then become visible to In-Store Space Collaboration Users -
note how store plans set to statuses other than ISSC in store Manager are not visible in In-
Store Space Collaboration. Also note that the parent store for the store plan must also
have been given the appropriate permissions in the Stores Tab of the Data Security dialog
box.

Note: controlling visibility of statuses is presently only active
in In-Store Space Collaboration.

It is possible to set permissions for statuses by function: i.e. Admin Users, ISSC Users, etc.
It is also possible to set permissions for

Adding and Removing Permissions for Statuses

Adding Permissions for Statuses
Adding Permissions for Statuses is done in three stages

1. Highlight the required status and select the Add User Group option from the Edit
menu

2. This will bring up the Add User Group dialog box. The User Groups it is desired to
add can be selected from the list.
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3. On clicking OK, the selected User Group will be added to the list of those that can
view store plans of that status in In-Store Space Collaboration.

All Users belonging to the selected User Groups will be able to access store plans of that
status in In-Store Space Collaboration (providing they also have rights to access that
store).
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Deleting Permissions for Statuses
Deleting Permissions for Statuses is done by highlighting the User Group it is desired to
remove and selecting 'Delete Link' from the Edit menu.
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